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Informações do Manual de Instruções
Este manual contém informações sobre a configuração e operação seguras do Sistema de detecção por 
PCR em tempo real CFX96™ que ostenta a marca CE-IVD (número de catálogo 1855095–IVD). Para 
obter mais informações sobre o CFX Manager™ software, consulte o Manual de Instruções do CFX96 
e do CFX384 para investigação em ciências da vida (números de catálogo 1855095 e 1855384).

Convenções de escrita utilizadas no presente manual
O manual utiliza as convenções de escrita mostradas na Tabela 1.

Para obter informações sobre as etiquetas de segurança utilizadas no presente manual e no Sistema 
CFX96, consulte “Conformidade reguladora e de segurança” na página iii.

Bio-Rad Recursos
A Tabela 2 mostra recursos Bio-Rad e como localizar aquilo de que necessita. 

Tabela 1. Convenções utilizadas no presente manual

Convenção Significado

SUGESTÃO: Apresenta informações e instruções úteis, incluindo informações 
explicadas mais detalhadamente noutras partes do presente 
manual.

NOTA: Apresenta informações úteis, incluindo informações explicadas mais 
detalhadamente noutras partes do presente manual.

AVISO! Explica informação muito importante sobre um aspecto que poderá 
provocar lesões no investigador, danos no instrumento ou originar 
perda de dados.

X > Y Seleccione X e depois Y numa barra de ferramentas, menu ou janela 
de software.

Tabela 2. Recursos Bio-Rad.

Recurso Como contactar

Representantes locais da Bio-
Rad Laboratories

Para encontrar informações e contactos locais no website 
da Bio-Rad, seleccione o seu país na página inicial 
(www.bio-rad.com). Localize o escritório internacional mais 
próximo no verso do presente manual.

Notas técnicas e literatura Navegue até ao website da Bio-Rad (www.bio-rad.com). 
Digite um item de pesquisa na caixa Search (Procurar) 
e seleccione Literature (Literatura) para encontrar 
hiperligações a notas técnicas, manuais e outro tipo 
de literatura.

Especialistas técnicos O Departamento de Assistência da Bio-Rad emprega 
cientistas experientes que fornecem soluções práticas 
e especializadas aos clientes. Se precisar de contactar 
a assistência técnica local pelo telefone, contacte o escritório 
Bio-Rad mais próximo de si. Para obter assistência técnica 
nos Estados Unidos e Canadá, ligue 1-800-424-6723 
(número gratuito) e seleccione a opção de assistência 
técnica.
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Conformidade reguladora e de segurança
Para a operação segura do Sistema de detecção por PCR em tempo real CFX96, recomendamos 
vivamente que observe as especificações de segurança incluídas nesta secção e ao longo do manual.

O sistema CFX96 foi aprovado para utilização como um equipamento médico de diagnóstivo 
in vitro (IVD). 

Etiquetas de aviso de segurança
As etiquetas de aviso presentes no instrumento e no presente manual advertem para fontes de lesões 
ou danos. Consulte a Tabela 3 para ver o significado de cada etiqueta de aviso de segurança. 

Tabela 3. Significado das etiquetas de aviso de segurança.

ATENÇÃO: Perigo para o ambiente! Este símbolo identifica componentes que podem 
ficar contaminados com materiais perigosos para o ambiente.

ATENÇÃO: Perigo! Este símbolo identifica os componentes que poderão causar lesões 
pessoais ou danos no instrumento se forem incorrectamente manuseados. Sempre 
que aparecer este símbolo, consulte o manual para obter mais informações antes 
de continuar.

ATENÇÃO: Superfície quente! Este símbolo identifica os componentes que poderão 
causar lesões pessoais devido a aquecimento excessivo se forem incorrectamente 
manuseados.
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Avisos de segurança no instrumento
As etiquetas de aviso mostradas na Tabela 4 estão também presentes no instrumento e referem-se 
directamente à utilização segura do sistema CFX96.

Especificações e conformidade para uma utilização segura
A Tabela 5 mostra as especificações para a utilização segura do sistema CFX96. Devem ser utilizados 
cabos blindados (fornecidos) com esta unidade para assegurar a conformidade com os limites FCC 
da Classe A.

CONFORMIDADE REGULADORA

Este instrumento foi testado e está em conformidade com todos os requisitos aplicáveis das seguintes 
normas electromagnéticas e de segurança:

• IEC 61010-1:2001 (2.ª Ed.), EN61010-1:2001 (2.ª Ed). Equipamento eléctrico de medição, 
de comando e de laboratório - Parte 1: Requisitos gerais

• IEC 61010-2-010:2005, EN61010-2-010:2003. Requisitos de segurança de equipamento 
eléctrico de medição, de comando e de laboratório. Parte 2-010: Requisitos específicos 
de equipamento de laboratório para aquecimento de materiais

Tabela 4. Etiquetas de aviso de segurança no instrumento.

Ícone Significado

Aviso sobre o risco de lesões corporais ou danos no equipamento.
Se o sistema de detecção de PCR em tempo real CFX96 for operado antes da leitura 
do presente manual, tal poderá constituir um risco de lesões pessoais. Para uma utilização 
segura, não opere este instrumento de formas não especificadas no presente manual. 
O instrumento deve ser operado apenas por pessoal de laboratório qualificado com 
formação para utilizar o equipamento eléctrico de forma segura. Os componentes 
do sistema devem ser sempre manuseados cuidadosamente e com as mãos limpas 
e secas.

Aviso sobre o manuseamento de materiais perigosos para o ambiente.
Ao manusear amostras perigosas para o ambiente, observe as precauções e directrizes 
recomendadas e cumpra todas as directrizes locais específicas do seu laboratório 
e localização. 

Aviso sobre o risco de queimaduras. 
Um termociclador gera calor suficiente para causar queimaduras graves. Use sempre 
óculos de segurança ou outro tipo de protecção para os olhos durante a operação. Permita 
sempre que o bloco de amostras regresse à temperatura de inactividade antes de abrir 
a tampa e remover as amostras. Proporcione sempre uma folga máxima para evitar 
queimaduras acidentais na pele.

Aviso sobre o risco de explosão.
Os blocos de amostras podem ficar suficientemente quentes durante a operação normal 
para que os líquidos entrem em ebulição e expludam.

Tabela 5. Especificações para uma utilização segura.

Requisitos para uma utilização segura Especificações

Temperatura Utilização em 
interiores

Temperatura ambiente 15–31°C. Humidade relativa máxima 
80%, sem condensação

Altitude Até 2.000 metros acima do nível do mar
iv
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• IEC 61010-2-081:2001+A1, EN61010-2-081:2002+A1. Requisitos de segurança 
de equipamento eléctrico de medição, de comando e de laboratório. Parte 2-081: Requisitos 
específicos de equipamento automático e semi-automático de laboratório para análise 
e outros fins (inclui a Emenda 1)

• EN 61326-1:2006 (Classe A) Equipamento eléctrico de medição, de comando 
e de laboratório. Requisitos EMC, Parte 1: Requisitos gerais

• EN 61010-2-101. Requisitos de segurança de equipamento eléctrico de medição, 
de comando e de laboratório. Requisitos específicos de equipamentos médicos para 
diagnóstico in vitro (IVD)

• EN 61326-2-6 (Classe A) Equipamento eléctrico de medição, de comando e de laboratório. 
Requisitos EMC. Parte 2-6. Requisitos específicos. Equipamentos médicos para diagnóstico 
in vitro (IVD)

Este equipamento gera, utiliza e pode radiar energia de rádiofrequência e, se não for instalado e utilizado 
em conformidade com o manual de instruções, pode provocar interferências nocivas para as 
comunicações de rádio. A operação deste equipamento em áreas residenciais pode provocar 
interferências nocivas; nestes casos, o utilizador terá de corrigir a interferência a expensas próprias.

Perigos
O sistema de detecção de PCR em tempo real CFX96 foi concebido para operar em segurança quando 
utilizado da forma recomendada pelo fabricante. Se o sistema CFX96 ou qualquer um dos componentes 
associados forem utilizados de uma forma não especificada pelo fabricante, tal poderá comprometer 
a protecção inerente proporcionada pelo instrumento. A Bio-Rad Laboratories, Inc. não se responsabiliza 
por quaisquer lesões ou danos causados pela utilização deste equipamento de forma não especificada, 
nem pelas modificações ao instrumento não realizadas pela Bio-Rad ou por um representante 
autorizado. A assistência ao sistema CFX96 deve ser levada a cabo apenas por pessoal da Bio-Rad. 

Perigos para o ambiente
O sistema CFX96 é um produto de laboratório. No entanto, na presença de amostras perigosas para 
o ambiente, observe as directrizes seguintes e cumpra todas as directrizes locais específicas do seu 
laboratório e localização.

PRECAUÇÕES GERAIS

• Use sempre luvas, batas e óculos de segurança com protecções laterais ou óculos 
de protecção

• Mantenha as mãos afastadas da boca, nariz e olhos

• Cubra totalmente eventuais golpes ou abrasões antes de trabalhar com materiais 
potencialmente infecciosos

• Depois de trabalhar com materiais potencialmente infecciosos, lave muito bem as mãos 
com sabão e água antes de sair do laboratório

• Retire relógios de pulso e jóias antes de trabalhar na bancada

• Guarde todo o material infeccioso ou potencialmente infeccioso em recipientes inquebráveis 
à prova de fuga

• Antes de sair do laboratório, dispa o vestuário de protecção

• Enquanto tiver luvas calçadas, não deve tocar em objectos ou superfícies que possam 
ser tocados por pessoas sem luvas (por ex., escrever, atender o telefone ou tocar num 
interruptor de luz)
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• Mude de luvas com frequência Descalce imediatamente as luvas quando estiverem 
visivelmente contaminadas

• Os materiais que não possam ser devidamente descontaminados não devem ser expostos 
a materiais potencialmente infecciosos

• Ao concluir uma operação que inclua material perigoso para o ambiente, descontamine a zona 
de trabalho com um desinfectante adequado (por exemplo, lixívia doméstica diluída a 1:10)

PRECAUÇÕES ESPECÍFICAS

• Todas as amostras de doentes constituem um perigo potencial para o ambiente e devem 
ser manuseadas de acordo com precauções universais

• Nenhumas substâncias perigosas para o ambiente são expelidas durante as operações 
normais deste instrumento

DESCONTAMINAÇÃO DE SUPERFÍCIES

AVISO! Para evitar choques eléctricos, desligue sempre o instrumento e desligue-o da corrente eléctrica 
antes de efectuar procedimentos de descontaminação.

As áreas seguintes podem ser limpas com qualquer desinfectante bactericida, virucida ou fungicida 
de grau hospitalar:

• Tampa exterior e caixa

• Superfície interior do bloco de reacção e poços do bloco de reacção

• Painel de controlo e visor

Para preparar e aplicar o desinfectante, consulte as instruções fornecidas pelo fabricante do produto. 
Enxague sempre o bloco de reacção e os poços do bloco de reacção várias vezes com água depois 
de aplicar um desinfectante. Seque muito bem o bloco de reacção e os poços do bloco de reacção 
depois de enxaguar com água.

AVISO! Não utilize detergentes abrasivos ou corrosivos nem soluções alcalinas fortes. Estes agentes 
podem riscar as superfícies e danificar o bloco de reacção, comprometendo a precisão do controlo 
térmico.

ELIMINAÇÃO DE MATERIAL PERIGOSO PARA O AMBIENTE

O sistema CFX96 não contém quaisquer materiais químicos potencialmente perigosos. Elimine 
os seguintes materiais potencialmente contaminados em conformidade com os regulamentos 
de laboratório locais, regionais e nacionais:

• Amostras clínicas

• Reagentes

• Recipientes de reacção usados ou outros consumíveis que possam estar contaminados

Perigos químicos
O sistema CFX96 não contém quaisquer materiais químicos potencialmente perigosos.

Perigo de explosão ou inflamabilidade
O sistema CFX96 não apresenta nenhum perigo não comum de inflamabilidade ou explosão quando 
utilizado de forma correcta conforme especificado pela Bio-Rad Laboratories.
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Perigos eléctricos
O sistema CFX96 não apresenta nenhum perigo eléctrico não comum para os operadores desde que seja 
instalado e operado correctamente, sem modificações físicas, e desde que seja ligado a uma fonte 
de alimentação com a especificação correcta.

Transporte
Antes de deslocar ou transportar o Termociclador C1000™ ou o módulo de reacção óptico CFX96, 
devem ser realizados procedimentos de descontaminação. Desloque ou transporte sempre a caixa 
do termociclador C1000 e o módulo de reacção óptico CFX96 em contentores separados com 
os materiais de embalagem fornecidos para proteger o instrumento de danos. Caso não seja possível 
obter contentores adequados, contacte o escritório Bio-Rad da sua zona. 

Armazenamento
O sistema CFX96 pode ser armazenado nas seguintes condições:

• Intervalo de temperaturas –20 a 60°C 

• Humidade relativa máxima de 80% 

Eliminação
O sistema de detecção de PCR em tempo real CFX96 contém materiais eléctricos ou electrónicos; 
por conseguinte, deve ser eliminado como lixo não separado e deve ser recolhido separadamente em 
conformidade com a Directiva WEEE (Resíduos de equipamentos eléctricos e electrónicos) da União 
Europeia 2002/96/CE. Antes da eliminação, contacte o representante Bio-Rad da sua zona para obter 
instruções específicas nacionais. 
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Manual de Instruções do Sistema de Detecção por PCR em Tempo Real CFX96™
1 Instalação do sistema
Leia este capítulo para obter informações sobre a configuração do CFX96™ real-time PCR 
detection system:

• Desembalar o módulo de reacção óptico (abaixo)

• Requisitos do sistema (página 1)

• Visão geral do sistema (página 2)

• Configuração do sistema (página 3)

• Instalação do CFX™ Manager software (página 6)

• Ficheiros de software (página 8)

• Execução de experiências (página 8)

Desembalar o módulo de reacção óptico
A remessa do módulo de reacção óptico CFX96 inclui os seguintes componentes:

• Módulo de reacção óptico 

• Cabo USB

• CD de instalação do CFX Manager software

• Manual de instruções

Retire todos os materiais de embalagem e guarde-os para utilização no futuro. Se faltarem 
itens ou se houver itens danificados, contacte o escritório Bio-Rad da sua zona.

Requisitos do sistema
Para operar o sistema CFX96, utilize as fontes de alimentação e os cabos seguintes:

• Alimentação de entrada. 100–240 VAC, 50–60 Hz

• Utilização em interiores. Temperatura ambiente 15–31°C. Humidade relativa máxima 
80%, sem condensação

• Cabo USB. Se pretende que o sistema CFX96 seja controlado por computador através 
de um cabo USB, o cabo fornecido pela Bio-Rad tem um nível de blindagem suficiente 
para utilização

NOTA: Para obter uma lista completa dos requisitos de segurança 
e conformidade para este instrumento, consulte “Conformidade reguladora 
e de segurança” na página iii.
1



Instalação do sistema
Visão geral do sistema
O sistema CFX96 inclui dois componentes: 

• Módulo de reacção óptico. Este módulo inclui um sistema óptico para recolha 
de dados de fluorescência e um termociclador com bloco

NOTA: O número de série do módulo CFX96 encontra-se na retaguarda 
do instrumento. 

• Base do termociclador C1000™. A C1000 base apresenta uma interface de utilizador 
para controlar o sistema quando este se encontra no modo de funcionamento 
independente (standalone) e um botão de alimentação e portas (ambos no painel 
traseiro) para ligar a um computador 

Figura 1. Vista frontal do sistema CFX96. 

Quando aberto, o sistema CFX96 apresenta os elementos mostrados na Figura 2.

Figura 2. Vista interior do CFX96 system.

AVISO! Evite tocar na tampa interior ou no bloco: estas superfícies podem 
estar quentes.

Botão de abertura

LED indicador

Painel frontal

Botão de fecho
Bloco

Tampa interior com placa 
de aquecimento
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• Tampa interior com placa de aquecimento. A tampa de aquecimento mantém 
a temperatura no topo do consumível para evitar a evaporação das amostras. 
Evite tocar ou contaminar de outra forma a placa de aquecimento. Nunca insira 
nada nos orifícios, uma vez que poderá danificar o sistema de vaivém óptico

• Bloco. Carregue amostras neste bloco antes do ciclo

• Botão de fecho. Prima este botão na parte interior da tampa para fechar a tampa 
motorizada 

AVISO! Evite a contaminação do instrumento por derrames e nunca execute uma 
reacção com uma tampa de amostra aberta ou com fuga. Para obter informações 
sobre a limpeza e manutenção gerais do instrumento, consulte “Manutenção do 
instrumento” (página 117).

O painel traseiro da caixa do C1000 apresenta os seguintes elementos (Figura 3):

• Interruptor de alimentação. Prima o interruptor de alimentação para ligar 
a alimentação do sistema

• Entrada de alimentação. Ligue o cabo de alimentação aqui

• Porta Ethernet. Ligue um cabo ethernet a registos de ciclos de e-mail e a ficheiros 
de dados independentes (standalone)

• Ligações USB. Utilize estas portas para ligar o sistema CFX96 a um computador 

ou para ligar um S1000™ thermal cycler

Figura 3. Painel traseiro do termociclador C1000.

 AVISO! Evite o contacto com a retaguarda da caixa do C1000 durante a operação.

Configuração do sistema
O sistema de detecção de PCR em tempo real CFX96 deve ser instalado sobre uma superfície 
limpa, seca e nivelada, com um fluxo de ar frio suficiente para permitir o seu funcionamento 
correcto. O sistema CFX96 pode ser operado em dois modos: independente (standalone) 
ou controlado por software. Se o sistema for operado no modo de controlo por software, 
certifique-se de que existe espaço suficiente para um computador durante a instalação.

Posicione a base do termociclador C1000 de modo que o interruptor de alimentação, 
localizado no painel traseiro, seja facilmente acessível.

Interruptor 
de alimentação

Entrada 
de alimentação

Porta 
Ethernet

Ligações USB
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Instalação do sistema
Para inserir o módulo de reacção óptico CFX96 no compartimento do módulo 
de reacção da caixa do C1000, siga as instruções seguintes:

1. Coloque a caixa do C1000 numa localização adequada com a barra de bloqueio para 
baixo. Retire os módulos de reacção anteriormente instalados.

2. Levante o módulo de reacção óptico pelas reentrâncias localizadas acima das aberturas 
de ventilação laterais (Figura 4).

Figura 4. Colocação do módulo de reacção óptico na caixa do C1000.

3. Posicione o módulo no compartimento do módulo de reacção da caixa do C1000, 
deixando um espaço de cerca de 2 cm na parte frontal. Quando estiver instalado 
no compartimento da caixa, o módulo óptico deverá cobrir o logótipo Bio-Rad à frente 
do compartimento da caixa do C1000.
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4. Puxe para cima a barra de bloqueio do termociclador C1000 até ficar nivelada com 
os lados do compartimento do módulo. Esta acção desloca o módulo para a frente, 
fixando-o no devido lugar (Figura 5).

Figura 5. Bloqueio do módulo óptico no devido lugar.

5. Verifique se o módulo está completamente alojado e nivelado na C1000 base. 
Não deverá existir uma folga entre o módulo e a base; o espaço deve estar nivelado. 

6. Ligue o cabo de alimentação à parte traseira da C1000 base (Figura 3 na página 3) e a 
uma tomada eléctrica de três pinos. Prima o interruptor de alimentação no painel traseiro 
do termociclador C1000 para iniciar o sistema.
5



Instalação do sistema
7. Siga as instruções no painel frontal do termociclador C1000 para remover o parafuso 
de transporte vermelho da tampa de aquecimento interior (Figura 6). Rode o parafuso 
no sentido contrário ao dos ponteiros do relógio para o retirar do furo.

Figura 6. Instruções de remoção do parafuso de transporte.

NOTA: Se o parafuso de transporte não for retirado neste passo, será detectado 
pelo CFX Manager software. Siga as instruções para remover o parafuso 
(página 18). 

SUGESTÃO: O parafuso de transporte deve ser instalado quando o módulo 
for transportado. Guarde este parafuso num local seguro para o transporte 
no futuro. 

8. Retire a placa de transporte do bloco do termociclador para operar.

Instalação do CFX Manager Software
O CFX Manager software é executado num computador pessoal (PC), sendo necessário para 
analisar dados do sistema CFX96 e para controlar o sistema CFX96 no modo de controlo 
por software. A Tabela 6 mostra os requisitos de sistema do computador para o CFX Manager 
software (versão 1.6 ou superior). 

Tabela 6. Requisitos do computador para o CFX Manager software versão 1.6 
ou superior.

Sistema Mínimo Recomendado

Sistema operativo Windows XP Professional SP2 
e superior ou Windows Vista Home 
Premium e superior ou Windows 7 
Home Premium e superior

Windows XP Professional SP2 
e superior ou Windows Vista 
Professional ou Windows 7 
Professional

Unidade Unidade de CD-ROM Unidade de CD-RW

Unidade de disco 
rígido

10 GB 20 GB

Velocidade 
do processador

2,0 GHz 2,0 GHz

RAM 1 GB de RAM (2 GB para 
Windows Vista)

2 GB de RAM 
6
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Para instalar o CFX Manager software:

1. Certifique-se de que iniciou sessão com privilégios de administrador. O software deve 
ser instalado no computador por um utilizador com privilégios de administrador. 

2. Insira o CD do CFX Manager software na respectiva unidade do computador.

3. Deverá aparecer automaticamente a página de instalação do software. Faça duplo 
clique em Install Software (Instalar software) na página de instalação do software 
(Figura 7).

Figura 7. Ecrã de instalação do software.

4. Siga as instruções no ecrã para efectuar a instalação. Quando estiver concluída, o ícone 
do CFX manager software da Bio-Rad aparece no ambiente de trabalho do computador.

5. Se a página de instalação não aparecer automaticamente, faça duplo clique em 
(unidade de CD):\Bio-Rad CFX e, a seguir, abra o ficheiro Readme.txt e siga as 
instruções nele contidas. Consulte “Instalar o software manualmente” na página 120.

Instalar os controladores
Se o sistema CFX96 for executado no Modo de controlo por software, devem ser instalados 
controladores no computador. Utilize apenas o cabo USB fornecido, o qual tem um nível 
de blindagem suficiente para evitar a perda de dados.

Para instalar os controladores do sistema:

1. Para ligar a caixa do chassis ao computador, ligue um cabo USB à porta USB 2.0 A 
localizada na retaguarda da caixa (Figura 3 na página 3) e, em seguida, ligue o cabo 
à porta USB 2.0 B localizada no computador.

Resolução do ecrã 1024 x 768 com modo de alta 
qualidade de cor 

1280 x 1024 com modo de alta 
qualidade de cor

USB Porta USB 2.0 de alta velocidade Porta USB 2.0 de alta velocidade

Tabela 6. Requisitos do computador para o CFX Manager software versão 1.6 
ou superior. (continuação)

Sistema Mínimo Recomendado
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Instalação do sistema
2. Se ainda não estiver ligado, ligue o sistema carregando no interruptor de alimentação 
localizado na retaguarda da caixa do C1000. Siga as instruções do assistente 
de detecção de hardware novo Found New Hardware Wizard, o qual é lançado depois 
de o instrumento ser detectado primeiramente pelo computador.

3. No primeiro ecrã seleccione Yes, this time only (Sim, só desta vez) para dar ordem 
ao sistema operativo do Windows para ligar à actualização do Windows para procurar 
software. Clique em Next (Seguinte). 

4. Indique ao assistente para instalar o software automaticamente (Install the software 
automatically). Clique em Next (Seguinte) para continuar a instalar os controladores.

5. Clique em Finish (Terminar) no ecrã de conclusão da instalação do software quando 
os controladores estiverem instalados.

Ficheiros de software
O CFX Manager software guarda informações sobre experiências em ficheiros específicos 
(Tabela 7):

Execução de experiências 

Consumíveis de plástico recomendados
O sistema CFX96 aceita tubos e placas de perfil baixo de 0,2 ml. A Bio-Rad recomenda 
os consumíveis seguintes para os melhores resultados:

• MLL-9601. Placas de 96 poços de perfil baixo, sem saia, com poços transparentes 

• MLL-9651. Placas de 96 poços de perfil baixo, sem saia, com poços brancos

• HSP-9601. Hard-Shell® Placas de 96 poços com saia, com revestimento branco 
e poços transparentes

• HSP-9655. Placas de 96 poços Hard-Shell com saia, com revestimento e poços 
brancos

• TLS-0801. Tiras de 8 tubos de perfil baixo de 0,2 ml, sem tampas, poços transparentes

• TLS-0851. Tiras de 8 tubos de perfil baixo de 0,2 ml, sem tampas, poços brancos

• TCS-0803. Tiras ópticas planas de 8 tampas, para placas e tubos de 0,2 ml

• MSB-1001. Vedantes adesivos Microseal® ‘B’, opticamente transparentes

Tabela 7. Abra estes tipos de ficheiros com o CFX Manager software. 

Tipo de ficheiro Extensão Como ver e editar o ficheiro

Protocolo .prcl Seleccione em Experiment Setup (Configuração 
da experiência) e edite no Protocol Editor (Editor 
de protocolos)

Placa .pltd Seleccione em Experiment Setup (Configuração 
da experiência) e edite no Plate Editor (Editor de placas)

Dados .pcrd Veja e analise na janela Data Analysis (Análise de dados)

Estudo de genes .mgxd Veja e analise na janela Gene Study (Estudo de genes)

Ficheiro de pré-
dados independente

.zpcr Contém leituras de fluorescência da operação 
independente que são convertidas num ficheiro de dados
8
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Carregar o bloco
Para carregar as reacções no bloco, siga as sugestões abaixo:

• Clique no botão Open Lid (Abrir tampa), localizado no separador Start Run (Iniciar 
ciclo) (consulte “Separador Start Run (Iniciar ciclo)” na página 24), ou prima o botão 
da tampa na parte da frente do sistema (Figura 1) para iniciar a abertura da tampa 
motorizada

• Coloque no bloco as tiras de tubos ou microplacas de 0,2 ml com tampas vedadas. 
Verifique se os tubos estão completamente vedados, para evitar fugas. 
Para os melhores resultados, carregue volumes de amostra de 10–25 μl para 
o sistema CFX96

NOTA: Para garantir a precisão da análise de dados, verifique se a orientação 
das reacções no bloco é exactamente idêntica à orientação do conteúdo dos 
poços no separador Plate (Placa) do software. Se for necessário, edite o conteúdo 
dos poços antes, durante ou após o ciclo. 

AVISO! Ao operar o sistema CFX96, equilibre sempre as tiras de tubos ou 
microplacas cortadas nos poços (Figura 8). Por exemplo, se executar uma tira 
de tubos no lado esquerdo do bloco, execute uma tira de tubos vazia (com 
tampas) no lado direito do bloco para equilibrar a pressão aplicada pela tampa 
aquecida. Se a pressão não for equilibrada, as amostras poderão evaporar-se, 
dando origem a ciclos falhados.

Figura 8. Equilibre no bloco as tiras de tubos ou microplacas cortadas.

AVISO! Certifique-se de que nada bloqueia a tampa quando esta se fecha. Embora 
exista um mecanismo de segurança que impede o fecho da tampa se esta 
detectar uma obstrução, não coloque nada no caminho da tampa quando esta 
se está a fechar.

Encerrar o sistema
Para encerrar o sistema CFX96, veja as sugestões seguintes:

• Após um ciclo, clique no botão de abertura da tampa na parte da frente do sistema 
CFX96 para aceder às amostras carregadas no bloco do termociclador

• Retire as amostras do bloco e clique no botão de fecho da tampa para fechar 
a tampa do sistema CFX96

• Prima o interruptor de alimentação no painel traseiro do termociclador C1000 para 
desligar a alimentação do sistema

Tira de 
tubos 
cheia

Tira de tubos 
para 
equilíbrio
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2 CFX Manager™ Software
Leia este capítulo para obter informações sobre como iniciar o CFX Manager software.

• Janela principal do software (abaixo)

• Assistente de arranque (página 15)

• Painel Detected Instruments (Instrumentos detectados) (página 16)

• Janela Instrument Properties (Propriedades dos instrumentos) (página 17)

Janela principal do software 
As funcionalidades disponíveis na janela principal do software são apresentadas na Figura 9.

Figura 9. A janela principal do software.
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CFX Manager™ Software
Barra de menus
A barra de menus da janela principal do software apresenta os itens indicados na Tabela 8.

Tabela 8. Itens da barra de menus da janela principal do software.

Item de menu Comando Função

File (Ficheiro) New (Novo) Criar um novo protocolo, placa, experiência ou estudo 
de genes

Open (Abrir) Abrir ficheiros existentes, incluindo ficheiros 
de protocolo (.prcl), placa (.pltd), dados (.pcrd) e estudo 
de genes (.mgxd), além de ficheiros de execução 
independentes (.zpcr)

Recent Data Files 
(Ficheiros 
de dados 
recentes)

Ver uma lista dos dez últimos ficheiros de dados 
visualizados, e seleccionar um para abrir em Data 
Analysis (Análise de dados) 

Repeat an 
Experiment 
(Repetir uma 
experiência)

Abrir a janela Experiment Setup (Configuração 
da experiência) com o protocolo e a placa de um ciclo 
concluído para repetir rapidamente o ciclo

Exit (Sair) Sair do programa de software

View (Ver) Application Log 
(Registo 
de aplicações)

Mostrar o registo de aplicações do software

Run Reports 
(Relatórios 
de ciclos)

Seleccionar numa lista um relatório de ciclo para análise

Startup Wizard 
(Assistente 
de arranque)

Abrir o assistente de arranque

Experiment Setup 
(Configuração 
da experiência)

Abrir a janela Experiment Setup (Configuração 
da experiência)

Instrument 
Summary 
(Resumo 
do instrumento)

Abrir a janela Instrument Summary (Resumo 
do instrumento)

Detected 
Instruments 
(Instrumentos 
detectados)

Mostrar ou ocultar o painel Detected Instruments 
(Instrumentos detectados)

Toolbar (Barra 
de ferramentas)

Mostrar ou ocultar a barra de ferramentas da janela 
principal do software 

Status Bar (Barra 
de estado)

Mostrar ou ocultar a barra de estado da janela principal 
do software
12
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User (Utilizador) Select User 
(Seleccionar 
o utilizador)

Abrir a janela Select User (Seleccionar o utilizador) para 
mudar de utilizador de software

Change Password 
(Alterar password)

Alterar a password de utilizador

User Preferences 
(Preferências 
do utilizador)

Abrir a janela User Preferences (Preferências 
do utilizador)

User 
Administration 
(Administração 
de utilizadores)

Gerir utilizadores na janela User Administration 
(Administração de utilizadores)

Tools 
(Ferramentas)

Dye Calibration 
Wizard (Assistente 
de calibração 
de fluorocromo)

Abrir a janela Dye Calibration (Calibração 
de fluorocromo) para calibrar um instrumento para 
um novo fluoróforo

Protocol 
AutoWriter

Abrir a janela Protocol AutoWriter para criar um novo 
protocolo

Ta Calculator 
(Calculador 
de temperatura)

Abrir a janela Ta Calculator (Calculador de temperatura) 
para calcular a temperatura de annealing (hibridização) 
de preparadores

View Block Status 
Log (Ver registo 
de estado 
do bloco)

Ver um registo do bloco do termociclador

Application Data 
Folder (Pasta 
de dados 
de aplicações)

Abrir a pasta Application Data (Dados de aplicações) 
para ver ficheiros de software

User Data Folder 
(Pasta de dados 
do utilizador)

Abrir a pasta User Data (Dados do utilizador) para 
ver ficheiros de dados, de placas e de protocolos

Properties All 
Instruments 
(Propriedades 
de todos 
os instrumentos)

Ver as propriedades de todos os instrumentos 
detectados, incluindo números de série

Zip Data and Log 
Files (Comprimir 
ficheiros de dados 
e de registo)

Escolher e comprimir ficheiros seleccionados num 
ficheiro zip, para armazenar ou enviar por e-mail

Options (Opções) Configurar as definições de e-mail do software

Tabela 8. Itens da barra de menus da janela principal do software. (continuação)

Item de menu Comando Função
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Botões da barra de ferramentas
Clique nos botões da barra de ferramentas da janela principal do software (Tabela 9) para 
aceder rapidamente a comandos de software comuns.

Windows 
(Janelas)

Cascade 
(Em cascata)

Dispor as janelas de software em cascata

Tile Vertical 
(Dispor 
na vertical)

Dispor as janelas de software de cima para baixo

Tile Horizontal 
(Dispor na 
horizontal)

Dispor as janelas de software da direita para a esquerda

Close All (Fechar 
todas)

Fechar todas as janelas de software abertas

Help (Ajuda) Contents (Índice) Abrir a ajuda do software (Help) para obter mais 
informações sobre a execução de PCR e PCR em tempo 
real

Index (Índice 
remissivo)

Ver o índice remissivo na Ajuda (Help) do software

Search (Procurar) Fazer pesquisas na Ajuda (Help) do software

Gene Expression 
Gateway Website

Abrir um website para obter informações sobre 
a execução de experiências de PCR e PCR em tempo 
real

PCR Reagents 
Website

Ver um website com uma lista de consumíveis Bio-Rad 
para reagentes PCR e PCR em tempo real

PCR Plastic 
Consumables 
Website

Ver um website com uma lista de consumíveis Bio-Rad 
para experiências PCR e PCR em tempo real

Software Updates 
(Actualizações 
de software)

Procurar actualizações de software da Bio-Rad 

About (Acerca) Abrir uma janela para ver a versão do software

Tabela 9. Botões da barra de ferramentas da janela principal do software.

Botão Nome do botão Função

Abrir um ficheiro de 
dados

Abrir uma janela do browser para localizar um ficheiro 
de dados (extensão *.pcrd) e abri-lo na janela Data 
Analysis (Análise de dados) (página 61)

Abrir um estudo de 
genes

Abrir uma janela do browser para localizar um ficheiro 
de estudo de genes (extensão .mgxd) e abri-lo 
na janela Gene Study (Estudo de genes) (página 98)

Tabela 8. Itens da barra de menus da janela principal do software. (continuação)

Item de menu Comando Função
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Assistente de arranque
O assistente de arranque aparece automaticamente quando o CFX Manager software é aberto 
inicialmente (Figura 9). Caso não seja apresentado, clique no botão do Assistente 
de arranque na barra de ferramentas da janela do software principal.

Opções do assistente de arranque:

• Create a new Experiment (página 21). Configurar o protocolo e a placa para iniciar 
uma nova experência

• Repeat an Experiment. Configurar uma experiência com o protocolo e a placa 
de um ciclo concluído. Se for necessário, poderá editar a experiência antes de executar 
o ciclo

• Open a Data File (página 61). Abrir um ficheiro de dados para analisar resultados

• Open a Gene Study (página 98). Abrir um estudo de expressão de genes com vários 
ficheiros para analisar resultados de várias experiências de expressão de genes

Criar um novo estudo 
de genes

Abrir a janela Gene Study (Estudo de genes) 
(página 98) para adicionar ficheiros e criar 
um novo estudo

Imprimir Imprimir a janela de software actual

Assistente de arranque Abrir o assistente de arranque (Startup Wizard) 
que estabelece a ligação a funções de software 
comuns (página 16)

Configuração da 
experiência

Abrir a janela Experiment Setup (Configuração 
da experiência) para executar uma experiência 
(página 21)

Protocol AutoWriter Abrir a janela Protocol AutoWriter (AutoWriter 
de protocolos) para criar um novo protocolo 
(página 35)

Seleccionar utilizador Abrir a janela Select User (Seleccionar o utilizador) 
para mudar de utilizador de software (consulte “Iniciar 
sessão ou seleccionar utilizador” na página 105)

Preferências do 
utilizador

Abrir a janela User Preferences (Preferências 
do utilizador) (página 106)

Ajuda Abrir a janela da ajuda do software (Help) para obter 
mais informações sobre a execução de PCR e PCR 
em tempo real

Tabela 9. Botões da barra de ferramentas da janela principal do software.

Botão Nome do botão Função
15
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• Open User Preferences (página 106). Abrir a janela User Preferences (Preferências 
do utilizador) para personalizar as definições de software

Painel Detected Instruments (Instrumentos detectados)
Os instrumentos ligados são apresentados no painel Detected Instruments (Instrumentos 
detectados) (Figura 10). Esta lista mostra cada instrumento como um ícone cuja designação 
é um número de série (predefinição).

Figura 10. Instrumentos mostrados no painel 
Detected Instruments (Instrumentos detectados).

Clique com o botão direito do rato no bloco ou ícone do instrumento para seleccionar uma 
das seguintes opções:

• View Status (Ver estado). Abrir a janela Run Details (Detalhes do ciclo) para verificar 
o estado do bloco do instrumento seleccionado

• Flash Block Indicator (Indicador de bloco intermitente). O indicador LED pisca 
no instrumento

• Open Lid (Abrir tampa). Abrir a tampa motorizada do bloco do instrumento 
seleccionado

• Close Lid (Fechar tampa). Fechar a tampa motorizada do bloco do instrumento 
seleccionado

• Rename (Mudar o nome). Mudar o nome do instrumento

• Properties (Propriedades). Abrir a janela Instrument Properties (Propriedades 
dos instrumentos)

• Collapse All (Recolher todos). Recolher a lista de instrumentos no painel Detected 
Instruments (Instrumentos detectados)

• Expand All (Expandir todos). Expandir a lista de instrumentos no painel Detected 
Instruments (Instrumentos detectados)
16



Manual de Instruções do Sistema de Detecção por PCR em Tempo Real CFX96™
Também é possível controlar um bloco, clicando para tal num ícone de bloco de instrumento 
no painel Detected Instruments (Instrumentos detectados) e clicando depois num botão 
no painel Selected Instruments (Instrumentos seleccionados) (Figura 11).

Figura 11. Botões na parte inferior do painel Detected Instruments 
(Instrumentos detectados).

• Clique em View Status (Ver estado) para abrir a janela Run Details (Detalhes 
do ciclo) e verificar o estado do bloco do instrumento seleccionado

• Clique em Open Lid (Abrir tampa) para abrir as tampas motorizadas do instrumento 
seleccionado

• Clique em Close Lid (Fechar tampa) para fechar as tampas motorizadas 
do instrumento seleccionado

• Clique em View Summary (Ver resumo) para abrir a janela Instrument Summary 
(Resumo do instrumento)

Se for detectado apenas um instrumento, o botão de View Summary (Ver resumo) 
não aparece. Para ver a janela Instrument Summary (Resumo do instrumento) em relação 
a um único instrumento, seleccione View > Instrument Summary (Ver > Resumo 
do instrumento).

Barra de estado
O lado esquerdo da barra de estado, na parte inferior da janela principal do software, 
apresenta o estado actual dos instrumentos. Observe o lado direito da barra de estado para 
ver o nome do utilizador, a data e a hora actuais.

Clique e arraste o canto direito da barra de estado para redimensionar a janela principal.

Janela Instrument Properties (Propriedades 
dos instrumentos)

Para abrir a janela Instrument Properties (Propriedades dos instrumentos) e ver informações 
sobre um instrumento, clique com o botão direito do rato no ícone do instrumento no painel 
Detected Instruments (Instrumentos detectados) (Figura 10 na página 16). 
17
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Separador Properties (Propriedades)
O separador Properties (Propriedades) mostra números de série importantes relativos 
ao instrumento ligado, incluindo o termociclador e o módulo de reacção. São também 
mostradas as versões de firmware. O nome predefinido de um instrumento é o número 
de série do termociclador C1000, o qual aparece em muitas localizações, incluindo o painel 
Detected Instruments (Instrumentos detectados) (Figura 12).

Para mudar o nome do instrumento com vista a facilitar a sua identificação, siga as instruções 
seguintes:

• No separador Instrument Properties (Propriedades dos instrumentos), digite um 
nome na caixa Rename (Mudar o nome) na parte superior do separador Properties 
(Propriedades) e clique no botão Rename (Mudar o nome) para guardar o novo 
nome

Figura 12. Janela Instrument Properties (Propriedades dos instrumentos)

Separador Shipping Screw (Parafuso de transporte)
O separador Shipping Screw (Parafuso de transporte) inclui instruções de instalação 
e remoção do parafuso de transporte vermelho. Para evitar danificar os módulos de reacção 
ópticos, instale o parafuso de transporte sempre que transportar o sistema CFX96.

NOTA: Se o parafuso de transporte for detectado pelo software, a janela 
Instrument Properties (Propriedades dos instrumentos) abre-se automaticamente 
com o separador Shipping Screw (Parafuso de transporte) em primeiro plano. 
Siga as instruções para remover o parafuso. Não é possível realizar um ciclo 
com o parafuso de transporte instalado. 
18
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A informação incluída neste separador muda consoante o parafuso de transporte esteja 
instalado ou removido. Por exemplo, para instalar o parafuso de transporte, clique no botão 
Install Shipping Screw (Instalar parafuso de transporte) e siga as instruções apresentadas 
no separador (Figura 13).

Figura 13. Instruções de instalação do parafuso de transporte.

Separador Calibrated Dyes (Fluorocromos calibrados)
Abra o separador Calibrated Dyes (Fluorocromos calibrados) para ver a lista de placas 
e fluoróforos calibrados para o instrumento seleccionado (Figura 14). Para ver informações 
detalhadas de uma calibração, clique no respectivo botão Info. 

Figura 14. Separador Calibrated Dyes (Fluorocromos calibrados) na janela Instrument 
Properties (Propriedades dos instrumentos).
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3 Execução de experiências
Leia este capítulo para obter informações sobre a execução de experiências utilizando 
o CFX Manager™ software:

• Janela Experiment Setup (Configuração da experiência) (abaixo)

• Separador Protocol (Protocolo) (página 22)

• Separador Plate (Placa) (página 23)

• Separador Start Run (Iniciar ciclo) (página 24)

• Janela Run Details (Detalhes do ciclo) (página 26)

Janela Experiment Setup (Configuração da experiência)
A janela Experiment Setup (Configuração da experiência) proporciona um acesso rápido aos 
ficheiros e definições necessários para a configuração e execução de uma experiência. 
Para abrir a janela Experiment Setup (Configuração da experiência), utilize uma das seguintes 
opções: 

• Clique na opção Create a New Experiment (Criar uma nova experiência) 
no assistente de arranque (página 15)

• Clique no botão Experiment Setup (Configuração da experiência) na barra 
de ferramentas principal do software (página 21)

• Seleccione File > New > Experiment (Ficheiro > Novo > Experiência) na barra 
de menus principal do software (página 12)

A janela Experiment Setup (Configuração da experiência) apresenta três separadores:

• Protocol. Clique no separador Protocol (Protocolo) para seleccionar um protocolo 
existente a executar ou editar, ou para criar um novo protocolo na janela Protocol Editor 
(Editor de protocolos) (página 29)

• Plate. Clique no separador Plate (Placa) para seleccionar uma placa existente 
a executar ou editar, ou para criar uma nova placa na janela Plate Editor (Editor 
de placas) (página 39) 

• Start Run. Clique no separador Start Run (Iniciar ciclo) (página 24) para verificar 
as definições do ciclo, seleccionar um ou mais blocos de instrumentos e iniciar o ciclo

NOTA: Se o protocolo seleccionado actualmente no separador Protocol (Protocolo) 
não incluir um passo com uma leitura de placa para análise por PCR em tempo 
real, o separador Plate (Placa) estará oculto. Para ver o separador Plate (Placa), 
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adicione uma “Plate Read” (Leitura de placa) (página 32) em pelo menos um passo 
do protocolo

NOTA: Para iniciar uma nova experiência a partir de um ciclo anterior, seleccione 
File > Repeat an Experiment (Ficheiro > Repetir uma experiência) na barra 
de menus principal do software. A seguir, seleccione o ficheiro de dados (.pcrd) 
para a experiência que pretende repetir.

A janela Experiment Setup (Configuração da experiência) abre-se com o separador Protocol 
(Protocolo) em primeiro plano (Figura 15). Para abrir outro separador, clique nesse separador 
ou clique nos botões Prev (Anterior) e Next (Seguinte) na parte inferior da janela.

Figura 15. A janela Experiment Setup (Configuração da experiência), incluindo 
os separadores Protocol (Protocolo), Plate (Placa) e Start Run (Iniciar ciclo).

Separador Protocol (Protocolo)
O separador Protocol (Protocolo) mostra uma pré-visualização do ficheiro de protocolo 
seleccionado carregado na configuração da experiência (Figura 15). Um ficheiro de protocolo 
contém as instruções para os passos da temperatura do instrumento e as opções 
do instrumento que controlam a velocidade de rampa e a temperatura da tampa. 

Seleccione uma das opções seguintes para seleccionar um protocolo existente, criar um novo 
protocolo ou editar o protocolo seleccionado actualmente:

• Botão Create New. Abrir o Protocol Editor (Editor de protocolos) para criar um novo 
protocolo

• Botão Select Existing. Abrir uma janela do browser para seleccionar e carregar 
um ficheiro de protocolo existente (extensão .prcl) no separador Protocol (Protocolo)

• Menu pendente Express Load. Seleccionar rapidamente um protocolo para carregá-lo 
no separador Protocol (Protocolo)

SUGESTÃO: Para adicionar ou eliminar protocolos no menu Express Load 
(Carregar rápido), adicione ou elimine ficheiros (extensão .prcl) na pasta Express 
Load (Carregar rápido). Para localizar esta pasta, seleccione Tools > User Data 
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Folder (Ferramentas > Pasta de dados do utilizador) na barra de menus da janela 
principal do software

• Botão Edit Selected. Abrir o protocolo seleccionado actualmente no Protocol Editor

Ciclos End Point Only (Só de ponto final)
Para executar um protocolo que contenha apenas um passo de aquisição de dados de ponto 
final, seleccione Options > End Point Only Run (Opções > Ciclo só de ponto final) 
em Options (Opções) na barra de menus da janela Experiment Setup (Configuração 
da experiência). O protocolo de ponto final predefinido, que inclui dois ciclos de 60,0°C 
durante 30 segundos, é carregado no separador Protocol (Protocolo). Para alterar 
a temperatura do passo ou o volume de amostra para o ciclo só de ponto final, clique 
no separador Start Run (Iniciar ciclo) e edite a temperatura de passo (Step Temperature) 
ou o volume de amostra (Sample Volume).

Separador Plate (Placa)
O separador Plate (Placa) mostra uma pré-visualização do ficheiro de placa seleccionado 
carregado na configuração da experiência (Figura 16). Numa experiência de PCR em tempo 
real, o ficheiro de placa contém uma descrição do conteúdo de cada poço, do modo de leitura 
e do tipo de placa. O CFX Manager software utiliza essas descrições para a recolha e análise 
de dados.

Seleccione uma das opções seguintes para seleccionar uma placa existente, criar uma nova 
placa ou editar a placa seleccionada actualmente:

• Botão Create New. Abrir o Plate Editor (Editor de placas) para criar uma nova placa

• Botão Select Existing. Abrir uma janela do browser para seleccionar e carregar 
um ficheiro de placa existente (extensão .pltd) no separador Plate (Placa)

• Menu pendente Express Load. Seleccionar rapidamente uma placa para carregá-la 
no separador Plate (Placa)

SUGESTÃO: Para adicionar ou eliminar placas no menu Express Load (Carregar 
rápido), adicione ou elimine ficheiros (extensão .pltd) na pasta Express Load 
(Carregar rápido). Para localizar esta pasta, seleccione Tools > User Data Folder 
(Ferramentas > Pasta de dados do utilizador) na barra de menus da janela principal 
do software.
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• Botão Edit Selected. Abrir a placa seleccionada actualmente no Plate Editor 

Figura 16. Janela do separador Plate (Placa).

Separador Start Run (Iniciar ciclo)
O separador Start Run (Iniciar ciclo) (Figura 17) inclui uma secção para verificar a informação 
sobre o ciclo que irá ser iniciado, incluindo os ficheiros de protocolo e placa seleccionados, 
e uma secção para seleccionar o bloco do instrumento.

• Painel Run Information (Informação do ciclo). Ver os ficheiros de protocolo e de placa 
seleccionados e a definição do modo de leitura (Scan Mode) de aquisição de dados. 
Introduza notas opcionais sobre a experiência na caixa Notes (Notas)
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• Painel Start Run on Selected Block(s) (Iniciar ciclo no(s) bloco(s) 
seleccionado(s)). Seleccione um ou mais blocos, edite os parâmetros do ciclo 
(se necessário) e clique no botão Start Run (Iniciar ciclo) para iniciar a experiência

Figura 17. O separador Start Run (Iniciar ciclo).

Para adicionar ou remover parâmetros do ciclo da folha de cálculo no painel Start Run on 
Selected Block(s) (Iniciar ciclo no(s) bloco(s) seleccionado(s)), clique com o botão direito 
do rato na lista e seleccione uma opção do menu para apresentar. Para seleccionar o valor 
a alterar, clique no texto dentro da célula para seleccioná-lo e digite na célula, ou seleccione 
um novo parâmetro no menu pendente. Os parâmetros editáveis incluem:

• Temperatura da tampa. Ver a temperatura da tampa. Anule a temperatura predefinida 
da tampa seleccionando o texto e digitando uma nova temperatura

AVISO! A alteração da temperatura da tampa pode influenciar os resultados 
e resultar em ciclos falhados. 

Botões de controlo do instrumento
Clique nos botões seguintes no separador Start Run (Iniciar ciclo) para operar remotamente 
os instrumentos seleccionados: 

• Start Run. Iniciar a experiência nos blocos de instrumentos seleccionados

• Flash Block Indicator. O indicador LED pisca nos blocos de instrumentos 
seleccionados

• Open Lid. Abrir a tampa motorizada nos blocos de instrumentos seleccionados

• Close Lid. Fechar a tampa motorizada nos blocos de instrumentos seleccionados
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Janela Run Details (Detalhes do ciclo)
Ao clicar no botão Start Run (Iniciar ciclo), o CFX Manager software sugere que guarde 
o nome do ficheiro de dados e, a seguir, abre a janela Run Details (Detalhes do ciclo). 
Analise a informação nesta janela para monitorizar o progresso do ciclo.

• Separador Run Status (Estado do ciclo). Verificar o estado actual do protocolo, abrir a 
tampa, fazer uma pausa num ciclo, adicionar repetições, ignorar passos ou parar o ciclo

• Separador Real-Time Status (Estado de tempo real). Ver os dados de fluorescência 
da PCR em tempo real à medida que são recolhidos

• Separador Time Status (Estado do tempo). Ver em ecrã total um temporizador 
de contagem decrescente para o protocolo

A Figura 18 mostra as funções da janela Run Details (Detalhes do ciclo). 

Figura 18. Janela Run Details (Detalhes do ciclo).

Separador Run Status (Estado do ciclo)
O separador Run Status (Estado do ciclo) (Figura 18) mostra o estado actual de um ciclo 
em curso na janela Run Details (Detalhes do ciclo) e apresenta botões (página 27) para 
controlar a tampa e alterar o ciclo em curso. 

• Painel Run Status (Estado do ciclo). Apresenta o progresso actual do protocolo, 
incluindo o passo actual, a repetição GOTO actual, temperatura do bloco, tempo 
de espera remanescente para o passo actual, temperatura da amostra, temperatura 
da tampa e do vaivém

• Botões de estado do ciclo. Clique num dos botões para operar remotamente 
o instrumento ou para interromper o protocolo actual

• Painel Run Information (Informação do ciclo). Apresenta detalhes da experiência
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BOTÕES DO SEPARADOR RUN STATUS (ESTADO DO CICLO)
Clique num dos botões mostrados na Tabela 10 para operar o instrumento a partir 
do software, ou para alterar o ciclo em curso. 
NOTA: Alterar o protocolo durante o ciclo (por exemplo, adicionar repetições), não altera 
o ficheiro de protocolo associado ao ciclo. Estas acções são registadas no registo do ciclo 
(Run Log).

Tabela 10. Botões do estado do ciclo e respectivas funções. 

Botão Função

Abrir a tampa motorizada nos instrumentos seleccionados

AVISO! Abrir a tampa durante um ciclo faz uma 
pausa no ciclo durante o passo actual e pode 
alterar os dados.

Fechar a tampa motorizada nos instrumentos seleccionados

Adicionar mais repetições ao passo GOTO actual 
do protocolo. Este botão só está disponível quando 
está em execução um passo GOTO

Ignorar o passo actual do protocolo. Se um passo GOTO 
for ignorado, o software verifica se pretende ignorar o ciclo 
GOTO total e avançar para o próximo passo do protocolo

O indicador LED pisca no instrumento seleccionado para 
identificar os blocos seleccionados

Fazer uma pausa no protocolo

NOTA: Esta acção é registada no registo do ciclo (Run Log).

Retomar um protocolo que estava em pausa

Parar o ciclo antes da conclusão do protocolo

AVISO! Parar prematuramente um ciclo pode 
alterar os dados e ter como consequência a falha 
da experiência.
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Separador Real-Time Status (Estado do tempo real)
O separador Real-time Status (Estado do tempo real) (Figura 19) mostra os dados de PCR 
em tempo real recolhidos em cada ciclo durante o protocolo após as duas primeiras leituras 
de placa. Este separador mostra também o selector de poços e texto que descreve o estado 
do protocolo na parte inferior da janela. 

Figura 19. O separador Real-time Status (Estado do tempo real) 
mostra os dados durante um ciclo.

SUBSTITUIR UM FICHEIRO DE PLACA

Durante um ciclo, substitua o ficheiro de placa clicando no botão Replace Plate (Substituir 
placa) (Figura 19) no separador Real-time Status (Estado do tempo real). Seleccione o novo 
ficheiro de placa (.pltd) na lista do browser Windows.

NOTA: O CFX Manager software verifica o modo de leitura e o tamanho da placa 
para o ficheiro de placa; estes devem coincidir com as definições do ciclo 
iniciadas durante a experiência. 

SUGESTÃO: A substituição de um ficheiro de placa é especialmente útil se iniciar 
um ciclo com um ficheiro Quick Plate (Placa rápida) na pasta Express Load 
(Carregar rápido). 

Separador Time Status (Estado do tempo)
O separador Time Status (Estado do tempo) mostra um temporizador de contagem 
decrescente para o ciclo actual.
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4 Protocolos
Leia o capítulo seguinte para obter informações sobre a criação e edição de ficheiros 
de protocolos:

• Janela Protocol Editor (Editor de protocolos) (abaixo)

• Controlos do Protocol Editor (página 31)

• Modo de controlo da temperatura (página 35)

• Protocol AutoWriter (página 35)

Janela Protocol Editor (Editor de protocolos)
Um protocolo dá instruções ao instrumento para controlar os passos da temperatura, 
a temperatura da tampa e outras opções do instrumento. Abra a janela Protocol Editor 
(Editor de protocolos) para criar um novo protocolo ou para editar o protocolo actualmente 
seleccionado no separador Protocol (Protocolo). Depois de criar ou editar um protocolo no 
Protocol Editor, clique em OK para carregar o ficheiro do protocolo na janela Experiment 
Setup (Configuração da experiência) e executá-lo.

AVISO! Confirme sempre que o protocolo carregado está correcto no separador 
Start Run (Iniciar ciclo) antes de iniciar o ciclo. Executar um ciclo com o protocolo 
errado pode alterar os dados ou resultar num ciclo falhado.

Abrir o Protocol Editor (Editor de protocolos)
Para abrir o Protocol Editor (Editor de protocolos), utilize uma das seguintes opções:

• Para criar um novo protocolo, seleccione File > New > Protocol (Ficheiro > Novo > 
Protocolo) ou clique no botão Create New (Criar novo) no separador Protocol 
(Protocolo) (página 22)

• Para abrir um protocolo existente, seleccione File > Open > Protocol (Ficheiro > 
Abrir > Protocolo) ou clique no botão Open Existing (Abrir existente) no separador 
Protocol (Protocolo) (página 22) 

• Para editar o protocolo actual no separador Protocol (Protocolo), clique no botão 
Edit Selected (Editar seleccionado) no separador Protocol (página 22)

SUGESTÃO: Para alterar as predefinições na janela Protocol Editor, introduza 
as alterações no separador Protocol (Protocolo) na janela User Preferences 
(Preferências do utilizador) (página 106)
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Janela Protocol Editor (Editor de protocolos)
A janela Protocol Editor (Editor de protocolos) (Figura 20) inclui as funções seguintes:

• Barra de menus. Seleccionar definições para o protocolo

• Barra de ferramentas. Seleccionar opções de edição do protocolo

• Protocolo. Ver o protocolo seleccionado na forma de gráfico (em cima) e como texto 
(em baixo). Clique na temperatura ou no tempo de espera na visualização de gráfico 
ou de texto de qualquer passo para introduzir um novo valor

• Botões do Protocol Editor. Para editar o protocolo, clique num dos botões à esquerda 
da visualização de texto

Figura 20. Janela Protocol Editor (Editor de protocolos) 
com botões de edição de protocolos.

Barra de menus do Protocol Editor (Editor de protocolos)
A barra de menus da janela Protocol Editor (Editor de protocolos) apresenta os itens de menu 
indicados na Tabela 11.

Tabela 11. Barra de menus do Protocol Editor (Editor de protocolos).

Item de menu Comando Função

File (Ficheiro) Save (Guardar) Guardar o protocolo actual

Save As 
(Guardar como)

Guardar o protocolo actual com um novo nome ou noutra 
localização

Close (Fechar) Fechar o Protocol Editor (Editor de protocolos)

Settings 
(Definições)

Lid Settings 
(Definições da 
tampa)

Abrir a janela Lid Settings (Definições da tampa) para alterar 
ou definir a temperatura da tampa
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A barra de ferramentas da janela Protocol Editor (Editor de protocolos) permite o acesso 
rápido a funções importantes. A Tabela 12 mostra as funções dos botões da barra 
de ferramentas do Protocol Editor. 

Controlos do Protocol Editor (Editor de protocolos)
A janela Protocol Editor (Editor de protocolos) apresenta botões para editar o protocolo 
na parte inferior esquerda do ecrã. Em primeiro lugar, seleccione e realce um passo 
do protocolo clicando com o ponteiro do rato. A seguir, clique num dos botões do Protocol 
Editor (Editor de protocolos) no lado inferior esquerdo da janela. A localização para a inserção 
de um novo passo (Before (antes)) ou (After (depois)) do passo seleccionado actualmente 
é determinada pelo estado da caixa Insert Step (Inserir passo) na barra de ferramentas.

Tools 
(Ferramentas)

Gradient 
Calculator 
(Calculador 
de gradiente)

Seleccionar o tipo de bloco para um passo do gradiente.

Run-time 
Calculator 
(Calculador 
de tempo 
de execução)

Seleccionar o instrumento e o modo de leitura a utilizar 
para calcular o tempo de execução previsto na janela 
Experiment Setup (Configuração da experiência)

Tabela 12. Botões da barra de ferramentas do Protocol Editor (Editor de protocolos). 

Botão e menus da barra 
de ferramentas

Nome Função

 

Save (Guardar) Guardar o ficheiro de protocolo actual

 

Print (Imprimir) Imprimir a janela seleccionada

Insert Step 
(Inserir passo)

Seleccione After (Depois) ou Before (Antes) 
para inserir um passo relativo ao passo 
actualmente realçado

Sample Volume 
(Volume de 
amostra)

Introduza um volume de amostra 
em μl entre 0 e 50. O volume de amostra 
determina o modo de controlo 
da temperatura (página 35). Introduza 
zero (0) para seleccionar o modo de bloco

Run Time (Tempo 
de execução)

Ver um tempo de execução previsto 
com base nos passos do protocolo 
e na velocidade de rampa

Help (Ajuda) Abrir a ajuda (Help) do software para obter 
mais informações sobre protocolos

Tabela 11. Barra de menus do Protocol Editor (Editor de protocolos). (continuação)

Item de menu Comando Função
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Botão Insert Step (Inserir passo) 
Para inserir um passo de temperatura antes ou depois do passo seleccionado actualmente:

1. Clique no botão Insert Step (Inserir passo).

2. Para alterar a temperatura ou o tempo de espera, clique no valor predefinido 
na visualização de gráfico ou de texto e introduza um novo valor.

Adicionar ou remover uma leitura de placa
Para adicionar uma leitura de placa a um passo ou para remover uma leitura de placa 
de um passo:

1. Seleccione o passo clicando no mesmo, na visualização de gráfico ou de texto.

2. Clique no botão Add Plate Read to Step (Adicionar leitura de placa a passo) para 
adicionar uma leitura de placa ao passo seleccionado. Se o passo já contiver uma leitura 
de placa, o texto do botão muda para Remove Plate Read (Remover leitura de placa). 
Clique para remover uma leitura de placa do passo seleccionado.

Botão Insert Gradient (Inserir gradiente)
Para inserir um passo de gradiente antes ou depois do passo seleccionado actualmente:

1. Para inserir um passo de gradiente de temperatura, clique no botão Insert Gradient 
(Inserir gradiente). 

2. Para alterar o intervalo de temperaturas de gradiente, clique na temperatura predefinida 
na visualização de gráfico ou de texto e introduza uma nova temperatura. 

3. Para editar o tempo de espera, clique no valor predefinido na visualização de gráfico 
ou de texto e introduza um novo tempo.
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A Figura 21 mostra o passo de gradiente inserido. As temperaturas de cada fila do gradiente 
são mostradas no lado direito da janela.

Figura 21. Protocolo com o passo de gradiente inserido.

Botão Insert GOTO (Inserir GOTO)
Para inserir um passo GOTO antes ou depois do passo seleccionado:

1. Clique no botão Insert GOTO (Inserir GOTO). 

2. Para alterar o número de passo GOTO ou o número de repetições GOTO, clique 
noSavenúmero predefinido na visualização de gráfico ou de texto e introduza 
um novo valor.

A Figura 21 mostra um passo GOTO inserido no final do protocolo. Repare que o ciclo GOTO 
inclui os passos 2 a 4. 

Botão Insert Melt Curve (Inserir curva de fusão)
Para inserir um passo de curva de fusão antes ou depois do passo seleccionado:

1. Clique no botão Insert Melt Curve (Inserir curva de fusão).

2. Para alterar o intervalo de temperaturas de fusão ou incrementar o tempo, clique 
noSavenúmero predefinido na visualização de gráfico ou de texto e introduza um novo 
valor. EmSavealternativa, clique no botão Step Options (Opções de passos) para 
introduzir oSaveintervalo de gradientes na janela Step Options (Opções de passos) 
(página 34).

NOTA: Não é possível inserir um passo de curva de fusão num ciclo GOTO.

NOTA: O passo de curva de fusão inclui um tempo de espera de 30 segundos 
noSaveinício do passo que não é mostrado no protocolo.
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Figura 22 - passo de curva de fusão adicionado após o passo 6.

Figura 22. Protocolo com o passo de curva de fusão inserido.

Opções de passos
Para alterar uma opção de passo relativamente ao passo seleccionado:

1. Seleccione um passo clicando no mesmo, na visualização de gráfico ou de texto.

2. Clique no botão Step Options (Opções de passos) para abrir a janela Step Options.

3. Para adicionar ou remover opções, introduza um número, edite um número ou clique 
naSavecaixa de selecção. 

SUGESTÃO: Para que um passo fique para sempre em espera (espera infinita), 
introduza zero (0.00) para o tempo.

A Figura 23 mostra o passo seleccionado com um gradiente de 10°C. Repare que algumas 
opções não estão disponíveis num passo de gradiente. Um passo de gradiente não pode 
incluir uma alteração da velocidade de rampa ou incremento.

Figura 23. Opção de passo para um gradiente.

A janela Step Options (Opções de passos) mostra as opções seguintes que podem 
ser adicionadas ou removidas dos passos:

• Plate Read. Seleccionar a caixa para incluir uma leitura de placa

• Temperature. Introduzir uma temperatura alvo para o passo seleccionado
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• Gradient. Introduzir um intervalo de gradientes para o passo 

• Increment. Introduzir uma temperatura para incrementar o passo seleccionado; 
aSavequantidade do incremento é adicionada à temperatura alvo com cada ciclo

• Ramp Rate. Introduzir uma velocidade para o passo seleccionado; o intervalo depende 
do tamanho do bloco

• Time. Introduzir um tempo de espera para o passo seleccionado

• Extend. Introduzir um tempo de prolongamento do passo seleccionado. O tempo 
deSaveprolongamento é adicionado ao tempo de espera com cada ciclo

• Beep. Seleccionar a caixa para incluir um sinal sonoro (bipe) no fim do passo

SUGESTÃO: Ao introduzir um número que esteja fora do intervalo de opções, 
oSavesoftware altera o número para a entrada mais próxima dentro do intervalo.

Botão Delete Step (Eliminar passo)
Para eliminar um passo do protocolo:

1. Seleccione um passo na visualização de gráfico ou de texto.

2. Clique no botão Delete Step (Eliminar passo) para eliminar o passo seleccionado.

AVISO! Esta função não pode ser anulada.

Modo de controlo da temperatura
O instrumento utiliza um de dois modos de controlo da temperatura para determinar 
o momento em que a amostra atinge a temperatura alvo num protocolo. 

Introduza um volume de amostra no editor de protocolos para seleccionar um modo 
de controlo da temperatura:

• Modo calculado. Ao introduzir um volume de amostra entre 1 e 50 μl, o termociclador 
calcula a temperatura da amostra com base no volume. Este é o modo padrão

• Modo de bloco. Ao introduzir um volume de amostra de zero (0) μl, o termociclador 
regista a temperatura da amostra com sendo igual à temperatura medida do bloco

Protocol AutoWriter
Abra o Protocol AutoWriter para gravar protocolos rapidamente para experiências de PCR 
e PCR em tempo real. Para abrir o Protocol AutoWriter, seleccione uma das seguintes opções:

• Clique no botão do Protocol AutoWriter na barra de ferramentas da janela principal 
do software

• Seleccione Tools > Protocol AutoWriter (Ferramentas > Protocol AutoWriter) 
na barra de menus da janela principal do software
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Figura 24 - protocolo (parte inferior da janela) gravado pelo Protocol AutoWriter.

Figura 24. Janela Protocol AutoWriter com um novo protocolo.

Criar um protocolo com o Protocol AutoWriter
A janela Protocol AutoWriter utiliza informações sobre a reacção para gerar automaticamente 
um ficheiro de protocolo. Siga estes passos para utilizar o Protocol AutoWriter para criar um 
novo protocolo:

1. Clique no botão do Protocol AutoWriter na barra de ferramentas para abrir a janela 
Protocol AutoWriter.

2. Introduza a Annealing Temperature (Ta) (Temperatura de annealing) e o Amplicon 
Length (Comprimento do amplicon) nas caixas do painel Enter Target Values/Enzymes 
(Introduzir valores alvo/enzimas). Se não conhece a temperatura de annealing para 
preparadores, clique no botão Ta Calculator (Calculador de temperatura) para introduzir 
as sequências de preparadores e calcular a temperatura de annealing. Para informações 
sobre os cálculos utilizados no calculador de temperatura, consulte Breslauer 
et al. 1986.

3. Seleccione um tipo de enzima na lista de opções (iTaq, iProof ou Other).

4. Adicione parâmetros no painel Additional Parameters (Optional) (Parâmetros 
adicionais (opcional)) se pretende adicionar um intervalo de gradientes (Gradient Range), 
uma temperatura de activação “hot start” (Hot Start Activation) ou um tempo 
de prolongamento final (Final Extension) ao protocolo.

5. Seleccione uma velocidade de protocolo (Standard (Padrão), Fast (Rápido), Ultrafast 
(Ultra-rápido) ou, deslocando para tal o cursor vertical deslizante no painel Type (Tipo). 
Ao deslocar a barra deslizante, o software ajusta o tempo de execução total. Seleccione 
Real-time PCR (PCR em tempo real) para comunicar ao software para recolher dados 
de fluorescência.
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6. Reveja o protocolo no painel Preview (Pré-visualização) e o tempo de execução total. 
Efectue as alterações necessárias.

7. Clique em OK para guardar o novo protocolo, ou clique em Cancel (Cancelar) 
para fechar a janela sem guardar o protocolo.

NOTA: A Bio-Rad Laboratories não garante que a execução de um protocolo 
gravado na janela Protocol AutoWriter resultará sempre num produto de PCR.
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5 Placas
Leia este capítulo para obter informações sobre a criação e edição de ficheiros de placas:

• Janela Plate Editor (Editor de placas) (abaixo)

• Janela Select Fluorophores (Seleccionar fluoróforos) (página 42)

• Controlos de carregamento dos poços (página 42)

• Janela Well Groups Manager (Gestor de grupos de poços) (página 47)

Janela Plate Editor (Editor de placas)
Um ficheiro de placa contêm parâmetros de execução, tais como o modo de leitura 
e fluoróforos, e o conteúdo dos poços, e indica ao instrumento a forma como deve analisar 
os dados. Abra a janela Plate Editor (Editor de placas) para criar uma nova placa ou para 
editar a placa actualmente seleccionada no separador Plate (Placa). Depois de criar ou editar 
uma placa no editor de placas, clique em OK para carregar o ficheiro da placa na janela 
Experiment Setup (Configuração da experiência) e executá-lo.

Para executar uma experiência, tem de carregar pelo menos um poço com o tipo de amostra 
e fluoróforo.

SUGESTÃO: Clique no botão Plate Loading Guide (Guia de carregamento 
de placas) para abrir a respectiva janela de guia de carregamento de placas a partir 
da barra de ferramentas para ver rapidamente as instruções de carregamento 
de uma placa.

Abrir o Plate Editor (Editor de placas)
Para abrir a janela Plate Editor (Editor de placas) (Figura 25), utilize uma das seguinte opções:

• Para criar uma nova placa, seleccione File > New > Plate (Ficheiro > Nova > Placa) 
ou clique no botão Create New (Criar nova) no separador Plate (Placa) (página 23)

• Para abrir uma placa existente, seleccione File > Open > Plate (Ficheiro > Abrir > 
Placa) ou clique no botão Open Existing (Abrir existente) no separador Plate (Placa) 
(página 23)

• Para editar o protocolo actual no separador Plate (Placa), clique no botão Edit 
Selected (Editar seleccionado) no separador Plate (página 23)

• Para abrir a placa associada a um ficheiro de dados na janela Data Analysis (Análise 
de dados) (página 61), faça clique em View/Edit Plate (Ver/Editar placa) na barra 
de ferramentas
39



Placas
Figura 25. Janela Plate Editor (Editor de placas).

Dimensão e tipo de placa
O software aplica as seguintes definições de placa a todos os poços durante a experiência:

• Plate Size. Seleccione um Plate Size (tamanho de placa) sob o menu Settings 
(Definições) que represente a dimensão do bloco do módulo de reacção do instrumento. 
Ao seleccionar o tipo de instrumento, CFX96, na opção do menu pendente no Startup 
Wizard (Assistente de arranque), irá alterar a dimensão de placa predefinida carregada 
no separador Plate (Placa) da janela Experiment Settings (Definições da experiência). 
No Plate Editor (Editor de placas), seleccione a dimensão da placa no menu Settings 
(Definições) (consulte a Tabela 13 na página 41). A dimensão da placa não pode 
ser alterada durante ou após a experiência

• Plate Type. Seleccione Clear Wells (Poços transparentes) ou White Wells (Poços 
brancos) em Plate Type (Tipo de placa) sob o menu Settings (Definições). Certifique-se 
de que o fluoróforo que está a ser utilizado na experiência está calibrado para o tipo 
de placa seleccionado 

NOTA: Os instrumentos CFX96 vêm calibrados de fábrica para muitas 
combinações de marcador fluorescente e placas. A calibração é específica do 
instrumento, fluorocromo e tipo de placa. Para calibrar uma nova combinação 
de fluorocromo e tipo de placa num instrumento, seleccione Tools > Calibration 
Wizard (Ferramentas > Assistente de calibração) (consulte “Assistente de 
calibração” na página 115)
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Modo de leitura
O sistema CFX96 excita e detecta fluoróforos em seis canais e utiliza vários modos de 
leitura de aquisição de dados para recolher os dados de fluorescência durante um ciclo.

Seleccione um destes modos de leitura na barra de ferramentas da janela Plate Editor 
(Editor de placas): 

• All Channels. Inclui os canais 1 a 5 no sistema CFX96

• SYBR/FAM only. Inclui apenas o canal 1 e faculta uma leitura rápida

• FRET. Inclui apenas o canal FRET e faculta uma leitura rápida

Barra de ferramentas do Plate Editor (Editor de placas)
A barra de ferramentas do Plate Editor (Editor de placas) faculta o acesso rápido a 
importantes funções de carregamento de placas:

A Tabela 13 mostra as funções disponíveis na barra de ferramentas do Plate Editor. 

Tabela 13. Itens da barra de ferramentas no Plate Editor.

Item da barra de 
ferramentas

Nome Função

Save 
(Guardar)

Guardar o ficheiro de placa actual

Print 
(Imprimir)

Imprimir a janela seleccionada

Zoom Aumentar ou diminuir a ampliação na visualização 
da placa

Scan Mode 
(Modo 
de leitura)

Seleccione um modo de leitura para indicar ao 
instrumento quais os canais dos quais deve recolher 
dados de fluorescência durante um ciclo. Seleccione All 
Channels (Todos os canais) (predefinição), SYBR/FAM 
only (Apenas SYBR/FAM) ou FRET

Well Groups 
(Grupos 
de poços)

Abrir a janela Well Groups Manager (Gestor de grupos 
de poços) e configurar os grupos de poços para a placa 
actual

Ajuda Abrir a Ajuda (Help) do software para obter informações 
sobre as placas

Plate Loading 
Guide (Guia 
de carrega-
mento 
de placas)

Mostra um guia rápido sobre como configurar uma placa 
e carregar os poços 
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Janela Select Fluorophores (Seleccionar fluoróforos)
A janela Select Fluorophores (Seleccionar fluoróforos) mostra os fluoróforos que podem ser 
seleccionados para carregar nos controlos de carregamento de poços no Plate Editor (Editor 
de placas). Para abrir a janela Select Fluorophores (Seleccionar fluoróforos), clique no botão 
Select Fluorophores (Seleccionar fluoróforos) no lado direito do Plate Editor. 

NOTA: Os fluoróforos mostrados dependem do modo de leitura; quando estiver 
seleccionada a opção “SYBR/FAM only” (Apenas SYBR/FAM), apenas os 
fluoróforos no canal 1 serão apresentados na janela Select Fluorophores 
(Seleccionar fluoróforos).

NOTA: Não é possível adicionar ou remover fluoróforos nesta lista; tem de calibrar 
os novos fluoróforos num instrumento no Calibration Wizard (Assistente de 
calibração) (página 115). Após a calibração, é adicionado o novo fluoróforo 
na janela Select Fluorophores (Seleccionar fluoróforos).

Clique na caixa de selecção Selected (Seleccionado) ao lado do nome do fluoróforo para 
adicionar ou remover os fluoróforos da lista no lado direito da janela Plate Editor.

Neste exemplo, SYBR está seleccionado na lista de fluoróforos disponíveis (Figura 26).

Figura 26. Janela Select Fluorophores (Seleccionar fluoróforos).

• Clique na caixa Color (Cor) ao lado do nome do fluoróforo e seleccione uma nova 
cor para representar cada fluoróforo na janela Plate Editor (Editor de placas) e nos 
gráficos Data Analysis (Análise de dados)

NOTA: Antes de iniciar o ciclo, o software verifica se os fluoróforos que especificou 
na placa estão calibrados para esse instrumento. Não é possível executar uma 
placa se esta incluir fluoróforos que não tenham sido calibrados nesse 
instrumento.

Controlos de carregamento dos poços
Um ficheiro de placa contém informações sobre o conteúdo de cada poço carregado 
com amostra para uma experiência. Após o ciclo, o software liga o conteúdo dos poços aos 
dados de fluorescência recolhidos durante o protocolo e aplica a análise apropriada na janela 
Data Analysis (Análise de dados). Por exemplo, os poços carregados com o tipo de amostra 
padrão são utilizados para gerar uma curva padrão. 
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Tenha em consideração as seguintes directrizes para o conteúdo dos poços:

• Target Name. Um ou mais alvos de interesse (genes ou sequências) em cada poço 
carregado. Cada alvo está atribuído a um fluoróforo

• Sample Name. Um identificador ou condição que corresponde à amostra em cada 
poço carregado, por exemplo, 0 hr, 1 hr ou 2 hr

Seleccione um poço para onde carregar o conteúdo, clicando para tal com o ponteiro do rato 
na visualização da placa. Mantenha o botão do rato premido e arraste para seleccionar vários 
poços. Os botões e as listas no lado direito da visualização da placa incluem todas as opções 
necessárias para carregar os poços (Tabela 14).

Tabela 14. Opções para carregar a placa e os poços no Plate Editor (Editor de placas).

Opção Função

Após seleccionar os poços, o tipo de amostra (Sample 
Type) tem de ser carregado em primeiro lugar. Seleccione 
um tipo de amostra (Sample Type) no menu pendente 
para carregar nos poços seleccionados, incluindo 
Unknown (Desconhecido), Standard (Padrão), NTC 
(no template control), Positive Control (Controlo 
positivo), Negative Control (Controlo negativo) e NRT 
(no reverse transcriptase).

Clique numa caixa Load (Carregar) para adicionar um 
fluoróforo aos poços seleccionados; cada fluoróforo 
corresponde ao nome de um alvo. Para adicionar 
fluoróforos à lista Load (Carregar), seleccione-os 
na janela Select Fluorophores (Seleccionar fluoróforos). 

Para distinguir entre vários alvos, seleccione um nome 
no menu pendente Target Name (Nome do alvo) e prima 
a tecla Enter para carregar o nome do alvo no poço. 
Para adicionar um novo nome de alvo ao menu pendente 
apenas na placa actual, escreva um nome na caixa 
pendente e prima a tecla Enter. Para eliminar um nome 
de alvo, seleccione-o, prima a tecla Delete (Eliminar) 
e prima a tecla Enter.

Para uma análise de expressão de genes ou para 
distinguir entre várias amostras, seleccione um Sample 
Name (nome de amostra) no menu pendente para 
carregar o nome da amostra nos poços seleccionados. 
Para adicionar um novo nome de amostra ao menu 
pendente na placa actual, escreva um novo nome 
na caixa pendente e prima a tecla Enter. Para eliminar 
um nome de amostra, seleccione-o no menu, prima 
a tecla Delete (Eliminar) no teclado e, em seguida, prima 
a tecla Enter.

Para carregar números replicados, os poços 
seleccionados têm de conter conteúdos de poços 
idênticos. Caso contrário, o software desactiva este 
controlo de carregamento. Faça clique na caixa Load 
(Carregar) para adicionar um Replicate # (N.º de réplica) 
aos poços seleccionados. 
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No painel Replicate Series (Série de réplicas) pode 
aplicar uma série de réplicas a um conjunto de poços 
seleccionados. Para introduzir um tamanho de grupo 
de réplicas (Replicate Group Size), seleccione um 
número que representa as amostras (poços) em cada 
grupo de réplicas. Seleccione Starting Replicate # 
(N.º de réplica inicial) para adicionar réplicas.

Pode carregar grupos de réplicas com números 
de réplicas da esquerda para a direita (Horizontal) 
ou de cima para baixo (Vertical).

Para introduzir uma concentração nos poços 
seleccionados com o tipo de amostra padrão, edite 
ou escreva um número na caixa Concentration 
(Concentração). Para aplicar a concentração a um 
fluoróforo no poço, seleccione um único fluoróforo 
no menu pendente (<All>) (Todos) sob a caixa de 
concentração. Para eliminar uma concentração, 
seleccione-a, prima a tecla Back Space no teclado e, 
em seguida, prima a tecla Enter.

Seleccione vários poços com um tipo de amostra padrão 
para activar o botão Dilution Series (Série de diluição).

Clique no botão Dilution Series (Série de diluição) para 
introduzir uma série de diluição para a concentração 
de amostras padrão e carregar uma curva padrão.

Introduza a concentração inicial (Starting Concentration) 
para a série de diluição, as (Replicates from) (número 
de réplica inicial) e to (número de réplica final) e o factor 
de diluição (Dilution Factor) (quantidade para alterar 
a concentração em cada grupo de réplicas). Seleccione 
Increasing (De aumento) para uma série de diluição que 
aumenta ou Decreasing (De diminuição) para uma série 
de diluição que diminui. Por fim, seleccione o fluoróforo 
utilizado para a série de diluição no menu pendente 
e clique em Apply (Aplicar).

Seleccione Tools > Show Well Notes (Ferramentas > 
Mostrar notas sobre poço) para mostrar este painel. 
Para introduzir notas sobre um ou mais poços, seleccione 
os poços e escreva as notas no menu pendente. 
Quaisquer notas que adicionar aparecem na folha 
de cálculo no separador Quantitation Data (Dados 
de quantificação) (página 76).

Tabela 14. Opções para carregar a placa e os poços no Plate Editor (Editor de placas). 

Opção Função
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Janela Experiment Settings (Definições da experiência)
Para abrir a janela Experiment Settings (Definições da experiência), utilize uma das seguintes 
opções:

• No Plate Editor (Editor de placas), clique no botão Experiment Settings (Definições 
da experiência)

• Ao analisar dados na janela Data Analysis (Análise de dados), clique no botão 
Experiment Settings (Definições da experiência) no separador Gene Expression 
(Expressão de genes)

Abra a janela Experiment Settings (Definições da experiência) para ver ou alterar a lista 
de Targets (Alvos) e Samples (Amostras) (Figura 27) ou definir o grupo de amostras para 
análise da expressão de genes a analisar se os Collection Names (nomes da recolha) tiverem 
sido adicionados aos poços.

• Targets. Uma lista de nomes de alvos para cada reacção de PCR, como um gene 
ou sequência de interesse. Clique na coluna Reference (Referência) para atribuir genes 
de referência a uma experiência

• Samples. Uma lista de nomes de amostras que indica a origem do alvo, como, 
por exemplo, uma amostra retirada a 1 hora (1 hr) ou retirada de um indivíduo específico 
(rato1). Clique na coluna Control (Controlo) para atribuir a condição de controlo 
a uma experiência

Seleccione Tools > Show Collection Name 
(Ferramentas > Mostrar nome da recolha) para mostrar 
este painel. Para introduzir a informação da recolha de 
amostras sobre um ou mais poços, seleccione os poços 
e escreva o nome de uma recolha no menu pendente. 
Qualquer nome de recolha que adicionar aos poços 
aparece na janela Gene Expression Analysis (Análise da 
expressão de genes) e permite opções de agrupamento 
de amostras.

Clique no botão Experiment Settings (Definições 
da experiência) na respectiva janela para gerir as listas 
de Targets (Alvos) e Samples (Amostras) e configurar uma 
experiência de expressão de genes.

Clique no botão Clear Replicate # (Limpar réplica n.º) 
para limpar os números das réplicas nos poços 
seleccionados.

Clique no botão Clear Wells (Limpar poços) para limpar 
permanentemente todo o conteúdo nos poços 
seleccionados.

Tabela 14. Opções para carregar a placa e os poços no Plate Editor (Editor de placas). 

Opção Função
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Figura 27 - separador Targets (Alvos) com as definições da análise.

Figura 27. Separador Targets (Alvos) na janela Experiment Settings 
(Definições da experiência).

A Figura 28 mostra o separador Samples (Amostras) com as definições da análise. 

Figura 28. Separador Samples (Amostras) na janela Experiment Settings 
(Definições da experiência).

Para ajustar as listas nestes separadores, utilize as funções seguintes:

• Para adicionar um nome de alvo ou amostra, escreva um nome na caixa New (Novo) 
e clique em Add (Adicionar)

• Para remover um nome de alvo ou de amostra da lista, clique na caixa Select 
to Remove (Seleccionar para remover) nessa fila e clique no botão Remove 
checked item(s) (Remover itens seleccionados)

• Para seleccionar o alvo como uma referência para a análise de dados da expressão 
de genes, clique na caixa na coluna Reference (Referência) ao lado do nome 
desse alvo

• Para seleccionar a amostra como amostra de controlo para a análise de dados 
da expressão de genes, clique na caixa na coluna Control (Controlo) ao lado 
do nome dessa amostra
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Clique na caixa Show Analysis Settings (Mostrar definições da análise) na janela Experiment 
Settings (Definições da experiência) para ver ou alterar os parâmetros da análise aplicados 
no separador Gene Expression (Expressão de genes).

Para ajustar os parâmetros do alvo:

• Clique numa célula na coluna Color (Cor) para alterar a cor dos alvos incluídos 
no gráfico Gene Expression (Expressão de genes)

• Introduza um número para a eficiência de um alvo. O software irá calcular 
a eficiência relativa para um alvo utilizando Auto Efficiency (Eficiência automática) 
se os dados de um alvo incluírem uma curva padrão. Alternativamente, introduza 
uma eficiência previamente determinada

Para ajustar as definições de uma amostra no separador Samples (Amostras):

• Clique numa cor na coluna Color (Cor) para alterar a cor das amostras incluídas 
no gráfico Gene Expression (Expressão de genes)

• Clique numa caixa na coluna Show Graph (Mostrar gráfico) para mostrar a amostra 
no gráfico Gene Expression (Expressão de genes) utilizando uma cor que esteja 
seleccionada na coluna Color (Cor)

Sample Name Grouping Option (Opção de agrupamento 
por nomes de amostra)
Carregar os nomes de recolha (Collection Names) nos poços permite que as amostras sejam 
analisadas numa de quatro configurações definidas pela opção de agrupamento por nomes 
de amostra (Sample Name Grouping Option). Estas opções estão disponíveis no menu 
pendente no separador Experiment Settings (Definições da experiência). 

• Target vs. Sample (Alvo vs. Amostra)

• Target vs. Collection (Alvo vs. Recolha)

• Target vs. Sample_Collection (Alvo vs. Amostra_Recolha)

• Target vs. Collection_Sample (Alvo vs. Recolha_Amostra)

Janela Well Groups Manager (Gestor de grupos 
de poços)

Os grupos de poços dividem uma placa em subconjuntos de poços que podem 
ser analisados de forma independente na janela Data Analysis (Análise de dados). Quando 
os grupos de poços estiverem configurados, seleccione um na janela Data Analysis (Análise 
de dados) para analisar os dados num grupo independente. Por exemplo, configure grupos 
de poços para analisar várias experiências executadas numa placa ou para analisar cada 
grupo de poços com uma curva padrão diferente.

NOTA: O grupo de poços predefinido é All Wells (Todos os poços).

Criar grupos de poços
Para criar grupos de poços na janela Well Groups Manager (Gestor de grupos de poços), 
siga estas instruções:

1. Clique no botão Well Groups (Grupos de poços) na barra de ferramentas do Plate Editor 
(Editor de placas).
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2. Clique em Add (Adicionar) para criar um novo grupo. O menu pendente mostra o nome 
do grupo como Group 1 (Grupo 1) para o primeiro grupo.

3. Para seleccionar os poços que irão constituir o grupo de poços na visualização 
da placa, clique e arraste o grupo de poços. Os poços seleccionados ficam com a cor 
azul (Figura 29). 

4. (Opcional) Altere o nome do grupo seleccionando o nome do grupo no menu pendente 
e escrevendo um novo nome.

5. (Opcional) Crie mais grupos de poços repetindo os passos 1 e 2.

6. (Opcional) Elimine os grupos de poços seleccionando o nome do grupo na lista 
pendente e clicando no botão Delete (Eliminar).

7. Clique em OK para terminar e fechar a janela, ou clique em Cancel (Cancelar) para 
fechar a janela sem efectuar alterações.

Figura 29. Cor dos poços na janela Well Group Manager (Gestor de grupos de poços).
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Janela Plate Spreadsheet View (Visualização da folha 
de cálculo da placa)

A janela Plate Spreadsheet View (Visualização da folha de cálculo da placa) mostra 
o conteúdo de uma placa no Plate Editor (Editor de placas). Para abrir a janela Plate 
Spreadsheet View (Figura 30), seleccione Tools > Show Spreadsheet View (Ferramentas > 
Mostrar visualização da folha de cálculo) na barra do menu do Plate Editor. 

Figura 30. Janela Plate Spreadsheet View (Visualização da folha de cálculo da placa).

Abra a visualização da folha de cálculo para importar ou exportar o conteúdo dos poços para 
o Excel ou outro formato delimitado por separadores:

• Clique em Import Template (Importar modelo) para importar o conteúdo dos poços 
a partir de um ficheiro delimitado por vírgulas

• Clique em Export Template (Exportar modelo) para exportar o conteúdo dos poços 
no formato Excel (formato .csv)

Para ordenar ou editar uma coluna, seleccione-a e utilize os métodos seguintes:

• Ordene a folha de cálculo de acordo com os dados numa coluna, clicando 
no diamante ao lado do nome da coluna

• Edite o conteúdo de uma coluna que tenha um asterisco (*) no topo, clicando 
e digitando cada poço

NOTA: Para seleccionar as unidades dos dados da curva padrão na coluna 
Quantity (Quantidade), abra o Plate Editor (Editor de placas) e seleccione 
Settings > Units (Definições > Unidades) na barra de menus. Após a execução 
da placa, os dados destes padrões aparecem no gráfico Standard Curve (Curva 
padrão) do separador Quantitation (Quantificação) da janela Data Analysis (Análise 
de dados) com as unidades que seleccionar. Abra a visualização da folha 
de cálculo para importar ou exportar o conteúdo das placas para o Excel ou outro 
formato delimitado por separadores.

Clique com o botão direito na folha de cálculo para seleccionar uma destas opções a partir 
do menu de clique direito:

• Copy. Copiar a folha de cálculo na totalidade

• Copy as Image. Copiar a folha de cálculo como um ficheiro de imagem

• Print. Imprimir a folha de cálculo

• Print Selection. Imprimir apenas as células seleccionadas
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• Export to Excel. Exportar o ficheiro como um ficheiro formatado para Excel

• Export to Text. Exportar o ficheiro como um ficheiro de texto

• Find. Localizar texto na folha de cálculo

• Sort. Ordenar a folha de cálculo seleccionando até três colunas de dados na janela 
Sort (Ordenar)
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6 Operação independente
Leia este capítulo para obter informações sobre a utilização do Sistema de detecção por PCR 
em tempo real CFX96™ no modo independente (standalone):

• Termociclador C1000™ (abaixo)

• Criar uma nova experiência (página 53)

• Exportação de dados para análise (página 58)

• Criar um ficheiro de dados (página 60)

Termociclador C1000
O sistema CFX96 pode executar experiências de PCR em tempo real sem um computador. 
Também é possível exportar os dados de fluorescência adquiridos durante um ciclo utilizando 
uma unidade de memória USB. Pode também optar pelo envio directo dos dados por e-mail 
para si se a base do C1000 estiver ligada à Internet e se estiver configurada a funcionalidade 
de e-mail (consulte o Manual de Instruções do termociclador C1000 para obter informações 
sobre a configuração das definições de e-mail). Os dados requerem o CFX™ Manager 
software para análise. 

O painel de controlo do Termociclador C1000™ dá acesso a todas as funções necessárias 
para operar o instrumento. A Figura 31 mostra os componentes do painel de controlo: 

Figura 31. O painel de controlo do termociclador C1000.

 
 

Teclas de 
comando

LCD
Teclas 
alfanuméricas

Teclas de 
navegação

Tecla do Protocol 
AutoWriter

Porta USB 
(abaixo)

Teclas de funções
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O painel de controlo contém cinco conjuntos de teclas cujas funções são mostradas 
na Tabela 15: 

Menu principal
Quando o sistema CFX96 arranca, executa um auto-teste para verificar as funções e, 
em seguida, apresenta o menu principal. O menu principal dá acesso a todas as operações 
do sistema, mostra a data e a hora, o nome do utilizador em sessão, o estado do sistema, 
o tipo de módulo de reacção e o nome do termociclador e os termocicladores 
S1000™ ligados.

NOTA: O termociclador C1000 armazena até 20 ciclos de experiências de PCR 
em tempo real, utilizando a indicação da data/hora nos ciclos. Com 20 ciclos 
armazenados no C1000, começam a ser eliminados os dados de ciclos mais 
antigos à medida que são armazenados novos ciclos.

Tabela 15. Funções das teclas do painel de controlo.

Tecla Função

TECLAS DE COMANDO 

RUN (EXECUTAR) Seleccionar e executar um protocolo 

EDIT (EDITAR) Seleccionar e alterar um protocolo 

STATUS (ESTADO) Ver o estado de um ou mais protocolos em execução

VIEW (VER) Alternar entre as visualizações de gráficos e de texto 
de um protocolo 

TECLAS DE FUNÇÕES

F1, F2, F3 ou F4 Os nomes e as funções das teclas de funções mudam 
em cada ecrã

TECLAS ALFANUMÉRICAS

1 a 9 Introduzir números ou letras do alfabeto. Prima uma tecla 
várias vezes para digitar as letras associadas

0, INCUBAÇÃO Inserir um zero,  (infinito) ou iniciar a incubação 
instantânea

ponto decimal (.) Introduzir um ponto decimal

sinal de menos (–) Introduzir um sinal de menos

Protocol AutoWriter 

Tecla do Protocol AutoWriter Lançar o Protocol AutoWriter

TECLAS DE NAVEGAÇÃO

Seta P/DIREITA Mover o cursor para a direita

Seta P/ESQUERDA Mover o cursor para a esquerda

Seta P/CIMA Mover o cursor para cima

Seta P/BAIXO Mover o cursor para baixo

ENTER Confirmar uma definição

BACK Cancelar uma função. Apagar uma letra, um número 
ou uma palavra
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Figura 32. Ecrã de arranque no painel frontal. 

Para iniciar as funções no menu principal, prima as teclas de funções associadas (F1 a F4):

• Log In (F1). Iniciar sessão no termociclador C!000. Depois de iniciar sessão, o nome 
do botão muda para Log Off

• Files (F2). Ver os ficheiros e pastas na biblioteca de ficheiros

• Utilities (F3). Abrir o menu Utilities (Utilitários)

• New Protocol (F4). Criar um novo protocolo

Criar uma nova experiência
1. Seleccione New Protocol (F4) no ecrã de arranque para iniciar (Figura 33). 

Figura 33. Protocolo predefinido de PCR em tempo real.

2. Para alterar a temperatura alvo e o tempo de espera num passo de temperatura, prima 
as teclas de setas para navegar entre os passos e para seleccionar um parâmetro 
(temperatura ou tempo). Prima as teclas alfanuméricas para introduzir um novo número 
para cada parâmetro que realçar.

SUGESTÃO: Ligue um rato de computador através de uma porta USB na caixa 
do C1000 para navegar.

3. (Opcional) Para inserir um novo passo, seleccione o botão Insert (Inserir) (F1). 
Para eliminar um passo, seleccione o botão Delete (Eliminar) (F3) (Figura 33). 
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4. (Opcional) Para alterar as opções dos passos, seleccione o botão Options (Opções) (F4) 
(Figura 33). Na janela Step Options (Opções de passos), seleccione o parâmetro 
a alterar, incluindo a temperatura e o tempo do passo, ou adicione/remova uma leitura 
de placa do passo (Figura 34).

Figura 34. Janela Step Options (Opções de passos).

NOTA: Prima as teclas alfanuméricas para introduzir um Gradient Range (Intervalo 
de gradientes) entre 1 e 24°C.

5. O passo GOTO dá instruções ao termociclador para repetir um conjunto de passos 
em loop para criar os ciclos na experiência de PCR. Seleccione um passo GOTO; prima 
as teclas de setas para seleccionar e depois editar o número do passo num passo 
GOTO, ou para alterar o número de repetições. 

6. (Opcional) Para alterar o volume de amostra predefinido, seleccione a caixa de volume 
de amostra (Vol) (Figura 33 na página 53). Utilize as teclas alfanuméricas para introduzir 
um novo volume de amostra em microlitros. O volume de amostra que for introduzido 
determina o modo de controlo da temperatura utilizado durante um ciclo.

7. (Opcional) Para alterar a temperatura predefinida da tampa, seleccione a caixa 
de temperatura da tampa (Lid) premindo as teclas de setas (Figura 33 na página 53). 
Utilize as teclas alfanuméricas para introduzir uma nova temperatura. Para o sistema 
CFX96, utilize uma temperatura da tampa de 105°C.

NOTA: O aquecimento da tampa evita a condensação nos recipientes de reacção 
vedados.

8. Ao criar um novo protocolo, poderá optar por guardá-lo com um nome. Utilize as teclas 
de setas para navegar até à caixa Name (Nome) do protocolo e prima as teclas 
numéricas várias vezes para introduzir uma letra ou número até digitar o novo nome 
do protocolo.

9. Prima ENTER para aceitar o nome.

Executar o protocolo
1. Para iniciar o ciclo, clique em Done (Concluído) (F2) na janela do protocolo (Figura 33 

na página 53).

SUGESTÃO: Em alternativa, clique na tecla de comando RUN (EXECUTAR) para 
iniciar o ciclo sem guardar ou editar o nome do protocolo.
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2. Introduza um nome de protocolo caso ainda não o tenha feito, ou edite o nome 
anteriormente criado na janela Protocol (Protocolo). Utilize as teclas de setas para 
seleccionar uma pasta de destino (Figura 35).

Figura 35. Guardar um protocolo.

3. Clique em Edit Filename (Editar nome de ficheiro) (F1). Digite um novo nome na caixa 
e clique em Save (Guardar) (F2) (Figura 36).

Figura 36. Introdução de um nome de protocolo.
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4. Clique em Run (Executar) (F2) para continuar a executar o protocolo (Figura 37).

Figura 37. Protocolo correctamente guardado.

5. Edite o Sample Volume (volume de amostra) e a Lid Temperature (temperatura 
da tampa). Pode também ser registada uma Sample ID (ID de amostra) 
ou um User (utilizador) para o ciclo (Figura 38). Clique em OK (F1) para continuar.

Figura 38. Edição do volume de amostra e da temperatura da tampa.
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6. Seleccione um modo de leitura (Scan Mode) para recolher dados de fluorescência 
durante um ciclo (Figura 39).

Figura 39. Modo de leitura e nome do ficheiro de dados.

Os modos de leitura detectam fluoróforos calibrados nestes canais:

• All Channels. Recolhe dados dos canais 1 a 5 no sistema CFX96

• SYBR/FAM only. Recolhe dados só do canal 1 e faculta uma leitura rápida

• FRET. Recolhe dados só do canal FRET e faculta uma leitura rápida

7. Antes do ciclo, é criado um nome de ficheiro de dados independente predefinido. 
Se pretende alterar o nome, utilize as teclas de setas para navegar até à caixa Data File 
Name (Nome do ficheiro de dados), e prima as teclas alfanuméricas para introduzir 
letras ou números até digitar um novo nome do ficheiro de dados (.zpcr).

8. Clique em OK (F1) para iniciar o ciclo.

Execução de um protocolo guardado anteriormente
• Para alterar um protocolo existente, prima a tecla EDIT (EDITAR) para abrir 

a biblioteca de ficheiros e seleccionar um protocolo a editar

• Para executar um protocolo existente, prima a tecla de comando RUN (EXECUTAR) 
e seleccione um protocolo guardado anteriormente na biblioteca de ficheiros

Monitorização de um ciclo
Quando se inicia um ciclo, aparece a janela de estado do ciclo. Analise a informação nesta 
janela para monitorizar o progresso do ciclo.

• Estado. Prima a tecla de comando STATUS (ESTADO) para verificar o estado actual 
do protocolo, efectuar uma pausa no ciclo, cancelar um ciclo, ignorar um passo ou 
aceder ao menu principal (Figura 40) 
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• Estado do tempo. Prima a tecla de comando VIEW (VER) para ver um temporizador 
de contagem decrescente em ecrã total para o protocolo. Prima novamente a tecla 
VIEW (VER) para voltar para o ecrã de estado

Figura 40. Monitorização do estado do ciclo.

Exportação de dados para análise
Quando o ciclo estiver concluído, os dados de fluorescência terão de ser transferidos para 
análise para um computador que execute o CFX Manager software. O ficheiro de dados 
independentes (standalone) é automaticamente guardado na pasta RT_DATA localizada 
na pasta SYSTEM (SISTEMA) (Figura 41).

Figura 41. A pasta RT_DATA armazena ciclos de PCR em tempo real.

Se tiver sido inserido uma unidade de memória USB na respectiva porta do termociclador 
C1000, os dados (.zpcr) serão guardados automaticamente no directório de raiz da unidade 
de memória USB.

Se não houver uma unidade de memória USB inserida no termociclador no final do ciclo, 
siga as instruções abaixo:

1. Prima o botão Files (Ficheiros) (F2) no ecrã principal para aceder às pastas de ficheiros. 

2. Navegue até à pasta RT_DATA e prima a tecla de seta p/direita para abrir a pasta.

3. Seleccione o ficheiro utilizando as teclas de setas p/cima e p/ baixo.
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4. Prima Export File (Exportar ficheiro) (F1) para exportar os dados do ciclo (.zpcr) para 
a unidade de memória USB (Figura 42).

Figura 42. Exportação de dados de um ciclo independente 
para a unidade de memória USB.

5. Clique em Yes (Sim) (F1) para confirmar a exportação.

Pode optar pelo envio directo dos dados por e-mail para si a partir do termociclador C1000 
após a conclusão do ciclo, configurando para tal as definições de e-mail (consulte o manual 
de instruções do termociclador C1000 para obter informações sobre a configuração 
das definições de e-mail).

Para enviar um e-mail com dados em anexo (.zpcr) no final de um ciclo, siga as instruções abaixo:

1. Seleccione Options (Opções) (F4) no ecrã de informações do ciclo (Figura 38 
na página 56).

2. Com as teclas de setas, seleccione a opção Send email notification (Enviar notificação 
de e-mail).

3. Clique em OK (F1) para voltar para o ecrã de informações do ciclo.

4. Utilizando as teclas de setas, navegue para a caixa Email Address (Endereço de e-mail) 
e utilize as teclas alfanuméricas para introduzir o endereço de e-mail.

5. Clique em OK (F1) para continuar a executar o ensaio.

Figura 43. Confirmação da exportação para a unidade de memória USB.
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Criação de um ficheiro de dados
Os dados independentes do ciclo (.zpcr) têm de ser convertidos num ficheiro de dados (.pcrd) 
pelo CFX Manager software para serem analisados. Para criar um ficheiro de dados a partir de 
um ciclo independente:

1. Clique e arraste o ficheiro .zpcr do directório da unidade de memória USB para a janela 
principal do software, ou seleccione Select File > Open > Stand-alone Run 
(Seleccionar ficheiro > Abrir > Ciclo independente) nas opções de menu da janela 
principal do software para seleccionar o nome do ficheiro.

2. Na janela Run File Processor, clique no botão Select Plate (Seleccionar placa) para 
importar o nome do ficheiro de placa que o software irá utilizar para criar o ficheiro 
de dados (Figura 44).

Figura 44. Atribuir um ficheiro de placa.

NOTA: O CFX Manager software verifica o modo de leitura e o tamanho da placa 
para o ficheiro de placa; estes devem coincidir com as definições actuais do ciclo 
iniciadas durante a experiência. Carregue um ficheiro Quick Plate (Placa rápida) 
para aceder rapidamente a dados de todos os poços.
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7 Visão geral da análise de dados
Leia este capítulo para obter informações sobre a análise de dados:

• Janela Data Analysis (Análise de dados) (abaixo)

• Separador Quantitation (Quantificação) (página 65)

• Definições de análise de dados (página 67)

• Selectores de poços (página 68)

• Gráficos (página 70)

• Folhas de cálculo (página 71)

Janela Data Analysis (Análise de dados)
Durante a análise de dados, mudar a forma como os dados são apresentados ao alterar 
o conteúdo dos poços no Plate Editor (Editor de placas) não altera nunca os dados 
de fluorescência que foram colhidos de cada poço durante o ciclo. Depois de o módulo 
recolher dados de fluorescência, esses dados já não podem ser eliminados, embora seja 
possível remover dados visualizados e de análise. 

Para alterar o conteúdo dos poços após um ciclo, abra o Plate Editor (Editor de placas) 
clicando no botão View/Edit Plate (Ver/Editar placa) na parte superior da janela Data Analysis 
(Análise de dados).

SUGESTÃO: Pode adicionar ou editar informações sobre o conteúdo do poço 
antes, durante ou depois de executar a experiência PCR em tempo real. 
É necessário atribuir o modo de leitura e o tamanho da placa antes do ciclo, 
não podendo esses parâmetros ser alterados após o ciclo.

O CFX Manager™ software efectua o processamento de dados de PCR em tempo real 
no final de cada ciclo, e abre a janela Data Analysis (Análise de dados) para apresentar 
esses dados. Escolha um destes métodos para abrir ficheiros de dados existentes na janela 
Data Analysis (Análise de dados).

• Arraste um ficheiro de dados (extensão .pcrd) sobre a janela principal do software 
e largue-o

• Seleccione File > Open > Data File (Ficheiro > Abrir > Ficheiro de dados) na janela 
de software principal para seleccionar um ficheiro no browser do Windows

• Clique no botão de Análise de dados na barra de ferramentas da janela principal 
do software para seleccionar um ficheiro no browser do Windows
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• Seleccione File > Recent Data Files (Ficheiro > Ficheiros de dados recentes) 
para seleccionar um ficheiro da lista dos dez ficheiros de dados mais recentemente 
abertos

A janela Data Analysis (Análise de dados) apresenta até nove separadores (Figura 45). 
Cada separador mostra os dados analisados para um método de análise específico:

Figura 45. Todos os separadores que podem ser mostrados na janela 
Data Analysis (Análise de dados).

O software só apresenta um separador na janela Data Analysis (Análise de dados) 
se os dados forem colhidos no ciclo e se estiverem disponíveis para esse tipo de análise.

Barra de ferramentas de análise de dados
A barra de ferramentas da janela Data Analysis (Análise de dados) permite o acesso rápido a 
importantes funções de análise de dados. A Tabela 16 mostra as funções dos botões da barra 
de ferramentas. 

Tabela 16. Barra de ferramentas da janela Data Analysis (Análise de dados). 

Botão da barra 
de ferramentas

Nome Função

 

Save (Guardar) Guardar o ficheiro de dados actual

 

Print (Imprimir) Imprimir a janela seleccionada

 

Trace Style (Estilo 
de traçado)

Abrir a janela Trace Style (Estilo de traçado) 

 

Report (Relatório) Abrir um relatório para o ficheiro de dados actual 

 

View/Edit Plate 
(Ver/Editar placa)

Abrir o Plate Editor (Editor de placas) para ver e editar 
o conteúdo dos poços

 

Well Groups... 
(Grupos de poços)

Seleccionar o nome de um grupo de poços no menu 
pendente. A selecção predefinida é All Wells (Todos 
os poços)

 

Help (Ajuda) Abrir o site de ajuda (Help) do software para obter 
mais informações sobre a análise de dados
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Barra de menus de análise de dados
A Tabela 17 mostra as funções dos itens da barra de menus. 

Tabela 17. Itens da barra de menus da janela Data Analysis (Análise de dados).  

Item de menu Comando Função

File (Ficheiro) Save (Guardar) Guardar o ficheiro

Save As (Guardar como) Guardar o ficheiro com um novo nome

Repeat Experiment (Repetir 
a experiência)

Extrair o ficheiro da placa e do protocolo 
da experiência actual para voltar 
a executá-la

Exit (Sair) Sair da janela Data Analysis (Análise 
de dados)

View (Ver) Run Log (Registo do ciclo) Abrir uma janela Run Log (Registo 
do ciclo) para ver o registo do ciclo 
de um ficheiro de dados

Settings 
(Definições)

Analysis Mode (Modo 
de análise)

Seleccionar o método de subtracção 
da linha de base para os grupos de poços 
seleccionados nos dados

C(t) Determination Mode (Modo 
de determinação de C(t))

Seleccionar o modo de regressão 
ou de limiar simples para determinar 
a forma como são calculados os valores 
C(t) para cada traçado

Baseline Thresholds (Limiares 
da linha de base)

Abrir a janela Baseline Thresholds 
(Limiares da linha de base) para ajustar 
a linha de base ou o limiar

Trace Styles (Estilos de traçado) Abrir a janela Trace Styles (Estilos 
de traçado) 

View/Edit Plate (Ver/Editar 
placa)

Abrir o Plate Editor (Editor de placas) para 
ver e editar a placa

Mouse Highlighting (Realce 
do rato)

Activar ou desactivar o realce simultâneo 
de dados com o ponteiro do rato

SUGESTÃO: Se a opção Mouse 
Highlighting (Realce do rato) estiver 
desactivada, prima continuamente a tecla 
Control para activar temporariamente 
a função de realce

Display Threshold Values 
(Mostrar valores de limiar)

Mostrar o valor da linha de limiar 
no gráfico
63



Visão geral da análise de dados
Tools 
(Ferramentas)

Reports (Relatórios) Abrir o relatório deste ficheiro de dados

Import Fluorophore Calibration 
(Importar calibração de 
fluoróforos)

Seleccionar um ficheiro de calibração 
a aplicar ao ficheiro de dados actual

Replace Plate (Substituir placa) Substituir o ficheiro da placa actual 
na análise de dados

Export All Data Sheets to Excel 
(Exportar todas as folhas de 
dados para Excel)

Exportar todas as visualizações de folha 
de cálculo de cada separador para 
um ficheiro formatado para Excel 
separado

Help (Ajuda) Abrir a ajuda (Help) do software para obter 
mais informações sobre a análise 
de dados

Tabela 17. Itens da barra de menus da janela Data Analysis (Análise de dados). 

Item de menu Comando Função
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Separador Quantitation (Quantificação)
Cada separador da janela Data Analysis (Análise de dados) apresenta dados em gráficos 
e folhas de cálculo para um método de análise específico, com um selector de poços para 
seleccionar os dados que pretende mostrar. A janela Data Analysis (Análise de dados) abre-se 
com o separador Quantitation (Quantificação) (Figura 46) em primeiro plano. Os dados 
do gráfico Amplification (Amplificação) neste separador devem ser utilizados para determinar 
as definições correctas de análise para a experiência. 

NOTA: O gráfico Amplification (Amplificação) mostra a fluorescência relativa (RFU) 
para cada poço em cada ciclo. Cada traçado do gráfico representa dados 
de um único fluoróforo num poço.

Figura 46. Disposição do separador Quantitation (Quantificação) na janela 
Data Analysis (Análise de dados).

NOTA: O software liga os dados nos painéis de cada separador de análise 
de dados. Por exemplo, realçar um poço colocando o ponteiro do rato sobre 
o poço na vista do selector de poços, realça os dados em todos os outros painéis.
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Visão geral da análise de dados
Selector Step Number (n.º de passo)
O Sistema CFX96™ pode adquirir dados de fluorescência em vários passos do protocolo; 
o software mantém os dados adquiridos a cada passo de forma independente. O software 
mostra o selector Step Number (n.º de passo) abaixo do gráfico Standard Curve (Curva 
padrão) no separador Quantitation (Quantificação) sempre que um protocolo contiver mais 
do que um passo de recolha de dados. Ao seleccionar um passo, o software aplica essa 
selecção a todos os dados mostrados na janela Data Analysis (Análise de dados). A Figura 47 
mostra que o número do passo de recolha de dados é 3 para todos os dados.

Figura 47. Selecção de número de passo na janela Data Analysis (Análise de dados).

Visualização de grupos de poços em análise de dados

Os poços da placa podem ser agrupados em subconjuntos para análise independente 
utilizando grupos de poços. Ao criar grupos de poços na janela Well Groups Manager 
(Gestor de grupos de poços) no Plate Editor (Editor de placas) (página 47), aparecem nomes 
de grupos na janela Data Analysis (Análise de dados) na lista Well Groups (Grupos de poços) 
na barra de ferramentas.

Por predefinição, o grupo de poços All Wells (Todos os poços) é seleccionado quando 
a janela Data Analysis (Análise de dados) é aberta inicialmente, com os dados em todos 
os poços com conteúdo mostrados nos gráficos e nas folhas de cálculo.

A Figura 48 mostra o grupo 2 (Group 2) seleccionado no menu Well Groups (Grupos 
de poços). Só os poços desse grupo de poços aparecem carregados no selector de poços 
e apenas os dados referentes a esses poços são incluídos nos cálculos de análise de dados. 

Figura 48. Janela Data Analysis (Análise de dados) 
com o grupo 2 (Group 2) seleccionado.
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Definições de análise de dados
O gráfico Amplification (Amplificação) no separador Quantitation (Quantificação) mostra 
a fluorescência relativa (RFU) para cada poço em cada ciclo. Cada traçado do gráfico 
representa dados de um único fluoróforo num poço. Estes dados são utilizados para 
determinar valores C(t) para cada poço por fluoróforo. O software utiliza um de dois modos 
para determinar os valores C(t):

• Regressão. Este modo aplica um modelo de regressão não linear e multivariável 
a traçados de poços individuais, utilizando posteriormente este modelo para calcular 
um valor C(t) óptimo

• Limiar simples. Este modo utiliza um valor de limiar simples para calcular o valor C(t) 
com base no ponto de intersecção de limiares de traçados de fluorescência individuais 

Ajuste do limiar
No modo de limiar simples, ajuste o limiar de um fluoróforo clicando na linha de limiar 
no gráfico Amplification (Amplificação) e deslocando o ponteiro do rato na vertical. Em 
alternativa, especifique um limiar de intersecção exacto para o fluoróforo seleccionado, 
de acordo com as instruções seguintes:

1. Seleccione Settings > Baseline Thresholds (Definições > Limiares da linha de base) 
na barra de menus para abrir a janela Baseline Thresholds (Limiares da linha de base).

2. Ajuste o limiar de intersecção (Figura 49) para o fluoróforo clicando em User Defined 
(Definido pelo utilizador) e introduzindo um número de limiar.

Figura 49. Janela Baseline Thresholds (Limiares da linha de base).

3. Clique em OK para confirmar a alteração e fechar a janela.
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Definições da linha de base
O software define automaticamente a linha de base individualmente para cada poço. Depois 
de seleccionar os poços para análise, verifique as definições da linha de base nestes poços. 
Abra a janela Baseline Thresholds (Limiares da linha de base) (Figura 49) para alterar a linha 
de base predefinida de poços seleccionados. Para abrir esta janela:

1. Seleccione Settings > Baseline Thresholds (Definições > Limiares da linha de base) 
para abrir a janela Baseline Thresholds (Limiares da linha de base).

Para ajustar o ciclo da linha de base inicial e final para cada poço:

1. No painel Baseline Cycles (Ciclos da linha de base), para seleccionar um ou mais poços, 
clique no número de fila, clique no canto superior esquerdo para seleccionar todos 
os poços, prima continuamente a tecla Control para seleccionar vários poços individuais 
ou prima continuamente a tecla Shift para seleccionar vários poços numa fila.

2. Ajuste o ciclo Baseline Begin (Início da linha de base) e Baseline End (Fim da linha 
de base) para todos os poços seleccionados, ou altere o número de ciclo de Begin 
(Início) e End (Fim) na parte inferior da folha de cálculo (Figura 49). 

3. Clique em OK para confirmar a alteração e fechar a janela.

Selecção do modo de análise
Seleccione o modo de análise para determinar o método de subtracção da linha de base para 
todos os traçados de fluorescência. Seleccione Settings > Analysis Mode (Definições > 
Modo de análise) para escolher uma das três opções seguintes:

• No Baseline Subtraction (Nenhuma subtracção da linha de base). O software 
apresenta os dados na forma de traçados de fluorescência relativa. Alguma análise 
não é possível neste modo de análise

• Baseline Subtracted (Com subtracção da linha de base). O software apresenta 
os dados na forma de traçados com subtracção da linha de base para cada fluoróforo 
num poço. O software tem de efectuar a subtracção da linha de base dos dados para 
determinar ciclos de limiar, construir curvas padrão e determinar a concentração 
de amostras desconhecidas. Para gerar um traçado com subtracção da linha de base, 
o software ajusta a melhor linha recta através da fluorescência registada de cada poço 
durante os ciclos da linha de base, e subtrai depois os dados de melhor ajuste 
dos dados de fundo com subtracção em cada ciclo

• Baseline Subtracted Curve Fit (Ajuste de curva com subtracção da linha de 
base). O software apresenta os dados na forma de traçados com subtracção da linha 
de base, e o software regulariza a curva com subtracção da linha de base utilizando 
um filtro de média centrado. Este processo é realizado de modo que cada C(t) fique 
constante

Selectores de poços
Clique nos poços do selector de poços para mostrar ou ocultar os dados dos gráficos 
ou das folhas de cálculo na janela Data Analysis (Análise de dados):

• Para ocultar um poço, realce e clique num poço individual. Para mostrar esse poço, 
realce e clique de novo no poço

• Para ocultar vários poços, clique e arraste os poços que deseja seleccionar. 
Para mostrar esses poços, clique e arraste de novo os poços
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• Clique no canto superior esquerdo da placa para ocultar todos os poços. 
Clique de novo no canto superior esquerdo para mostrar todos os poços

• Clique no início de uma coluna ou fila para ocultar esses poços. Clique de novo 
na coluna ou fila para mostrar os poços

Só os poços carregados com conteúdo (introduzidos no Plate Editor) podem ser 
seleccionados no selector de poços, ficando visível a sua cor se forem seleccionados. 
Conforme mostrado na Figura 50, o selector de poços mostra os três tipos de poços 
seguintes:

• Poços carregados seleccionados (azul). Estes poços contêm um tipo de 
amostra Unk (desconhecido) carregado. Os dados destes poços aparecem 
na janela Data Analysis (Análise de dados)

• Poços carregados não seleccionados (cinzento claro). Estes poços contêm tipos 
de amostra Std (Padrão) e Pos. Os dados de poços não seleccionados não aparecem 
na janela Data Analysis (Análise de dados)

• Poços vazios (cinzento escuro). Estes poços não foram carregados na janela 
Plate Editor

Figura 50. Aparecem três cores de poços num selector de poços.

Exclusão temporária de poços da análise

OPÇÃO DE CLIQUE DIREITO

1. Clique com o botão direito do rato no poço do selector de poços, num traçado 
de fluorescência ou num ponto esboçado na curva padrão.

2. Nas opções do menu, seleccione Exclude Well XX from Analysis (Excluir poço XX 
da análise). 

Figura 51. Clique com o botão direito do rato para excluir um poço da análise.
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OPÇÕES DO PLATE EDITOR (EDITOR DE PLACAS)
1. Clique no botão View/Edit Plate (Ver/Editar placa) na barra de ferramentas da janela 

Data Analysis (Análise de dados). 

2. Seleccione um ou mais poços na visualização do selector de poços.

3. Clique em Exclude Wells in Analysis (Excluir poços na análise) (Figura 52) para excluir 
os poços seleccionados. Esta caixa de selecção encontra-se na parte inferior 
dos controlos do Plate Editor (Editor de placas), no lado direito da janela.

Figura 52. Caixa de selecção Exclude Wells in Analysis (Excluir poços na análise) 
na parte inferior do painel.

4. Os poços excluídos são marcados com um asterisco (*) na janela Plate Editor (Editor 
de placas).

Em alternativa, para remover permanentemente os poços da análise, limpe o conteúdo 
dos poços no Plate Editor (Editor de placas) clicando no botão Clear Wells (Limpar poços). 

AVISO! Terá de voltar a introduzir o conteúdo de poços que tenha sido limpo.

Gráficos
Cada gráfico da janela Data Analysis (Análise de dados) apresenta os dados num gráfico 
diferente e inclui opções de ajuste de dados. Para ampliar uma área do gráfico, seleccione 
a área clicando e arrastando com o rato. O software redimensiona o gráfico e centra-o na área 
seleccionada.
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Itens comuns de menu de clique direito para gráficos
Todos os gráficos apresentam itens de menu de clique direito. Alguns dos itens disponíveis 
estão presentes para todos os gráficos, podendo ser utilizados para mudar a forma como 
os dados são apresentados ou para exportar facilmente os dados a partir de um gráfico 
(Tabela 18).

NOTA: Os itens de menu que se aplicam a gráficos específicos são descritos 
no capítulo seguinte “Janelas de análise de dados” (página 73).

Folhas de cálculo
As folhas de cálculo mostradas em Data Analysis (Análise de dados) incluem opções para 
ordenar e transferir dados. Ordene as colunas de acordo com um dos métodos seguintes:

• Clique e arraste uma coluna para uma nova localização na tabela seleccionada

• Clique no cabeçalho da coluna para ordenar os dados por ordem ascendente 
(Ascending) ou descendente (Descending)

Para ordenar até três colunas de dados na janela Sort (Ordenar), siga os passos seguintes:

1. Clique com o botão direito do rato na folha de cálculo para abrir o menu e seleccione 
Sort (Ordenar).

2. Na janela Sort (Ordenar), seleccione o primeiro título de coluna a ordenar. Ordene os 
dados por ordem ascendente (Ascending) ou descendente (Descending).

3. Para seleccionar mais do que um título de coluna, seleccione o título no menu pendente. 
Seleccione Ascending (Ascendente) ou Descending (Descendente) para ordenar 
a coluna por essa ordem.

4. Clique em OK para ordenar os dados, ou clique em Cancel (Cancelar) para interromper 
a acção.

Para realçar os dados nos gráficos associados e no selector de poços, o ponteiro do rato 
deve manter-se sobre uma célula. Se clicar na célula, poderá copiar o conteúdo para colar 
noutro programa de software. 

Tabela 18. Itens de menu de clique direito para gráficos.

Item Função

Copy (Copiar) Copiar o gráfico para a área de transferência

Save Image As... (Guardar 
imagem como)

Guardar a imagem do gráfico no tipo de ficheiro de imagem 
seleccionado. Seleccione entre os formatos seguintes: 
PNG (predefinição), GIF, JPG, TIF ou BMP

Page Setup... (Configuração 
de página)

Pré-visualizar e seleccionar a configuração da página para 
impressão

Print... (Imprimir) Imprimir o gráfico

Show Point Values (Mostrar 
valores de pontos)

Mostrar os valores dos pontos quando o rato de desloca 
sobre um ponto do gráfico. 

Set Scale to Default (Definir 
escala para predefinição)

Voltar para a visualização predefinida da escala depois 
de ampliar o gráfico

Chart Options... (Opções 
do gráfico)

Abrir a janela Chart Options (Opções do gráfico) para 
alterar o gráfico, incluindo alterar o título, seleccionar 
limites para os eixos x e y, mostrar as linhas da grelha 
e mostrar marcas menores nos eixos
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Itens comuns de menu de clique direito para folhas 
de cálculo
Clique com o botão direito do rato em qualquer visualização da folha de cálculo para 
seleccionar os itens mostrados na Tabela 19. 

Tabela 19. Itens de menu de clique direito para folhas de cálculo. 

Item Função

Copy (Copiar) Copiar o conteúdo dos poços seleccionados para a área 
de transferência, e colar depois o conteúdo numa folha 
de cálculo, por ex. Excel

Copy as Image (Copiar como 
imagem)

Copiar a visualização da folha de cálculo como um ficheiro 
de imagem, e colar num ficheiro que aceite um ficheiro 
de imagem, como ficheiros de texto, imagem ou folha 
de cálculo

Print... (Imprimir) Imprimir a visualização actual

Print Selection... 
(Imprimir selecção)

Imprimir a selecção actual

Export to Excel... 
(Exportar para Excel)

Exportar os dados para uma folha de cálculo Excel

Export to Text... 
(Exportar para texto)

Exportar os dados para um editor de texto

Export to XML... 
(Exportar para XML)

Exportar os dados para um ficheiro XML

Export to HTML... 
(Exportar para HTML)

Exportar os dados para um ficheiro HTML

Find... (Localizar) Procurar texto

Sort... (Ordenar) Ordenar os dados em até três colunas
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8 Janelas de análise de dados
Leia este capítulo para obter mais informações sobre os separadores da janela Data Analysis 
(Análise de dados):

• Separador Quantitation (Quantificação) (abaixo)

• Separador Quantitation Data (Dados de quantificação) (página 76)

• Separador Melt Curve (Curva de fusão) (página 78)

• Separador Melt Curve Data (Dados da curva de fusão) (página 79)

• Separador End Point (Ponto final) (página 80)

• Separador Allelic Discrimination (Discriminação alélica) (página 81)

• Separador QC (Controlo de qualidade) (página 83)

• Separador Run Information (Informação do ciclo) (página 84)

• Relatórios de ficheiros de dados (página 85)

Separador Quantitation (Quantificação)
Utilize os dados no separador Quantitation (Quantificação) (Figura 46 na página 65) para 
definir as condições de análise de dados, incluindo as definições da linha de base para poços 
individuais e as definições de limiares. O separador Quantitation (Quantificação) apresenta 
dados nas quatro visualizações seguintes:

• Gráfico de amplificação. Mostra as unidades de fluorescência relativa (RFUs) para 
cada poço em cada ciclo. Cada traçado do gráfico representa dados de um único 
fluoróforo num poço

• Curva padrão. Este gráfico só é mostrado se a experiência incluir poços designados 
por Sample Type Standard (Tipo de amostra padrão). Mostra uma curva padrão com 
o ciclo de limiar representado em relação ao registo da quantidade inicial. A legenda 
mostra a eficiência da reacção (Reaction Efficiency) (E) para cada fluoróforo nos poços 
com um tipo de amostra padrão

• Selector de poços. Selecciona os poços com os dados de fluorescência que pretende 
mostrar

• Folha de cálculo. Mostra uma folha de cálculo dos dados recolhidos nos poços 
seleccionados
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Janelas de análise de dados
Selector de fluoróforos
Para seleccionar os dados de fluoróforos a apresentar nos gráficos e folhas de cálculo 
do separador Quantitation (Quantificação), clique no selector de fluoróforos abaixo do gráfico 
de amplificação (Amplification) (Figura 53). Clique na caixa junto ao nome do fluoróforo para 
mostrar ou ocultar os dados do fluoróforo na janela de análise de dados.

Figura 53. Selector de fluoróforos com FAM seleccionado.

Janela Trace Styles (Estilos de traçado)
Abra a janela Trace Styles (Estilos de traçado) (Figura 54) para ajustar o aspecto dos traçados 
nos gráficos de amplificação e curva de fusão dos separadores Quantitation (Quantificação) 
e Melt Curve (Curva de fusão).

Para abrir esta janela, siga os passos seguintes:

1. Seleccione apenas um fluoróforo nas caixas de selecção de fluoróforos. 

2. Clique no botão Trace Styles (Estilos de traçado) na barra de ferramentas de Data 
Analysis (Análise de dados), ou seleccione Settings > Trace Styles (Definições > Estilos 
de traçado) na barra de menus de Data Analysis (Análise de dados).

Figura 54. Janela Trace Styles (Estilos de traçado).

Utilize as ferramentas da janela Trace Styles (Estilos de traçado) para ajustar o aspecto 
dos traçados e pré-visualizar as alterações no selector de poços na parte inferior da janela.

• Seleccione um conjunto específico de poços utilizando o selector de poços na parte 
inferior da janela. Em alternativa, seleccione poços que contenham um tipo 
de amostra no menu pendente na coluna Wells (Poços)

• Clique na caixa na coluna Color (Cor) para seleccionar uma cor para os poços

• Seleccione um símbolo no menu pendente da coluna Symbol (Símbolo)

• Clique em Show Contents (Mostrar conteúdo) para mostrar os tipos de amostra 
em cada poço, ou clique em Show Symbols (Mostrar símbolos) para mostrar 
os símbolos seleccionados em cada poço
74



Manual de Instruções do Sistema de Detecção por PCR em Tempo Real CFX96™
Opção Log Scale (Escala logarítmica)
Clique na caixa Log Scale (Escala logarítmica) sob o gráfico de amplificação (Amplification) 
para ver os traçados de fluorescência numa escala semi-logarítmica, conforme mostrado na 
Figura 55.

Figura 55. Opção Log Scale (Escala logarítmica) seleccionada 
no gráfico de amplificação (Amplification).

Gráfico de curva padrão
O software cria um gráfico de curva padrão (Standard Curve) (Figura 56) no separador 
Quantitation (Quantificação) se os dados incluirem tipos de amostra definidos como padrão 
(Std) para um fluoróforo na experiência.

Figura 56. Gráfico de curva padrão.

O gráfico de curva padrão (Standard Curve) mostra a informação seguinte:

• Nome de cada curva (o nome do fluoróforo)

• Cor de cada fluoróforo

• Eficiência da reacção (E). Utilize esta estatística para optimizar uma reacção 
multiplex e equalizar os dados para uma curva padrão

NOTA: A eficiência da reacção descreve a quantidade do alvo que é produzida 
com cada ciclo no protocolo. Uma eficiência de 100% significa que está a duplicar 
o alvo com cada ciclo.
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• Coeficiente de determinação, R2 (escrito como R^2). Utilize esta estatística para 
determinar até que ponto a linha descreve os dados correctamente (qualidade do 
ajuste)

Opções de menu de clique direito dos gráficos

Além das opções de menu de clique direito habituais (copiar, imprimir e exportar gráficos), 
a Tabela 20 mostra as opções de menu disponíveis apenas no gráfico de amplificação 
(Amplification).
Tabela 20. Opções de menu de clique direito específicas do gráfico de amplificação.

Separador Quantitation Data (Dados de quantificação)
O separador Quantitation Data (Dados de quantificação) mostra folhas de cálculo 
que descrevem os dados de quantificação recolhidos em cada poço. Seleccione uma das três 
opções para mostrar os dados em formatos diferentes:

• Results (Resultados). Mostra os dados numa folha de cálculo

• Plate (Placa). Mostra uma visualização dos dados em cada poço como um mapa 
de placas

• RFU. Escolha esta folha de cálculo para mostrar as quantidades de RFU em cada poço 
para cada ciclo

SUGESTÃO: Clique com o botão direito do rato para ver opções, incluindo a opção 
de ordenar

Opção de menu Função

Show Threshold Values 
(Mostrar valores de limiar)

Mostrar o valor de limiar para cada curva de amplificação 
no gráfico

Trace Styles... 
(Estilos de traçado)

Abrir a janela Trace Styles (Estilos de traçado) para alterar 
os estilos dos traçados que aparecem nos separadores 
Quantitation (Quantificação) e Melt Curve (Curva de fusão)

Baseline Thresholds... 
(Limiares da linha de base)

Abrir a janela Baseline Thresholds (Limiares da linha de base) 
para alterar a linha de base ou os limiares de cada fluoróforo 
(as alterações aparecem no gráfico de amplificação 
(Amplification) no separador Quantitation (Quantificação))
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Folha de cálculo de resultados
Seleccione uma folha de cálculo Results (Resultados) (Figura 57) para ver dados de cada 
poço na placa.

Figura 57. Separador Quantitation Data (Dados de quantificação) com 
a folha de cálculo de resultados seleccionada.

NOTA: Todos os cálculos de desvio padrão (Std. Dev) se aplicam aos grupos 
de réplicas atribuídos nos poços na janela Plate Editor (Editor de placas). 
Os cálculos fazem a média do valor C(t) para cada poço no grupo de réplicas.

A folha de cálculo Results (Resultados) inclui o tipo de informação mostrada na Tabela 21. 

Tabela 21. Conteúdo da folha de cálculo de resultados.

Informação Descrição

Well (Poço) Poço na placa

Fluor Fluoróforo detectado

Content (Conteúdo) Tipo de amostra e número da réplica

Target (Alvo) Nome do alvo de amplificação (gene) 

Sample (Amostra) Descrição da amostra

Threshold Cycle (C(t)) 
(Ciclo de limiar)

Ciclo de limiar

C(t) Mean (Média de C(t)) A média do ciclo de limiar para o grupo de réplicas

C(t) Std. Dev Desvio padrão do ciclo de limiar para o grupo de réplicas

Starting Quantity (SQ) 
(Quantidade inicial)

Estimativa da quantidade inicial do alvo

Log Starting Quantity 
(Registo quantidade inicial)

Registo da quantidade inicial

SQ Mean (Média SQ) Média da quantidade inicial

SQ Std. Dev Desvio padrão da quantidade inicial

Set Point (Ponto de acerto) Temperatura da amostra no poço para um passo do gradiente

Sample Note (Nota de 
amostra)

Um ciclo de desnaturação, annealing (hibridização) e 
extensão, ou um ciclo de passos de annealing (hibridização) 
e extensão num protocolo
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Folha de cálculo Plate (Placa)
Seleccione a folha de cálculo Plate (Placa) para ver um mapa de placas dos dados de 
um fluoróforo de cada vez. Seleccione cada fluoróforo clicando num separador na parte 
inferior da folha de cálculo. A Figura 58 mostra a folha de cálculo Plate (Placa) como um mapa 
de placas. 

Figura 58. Folha de cálculo Plate (Placa) no separador Quantitation Data 
(Dados de quantificação).

Folha de cálculo RFU
Seleccione a folha de cálculo RFU para ver as leituras de RFU para cada poço adquiridas 
em cada ciclo da experiência. Seleccione os fluoróforos individuais clicando num separador 
na parte inferior da folha de cálculo. O número do poço aparece no topo de cada coluna, 
e o número do ciclo aparece à esquerda de cada fila (Figura 59). 

Figura 59. Folha de cálculo RFU no separador Quantitation Data 
(Dados de quantificação).

Separador Melt Curve (Curva de fusão)
Abra o separador Melt Curve (Curva de fusão) (Figura 60) para determinar a temperatura 
de fusão (Tm) de produtos de PCR amplificados. Este separador mostra os dados da curva 
de fusão nas quatro visualizações seguintes:

• Melt Curve. Ver os dados em tempo real para cada fluoróforo como RFUs 
por temperatura para cada poço

• Melt Peak. Ver a regressão negativa dos dados de RFU por temperatura para 
cada poço  

• Well Selector. Seleccionar poços para mostrar ou ocultar os dados
78



Manual de Instruções do Sistema de Detecção por PCR em Tempo Real CFX96™
• Peak spreadsheet. Ver uma folha de cálculo dos dados recolhidos no poço 
seleccionado

NOTA: Esta folha de cálculo mostra apenas um máximo de dois picos para cada 
traçado. Para ver mais picos, clique no separador Melt Curve Data (Dados 
da curva de fusão) (página 79).

Figura 60. Disposição do separador Melt Curve (Curva de fusão) 
na janela Data Analysis (Análise de dados).

Ajuste os dados da curva de fusão utilizando um dos métodos seguintes:

• Clique e arraste as barras limite no gráfico Melt Peak (Pico de fusão) para incluir 
ou excluir picos na análise de dados

• Seleccione Positive (Positivo) no menu pendente Peak Type (Tipo de pico) para 
mostrar os dados de folha de cálculo dos picos acima da linha de limiar de fusão, 
ou seleccione Negative (Negativo) para ver os dados de folha de cálculo dos picos 
abaixo da linha de limiar de fusão

Separador Melt Curve Data (Dados da curva de fusão)
O separador Melt Curve Data (Dados da curva de fusão) mostra os dados do separador Melt 
Curve (Curva de fusão) em várias folhas de cálculo que incluem todos os picos de fusão para 
cada traçado. Seleccione uma das quatro opções para mostrar os dados da curva de fusão 
em folhas de cálculo diferentes.

• Melt Peaks. Mostrar todos os dados, incluindo todos os dados de fusão, para cada 
traçado

• Plate. Mostrar uma vista dos dados e do conteúdo de cada poço na placa, incluindo 
o conteúdo, o nome da amostra, pico 1 e pico 2

• RFU. Mostrar as quantidades de RFU a cada temperatura para cada poço

• –d(RFU)/dT. Mostrar a taxa de alteração negativa na RFU à medida que a temperatura 
(T) muda para cada poço. Esta é o primeiro esboço de regressão para cada poço 
na placa
79



Janelas de análise de dados
Separador End Point (Ponto final)
Abra o separador End Point (Ponto final) para analisar unidades de fluorescência relativa 
(RFUs) finais para os poços de amostra. O software compara os níveis de RFU de poços com 
amostras desconhecidas com os níveis de RFU de poços com controlos negativos, 
e classifica as desconhecidas como Positivo ou Negativo. As amostras positivas apresentam 
um valor de RFU superior ao valor médio de RFU dos controlos negativos, mais o valor 
de cutoff.

Para analisar os dados de ponto final, a placa deve conter controlos negativos ou o software 
não poderá fazer a determinação. Execute um dos dois tipos de protocolos seguintes:

• Executar um protocolo de quantificação. Configure um protocolo padrão. Depois 
de executar a experiência, abra a janela Data Analysis (Análise de dados), ajuste 
as definições de análise de dados no separador Quantitation (Quantificação) e clique 
no separador End Point (Ponto final) para escolher um ciclo de ponto final

• Executar um protocolo só de ponto final.  Carregue o protocolo End Point Only 
(Só ponto final) no separador Plate (Placa) da janela Experiment Setup (Configuração 
da experiência), seleccione ou crie uma placa e execute a experiência

O separador End Point (Ponto final) mostra os valores médios de RFU para determinar 
se o alvo foi amplificado ou não pelo último ciclo (final). Utilize estes dados para determinar 
se uma sequência alvo específica está presente (positiva) numa amostra. Os alvos positivos 
apresentam valores de RFU superiores ao nível de cutoff que for definido. 

O software apresenta os dados seguintes no separador End Point (Ponto final):

• Settings. Ajuste das definições de análise de dados

• Results. Mostra os resultados imediatamente após o ajuste das definições

• Well Selector. Seleccione os poços com os dados de ponto final que pretende mostrar

• Folha de cálculo de poços. Mostra uma folha de cálculo da RFU final recolhida nos 
poços seleccionados

Figura 61. Disposição do separador de análise End Point (Ponto final).

A lista Results (Resultados) inclui a informação seguinte:

• Lowest RFU value. O valor de RFU mais baixo dos dados

• Highest RFU value. O valor de RFU mais alto dos dados

• Negative Control Average. RFU média para os poços que contêm controlos negativos

• Cut Off Value. O valor de cutoff é calculado adicionando a tolerância (RFU 
ou percentagem de intervalo mostrado nas definições) e a média dos controlos 
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negativos. As amostras com RFUs superiores ao valor de cutoff serão designadas 
por “Positivas”. Para ajustar o valor de cutoff, altere a RFU ou a percentagem 
de intervalo

O valor de cutoff é calculado utilizando a seguinte fórmula:

Valor de corte = Media de control negativo + Tolerancia

Seleccione uma tolerância de acordo com um dos métodos seguintes:

• RFUs (predefinição). Seleccione este método para utilizar um valor absoluto de RFU 
para a tolerância. O valor mínimo de tolerância de RFU é 2. O máximo é o valor absoluto 
do valor máximo de RFU menos o valor absoluto do valor mínimo de RFU. O valor 
predefinido de tolerância de RFU é 10% do intervalo total de RFU

• Percent of Range. Seleccione este método para utilizar uma percentagem do intervalo 
de RFU para a tolerância. A percentagem de intervalo mínima é 1 por cento. 
A percentagem de intervalo máxima é 99 por cento. A percentagem de intervalo 
predefinida é 10 por cento

Ajuste da análise de dados de ponto final
Ajuste a informação mostrada no separador End Point (Ponto final) utilizando os métodos 
seguintes:

• Escolha um fluoróforo (Fluorophore) na lista pendente para ver os dados

• Escolha um valor de End Cycle to Average para definir o número de ciclos 
que o software utiliza para calcular a RFU média de ponto final

• Seleccione RFUs para ver os dados em unidades de fluorescência relativa

• Seleccione Percentage of Range (Percentagem de intervalo) para ver os dados 
como uma percentagem do intervalo de RFU

Separador Allelic Discrimination (Discriminação alélica)
O separador Allelic Discrimination (Discriminação alélica) atribui os genótipos a poços 
com amostras desconhecidas utilizando a RFU ou C(t) de amostras de controlo positivas 
(Figura 62). Utilize estes dados para identificar genótipos de amostras, incluindo Alelo 1, 
Alelo 2, Heterozigoto, Desconhecido, Controlo 1 ou Controlo 2.

NOTA: Os dados de discriminação alélica devem ser provenientes de experiências 
multiplex.

A análise de discriminação alélica requer o seguinte conteúdo mínimo dos poços:

• Dois fluoróforos em cada poço, com excepção dos poços que contêm controlos 
positivos, os quais só podem conter um fluoróforo

• Um fluoróforo que seja comum a todos os poços do grupo de poços

• Amostras NTC (no template control) se pretender normalizar os dados
81



Janelas de análise de dados
Figura 62. Disposição do separador Allelic Discrimination (Discriminação alélica) 
na janela Data Analysis (Análise de dados).

Ajuste de dados para discriminação alélica
O software atribui automaticamente um genótipo a poços com amostras desconhecidas 
com base nas posições das barras limite vertical e horizontal e, a seguir, mostra uma lista 
de determinação de genótipos na visualização de folha de cálculo. Para a determinação 
automática de genótipos, o software utiliza controlos positivos (quando disponíveis), 
ou calcula os limiares. O software toma uma RFU ou C(t) médios para os controlos positivos 
para definir automaticamente as linhas de limiar para discriminação dos alelos. 

Ajuste as posições das barras de limiar clicando e arrastando as mesmas, e o software ajusta 
automaticamente os cálculos para efectuar novas atribuiçoes de genótipos: 

• Se a experiência contiver três controlos na placa, a posição das barras de limiar 
baseia-se na média e no desvio padrão da RFU ou do C(t) dos controlos

• Se o número de controlos for inferior a três, a posição das barras de limiar 
é determinada pelos valores do ciclo de limiar ou intervalo de RFU no fluoróforo 
seleccionado

Ajuste os dados de discriminação alélica utilizando um dos métodos seguintes:

• Clique e arraste as barras de limiar no gráfico Allelic Discrimination (Discriminação 
alélica) para ajustar as determinações na folha de cálculo

• Seleccione um fluoróforo para cada eixo do gráfico (X: e Y:) nas opções 
de definições no canto inferior direito da janela
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• Para alterar manualmente uma determinação, realce uma fila da folha de cálculo 
e seleccione uma opção da lista Call Selected Alleles (incluindo Allele 1 (Alelo 1), 
Allele 2 (Alelo 2), Heterozygote (Heterozigoto), None (Nenhum), Unknown 
(Desconhecido), Control 1 (Controlo 1) ou Control 2 (Controlo 2))

• Clique no botão Restore Default Thresholds (Restaurar limiares predefinidos) para 
voltar a colocar as barras vertical e horizontal na respectiva posição original, 
indicada pelos números junto das barras

• Seleccione o Display Mode C(t) para ver os dados como níveis de limiar. Seleccione 
o Display Mode RFU para ver os dados em unidades de fluorescência relativa 
no ciclo seleccionado

• Seleccione Normalize Data (Normalizar dados) para normalizar os dados de RFU 
mostrados no gráfico e na folha de cálculo

A normalização altera os dados do gráfico para um intervalo de 0 a 1 em ambos os eixos. 
Para normalizar os dados, a placa deve conter poços sem quaisquer tipos de amostras NTC 
(no template control), para Allele 1 e Allele 2 (Alelo 1 e 2). Para esta determinação, os dados 
de RFU são normalizados para os valores NTC como uma combinação linear de RFUs 
específicas de Allele 1 e Allele 2 (Alelo 1 e 2). Esta determinação é uma forma eficaz 
de apresentar dados de RFU.

Os cálculos para RFUs normalizadas seguem as fórmulas apresentadas em Livak et al. (1995).

Em que:
• A1 representa RFU para Allele 1 (Alelo 1)
• A2 representa RFU para Allele 2 (Alelo 2)

•  representa a RFU média

NTCA1 + A2 representa a soma de RFUs para a amostra NTC de Allele 1 e Allele 2 (Alelo 1 e 2)

Separador QC (Controlo de qualidade)
Abra o separador QC (Controlo de qualidade) para avaliar rapidamente a qualidade 
dos dados da experiência com base nas regras definidas no separador QC (Controlo 
de qualidade) na janela User Preferences (Preferências do utilizador) (consulte “Separador 
QC (Controlo de qualidade)” na página 111).

A1normalizado
A1

A1 A2 x NTCA1 A2+ + +
--------------------------------------------------------------=
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O software apresenta as regras de QC (Controlo de qualidade) aplicadas actualmente 
e as definições que definem cada regra (Figura 63). A descrição da regra apresenta também 
os poços que falham uma regra seleccionada. 

NOTA: Pode activar ou desactivar regras clicando na caixa de selecção junto 
à regra na coluna Use Rule (Usar regra).

Figura 63. Disposição do separador QC (Controlo de qualidade).

Separador Run Information (Informação do ciclo)
O separador Run Information (Informação do ciclo) (Figura 64) mostra o protocolo e outras 
informações sobre o ciclo para cada experiência. Pode também utilizar a caixa Notes (Notas) 
para introduzir e editar as notas do ciclo, ou introduzir e editar a ID de dados do ciclo 
escrevendo na caixa ID.

Figura 64. Disposição do separador Run Information (Informação do ciclo) 
na janela Data Analysis (Análise de dados).
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Relatórios de ficheiros de dados
A janela Report (Relatório) (Figura 65) mostra informações sobre o ficheiro de dados actual 
na janela Data Analysis (Análise de dados). Para abrir um relatório, seleccione Tools > 
Reports (Ferramentas > Relatórios), ou clique no botão de relatórios na barra de ferramentas 
da janela Data Analysis (Análise de dados).

A janela Report (Relatório) mostra as três secções seguintes:

• Menu e barra de ferramentas. Seleccionar opções para formatar, guardar e imprimir 
o relatório ou modelo

• Lista de opções (canto superior esquerdo da janela). Seleccionar opções a mostrar 
no relatório

• Painel de opções (canto inferior esquerdo da janela). Introduzir informações sobre 
uma opção seleccionada

• Painel de pré-visualização (lado direito da janela). Pré-visualizar o relatório actual

Figura 65. Exemplo de uma janela Report (Relatório) de um ficheiro de dados.

SUGESTÃO: A disposição do relatório pode definir o tipo de informação que 
aparece em qualquer relatório se o relatório for guardado como um modelo. 
Seleccione Template > Save ou Save As (Modelo > Guardar ou Guardar como) 
para guardar a disposição do relatório actual como um modelo.

Criar um relatório de análise de dados
Para criar um relatório na janela Data Analysis (Análise de dados), siga os passos seguintes:

1. Antes de criar o relatório, efectue os ajustes finais ao conteúdo dos poços, aos poços 
seleccionados, aos gráficos e às folhas de cálculo na janela Data Analysis (Análise 
de dados).

2. Clique no botão Report (Relatório) na barra de ferramentas da janela Data Analysis 
(Análise de dados) para abrir a janela Report (Relatório).
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3. Altere as opções que pretende incluir no relatório. O relatório abre-se com as opções 
predefinidas seleccionadas. Clique nas caixas de selecção da lista de opções 
de relatório para alterar categorias por inteiro ou opções individuais de uma categoria. 

NOTA: Os dados que aparecem no relatório dependem das selecções actuais 
dos separadores da janela Data Analysis (Análise de dados). Por exemplo, 
uma experiência de quantificação poderá não conter uma curva padrão, pelo 
que esses dados não aparecem na janela Data Analysis (Análise de dados) nem 
no relatório de dados.

4. Clique no botão Update Report (Actualizar relatório) para actualizar a pré-visualização 
do relatório sem quaisquer alterações.

5. Imprima ou guarde o relatório. Clique no botão de impressão na barra de ferramentas 
para imprimir o relatório actual. Seleccione File > Save (Ficheiro > Guardar) para guardar 
o relatório como um ficheiro em formato PDF (ficheiro Adobe Acrobat Reader), MHT 
(documento Microsoft) or MHTML (documento Microsoft), e seleccione uma localização 
para guardar o ficheiro. Seleccione File > Save As (Ficheiro > Guardar como) para 
guardar o relatório com um novo nome ou numa nova localização.

6. (Opcional) Crie um modelo de relatório com as informações pretendidas. Para guardar 
as definições de relatório actuais num modelo, seleccione Template > Save ou Save As 
(Modelo > Guardar ou Guardar como). Pode assim carregar o modelo de relatório 
da próxima vez que quiser criar um novo relatório.

Categorias de relatórios de análise de dados
Um relatório pode incluir qualquer uma das opções das categorias descritas na Tabela 22, 
consoante o tipo de dados na janela Data Analysis (Análise de dados). 

Tabela 22. Categorias de relatórios de análise de dados na lista de opções.

Categoria Opção Descrição

Header (Cabeçalho) Título, subtítulo e logótipo do relatório

Report Information 
(Informação do relatório)

Data da experiência, nome de utilizador, 
nome do ficheiro de dados, caminho 
do ficheiro de dados e grupo de poços 
seleccionado

Notes (Notas) Notas sobre o relatório de dados

Experiment Setup (Configuração da experiência)

Run Information 
(Informação do ciclo)

Inclui a data da experiência, o nome 
de utilizador, o nome do ficheiro 
de dados, o caminho do ficheiro 
de dados e o grupo de poços 
seleccionado

Protocol (Protocolo) Visualização de texto dos passos 
e opções do protocolo

Plate Display (Mostrar 
placa)

Mostra uma vista de placa com 
a informação de cada poço da placa

Quantitation (Quantificação)

Analysis Settings 
(Definições de análise)

Inclui o número de passo quando 
os dados foram recolhidos, o modo 
de análise e o método de subtracção 
da linha de base
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Amplification Chart 
(Gráfico de amplificação)

Cópia do gráfico de amplificação para 
experiências que incluem dados 
de quantificação

Standard Curve Chart 
(Gráfico de curva padrão)

Cópia do gráfico de curva padrão

Data (Dados) Folha de cálculo que mostra os dados 
de cada poço

Gene Expression (Expressão de genes)

Analysis Settings 
(Definições de análise)

Inclui o modo de análise, dados 
do gráfico, opção de dimensionamento 
e erro do gráfico

Chart (Gráfico) Cópia do gráfico de expressão de genes

Target Names (Nomes 
de alvos)

Gráfico dos nomes

Sample Names (Nomes 
de amostras)

Gráfico dos nomes

Data (Dados) Folha de cálculo que mostra os dados 
de cada poço

Melt Curve (Curva de fusão)

Analysis Settings 
(Definições de análise)

Inclui o número do passo de fusão 
e a definição da barra de limiar

Melt Curve Chart (Gráfico 
da curva de fusão)

Cópia do gráfico da curva de fusão

Melt Peak Chart (Gráfico 
do pico de fusão)

Cópia do gráfico do pico de fusão

Data (Dados) Folha de cálculo que mostra os dados 
de cada poço

Allelic Discrimination (Discriminação alélica)

Analysis Settings 
(Definições de análise)

Inclui o modo de apresentação, 
fluoróforos, ciclo, limiares e dados 
normalizados

Chart (Gráfico) Cópia do gráfico de discriminação 
alélica

Data (Dados) Folha de cálculo que mostra os dados 
de cada poço

End Point (Ponto final)

Analysis Settings 
(Definições de análise)

Inclui fluoróforo, ciclos finais cuja média 
deve ser calculada, modo, valor mais 
baixo de RFU, valor mais alto de RFU 
e valor de cutoff

Data (Dados) Folha de cálculo que mostra os dados 
de cada poço

Tabela 22. Categorias de relatórios de análise de dados na lista de opções. 

Categoria Opção Descrição
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9 Análise de expressão de genes
Leia este capítulo para obter informações sobre a execução de análise de expressão 
de genes:

• Expressão de genes (em baixo)

• Configuração de placas para análise de expressão de genes (página 90)

• Separador Gene Expression (Expressão de genes) (página 90)

• Janela Experiment Settings (Definições da experiência) (página 96)

• Estudo de genes (página 98)

• Janela Gene Study Report (Relatório do estudo de genes) (página 103)

Expressão de genes
Com a utilização de controlos qualificados de forma rigorosa nas reacções, pode executar 
uma experiência de expressão de genes para normalizar as diferenças relativas numa 
concentração alvo entre amostras. Normalmente, os níveis de mensagem para um ou mais 
genes de referência são utilizados para normalizar os níveis de expressão de um gene 
pretendido. Os genes de referência têm em conta as diferenças de carregamento ou outras 
variações representadas em cada amostra, e não devem ser regulados no sistema biológico 
que está a ser estudado.

Abra o separador Gene Expression (Expressão de genes) para avaliar as diferenças relativas 
entre reacções de PCR em dois ou mais poços. Por exemplo, pode avaliar os números 
relativos de genomas virais ou os números relativos de sequências transfectadas na reacção 
de PCR. A aplicação mais comum para o estudo da expressão de genes é a comparação 
da concentração de cADN em mais de uma reacção para calcular os níveis de ARN 
mensageiro de estado fixo.

O software calcula o nível de expressão relativa de um alvo com um dos seguintes cenários: 

• Nível de expressão relativa de uma sequência alvo (Alvo 1) em relação a outro alvo 
(Alvo 2). Por exemplo, a quantidade de um gene relativamente a outro gene sob 
o mesmo tratamento de amostra

• O nível de expressão relativa de uma sequência alvo numa amostra comparado com 
o mesmo alvo sob tratamentos de amostra diferentes. Por exemplo, a quantidade 
relativa de um gene relativamente a si próprio sob condições temporais, geográficas 
ou de desenvolvimento diferentes
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Configuração de placas para análise de expressão 
de genes

Para efectuar a análise de expressão de genes, o conteúdo dos poços deve incluir o seguinte:

• Dois ou mais alvos. Os dois alvos que representam sequências ou genes amplificados 
diferentes nas amostras

• Um ou mais alvos de referência. Pelo menos um alvo tem de ser um alvo de referência 
para a expressão normalizada. Atribua todos os alvos de referência na janela Experiment 
Settings (Definições da experiência) (página 45) para analisar os dados no modo 
Normalized Expression (Expressão normalizada) (C(t)). As experiências que não 
contenham uma referência têm de ser analisadas utilizando o modo Relative Expression 
(Expressão relativa) (C(t))

• Amostras comuns. As reacções têm de incluir amostras comuns (necessárias duas 
no mínimo) para visualizar os dados em gráfico no separador Gene Expression 
(Expressão de genes). Estas amostras representam diferentes tratamentos ou condições 
para cada uma das sequências alvo. Atribua uma amostra de controlo (opcional) 
na janela Experiment Settings (Definições da experiência) (página 45)

Os requisitos para a configuração da expressão de genes no Plate Editor (Editor de placas) 
variam consoante o conteúdo das reacções é PCR uniplexada com um fluoróforo nas 
reacções ou PCR multiplexada com mais de um fluoróforo nas reacções.

A Figura 66 mostra um exemplo dos conteúdos mínimos dos poços para uma experiência 
de expressão de genes uniplexada. 

Figura 66. Exemplo do conteúdo de poços numa experiência 
de expressão de genes uniplexada.

A Figura 67 mostra um exemplo dos conteúdos mínimos dos poços para uma experiência 
de expressão de genes multiplexada. 

Figura 67. Exemplo do conteúdo de poços numa experiência 
de expressão de genes multiplexada.

Separador Gene Expression (Expressão de genes)
O separador Gene Expression (Expressão de genes) na janela Data Analysis (Análise 
de dados) mostra a expressão relativa dos alvos nestas duas visualizações:

• Gráfico Gene Expression (Expressão de genes). Mostra os dados de PCR em tempo 
real como expressão normalizada (C(t)) ou quantidade relativa (C(t))
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• Folha de cálculo. Mostra uma folha de cálculo dos dados de expressão de genes

SUGESTÃO: Clique com o botão direito do rato em qualquer gráfico ou folha 
de cálculo para ver as opções. Clique no botão View/Edit Plate (Ver/editar placa) 
no Plate Editor (Editor de placas) e altere o conteúdo dos poços na placa.

.

Figura 68. Disposição do separador Gene Expression (Expressão de genes) na janela 
Data Analysis (Análise de dados).

SUGESTÃO: Clique com o botão direito no gráfico para seleccionar as opções 
de menu de clique de botão direito. Seleccione Sort (Ordenar) neste menu para 
reordenar os nomes Target (Alvo) e Sample (Amostra) no gráfico.

Expressão de genes normalizada

Para normalizar os dados, utilize o nível de expressão medida de um ou mais genes 
de referência (alvos) como um factor de normalização. Os genes de referência são alvos 
que não são regulados no sistema biológico que está a ser estudado, como actina, GAPDH 
ou Histone H3.

Para configurar a análise da expressão de genes normalizada (C(t)), siga as instruções 
abaixo:

1. Abra um ficheiro de dados (extensão .pcrd).

2. Analise os dados no separador Quantitation (Quantificação) na janela Data Analysis 
(Análise de dados). Efectue ajustes nos dados, por exemplo alterar o limite e o modo 
de análise.

3. Clique no separador Gene Expression (Expressão de genes).
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4. Seleccione um controlo no separador Samples (Amostras) na janela Experiment 
Settings (Definições da experiência). Se um controlo for atribuído, o software normaliza 
as quantidades relativas para todos os genes na quantidade de controlo, que está 
definida como 1.

5. Seleccione os genes de referência para esta experiência no separador Target (Alvo) 
da janela Experiment Settings (Definições da experiência). A análise da expressão 
de genes requer uma referência entre os alvos nas amostras.

6. Seleccione Normalized Expression (C(t)) (Expressão normalizada) se ainda não 
estiver seleccionado e, em seguida, visualize os níveis de expressão no separador Gene 
Expression (Expressão de genes).

Quantidade relativa
Seleccione Relative Quantity (C(t)) (Quantidade relativa) no menu pendente nos controlos 
do gráfico do separador Gene Expression (Expressão de genes) para executar uma análise 
de quantidade relativa Relative Quantity (C(t)). Por definição, os dados da quantidade relativa 
(C(t)) não são normalizados. Este método é utilizado para quantificar amostras que não 
incluem quaisquer genes de referência (alvos). Normalmente, o investigador confia numa 
das seguintes considerações ao configurar a experiência:

• Cada amostra representa a mesma quantidade do modelo em cada amostra 
biológica, possivelmente a mesma massa de ARN ou cADN em cada poço

• Qualquer variação na quantidade de amostra biológica carregada será normalizada 
após o ciclo por algum método na análise de dados exterior ao software. 
Por exemplo, o investigador poderá optar por dividir o valor da quantidade relativa 
pelo factor de normalização, possivelmente a massa de ácido nucleico carregado 
para cada amostra ou o número de células a partir das quais o ácido nucleico 
foi isolado

Ajustar dados da expressão de genes
Depois de seleccionar o método de análise, ajuste os dados que visualizar no separador Gene 
Expression (Expressão de genes) alterando as opções das definições à direita do gráfico. 

DADOS DO GRÁFICO

As opções dos dados do gráfico permitem apresentar os dados no gráfico com uma de duas 
opções:

• Relative to control. Coloque os dados em gráfico com o eixo com escala entre 0 e 1. 
Se atribuir um controlo na experiência, seleccione esta opção para visualizar 
rapidamente a regulação ascendente e descendente do alvo

• Relative to zero. Coloque os dados em gráfico com a origem em zero

OPÇÕES DO EIXO X

A opção do eixo x permitem seleccionar os dados do eixo x do gráfico Gene Expression 
(Expressão de genes):

• Target. Seleccione esta opção para colocar em gráfico os nomes dos alvos no eixo x

• Sample. Seleccione esta opção para colocar em gráfico os nomes das amostras no 
eixo x
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OPÇÕES DO EIXO Y

A opção do eixo y permite mostrar o gráfico Gene Expression (Expressão de genes) numa 
de três escalas:

• Linear. Seleccione esta opção para mostrar uma escala linear

• Log 2. Seleccione esta opção para avaliar as amostras num intervalo dinâmico extenso

• Log 10. Seleccione esta opção para avaliar as amostras num intervalo dinâmico muito 
extenso

OPÇÕES DE DIMENSIONAMENTO (SCALING)

Seleccione Normalized Gene Expression (C(t)) (Expressão de genes normalizada) para 
activar as opções de dimensionamento no gráfico Gene Expression (Expressão de genes). 
Seleccione uma destas opções de dimensionamento para calcular e apresentar os dados 
da forma que melhor se ajuste à concepção da experiência:

• Unscaled expression. Esta opção apresenta a expressão de genes normalizada não 
dimensionada

• Highest expression. Dimensione a expressão de genes normalizada para a mais 
elevada para cada alvo, dividindo o nível de expressão de cada amostra pelo nível mais 
elevado de expressão em todas as amostras. Esta opção de dimensionamento utiliza 
a fórmula Scaled to highest (Dimensionada para a mais elevada)

• Lowest expression. Calcule novamente a expressão de genes normalizada para cada 
alvo, dividindo o nível de expressão de cada amostra pelo nível mais baixo de expressão 
em todas as amostras. Esta opção de dimensionamento utiliza a fórmula Scaled to 
lowest (Dimensionada para mais baixa)

ERROR TYPE

Seleccione uma opção para o tipo de cálculos de erro (barras de erro) no gráfico Gene 
Expression (Expressão de genes):

• Standard Error of the Mean (default, SEMs) - Erro padrão da média (predefinição, SEMs)

• Standard Deviation (Std Devs) - Desvio padrão (Std Devs)

CHART ERROR BAR MULTIPLIER

Seleccione um multiplicador das barras de erro no gráfico Gene Expression (Expressão 
de genes). Seleccionar um destes números inteiros: 1 (predefinição), 2 ou 3. O tipo 
de alterações do multiplicador altera-se ao seleccionar Error Type (Tipo de erro):

• SEMs para erro padrão da média

• Std Devs para desvios padrão

TARGET STABILITY VALUE

Abra esta janela sempre que for utilizado mais do que 1 gene de referência. O software calcula 
dois parâmetros de qualidade para os genes de referência:

• Coefficient of Variation (CV) (Coeficiente de variação) das quantidades relativas 
de genes de referência normalizados. Os valores de CV mais baixos denotam 
estabilidade mais elevada

• M-value (Valor M). A medida da estabilidade da expressão de genes de referência
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Opções do menu de clique direito para o gráfico 
de expressão de genes
Clique com o botão direito no gráfico Gene Expression (Expressão de genes) para seleccionar 
os itens apresentados na Tabela 23. 

Folha de cálculo Gene Expression (Expressão de genes)
A Tabela 24 descreve as informações apresentadas na folha de cálculo Gene Expression 
(Expressão de genes).

Tabela 23. Itens do menu de clique direito.

Item Função

Copy (Copiar) Copiar o gráfico para uma área de transferência

Save as Image (Guardar 
como imagem)

Guardar o gráfico na visualização de gráfico como um ficheiro 
de imagem. O tipo de imagem predefinido é PNG. As outras 
selecções para os tipos de ficheiro de imagem incluem GIF, 
JPG, TIF e BMP

Page Setup... 
(Configuração de página)

Seleccionar uma configuração de página para impressão

Print... (Imprimir) Imprimir a visualização do gráfico

Show Point Values 
(Mostrar valores de pontos)

Mostrar a quantidade relativa de cada ponto no gráfico 
quando coloca o cursor sobre esse ponto

Set Scale to Default (Definir 
escala para predefinição)

Definir a visualização do gráfico novamente para as 
predefinições após ampliar

Chart Options... (Opções 
do gráfico)

Abrir a janela Chart Options (Opções do gráfico) para ajustar 
o gráfico

Sort... (Ordenar) Definir a ordem em que as amostras ou alvos aparecem 
no eixo x do gráfico

User Corrected Std Devs 
(Desvios padrão corrigidos 
pelo utilizador)

Calcular as barras de erro utilizando a fórmula de desvio 
padrão corrigido

Use Solid Bar Colors (Utilizar 
cores de barra sólidas)

Apresentar barras sólidas no gráfico

x-axis labels (Etiquetas 
do eixo x)

Seleccionar para apresentar as etiquetas horizontais 
ou em ângulo do eixo x

Tabela 24. Descrição das informações na folha de cálculo no separador Gene 
Expression (Expressão de genes). 

Informação Descrição

Target (Alvo) Nome do alvo (gene amplificado) seleccionado na janela 
Experiment Settings (Definições da experiência)

Sample (Amostra) Nome da amostra seleccionada na janela Experiment Settings 
(Definições da experiência)

Ctrl Amostra de controlo, quando o nome da amostra estiver 
seleccionado como um controlo na janela Experiment Settings 
(Definições da experiência)
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Opção Show Details (Mostrar detalhes)
Ao clicar na caixa de selecção Show Details (Mostrar detalhes), a Tabela 25 também mostra 
esta informação. 

Expression (Expressão) Normalized Gene Expression (C(t)) (Expressão de genes 
normalizada) ou Relative Quantity (C(t)) (Quantidade relativa) 
dependendo do modo seleccionado

Expression SEM (or SD) 
(SEM ou SD da expressão)

Standard Error of the Mean (Erro-padrão da média) ou 
Standard Deviation (Desvio padrão), dependendo da opção 
seleccionada

Corrected Expression SEM 
(or SD) (SEM ou SD da 
expressão corrigida)

Cálculo do valor corrigido para Standard Error of the Mean 
(SEM) (Erro-padrão da média) ou Standard Deviation (SD) 
(Desvio padrão) da expressão relativa, dependendo da opção 
seleccionada

Mean (C(t)) (Média) Média do ciclo de limiar

C(t) SEM (or SD) (SEM ou SD) Standard Error of the Mean (Erro-padrão da média) ou 
Standard Deviation (Desvio padrão) do ciclo de limiar, 
dependendo da opção seleccionada

Tabela 25. Informação na folha de cálculo Gene Expression com a opção Show Details 
(Mostrar detalhes) seleccionada. 

Informação Descrição

Data Set (Conjunto de dados) Dados de fluorescência de um fluoróforo no ficheiro de dados

Relative Quantity 
(Quantidade relativa)

Quantidade relativa calculada de amostras

Relative Quantity SD 
(SD de quantidade relativa)

Desvio padrão do cálculo da quantidade relativa

Corrected Relative Quantity 
SD (SD de quantidade relativa 
corrigida)

Desvio padrão calculado da quantidade relativa corrigida

Unscaled Expression 
(Expressão não 
dimensionada)

Expressão não dimensionada calculada

Unscaled Expression SD 
(SD de expressão não 
dimensionada)

Desvio padrão calculado da expressão não dimensionada

Corrected Unscaled 
Expression SD (SD de 
expressão não dimensionada 
corrigida)

Desvio padrão corrigido da expressão não dimensionada

Expression (Expressão) Nível de expressão relativa

Wells (Poços) Número do poço na placa

Tabela 24. Descrição das informações na folha de cálculo no separador Gene 
Expression (Expressão de genes).  (continuação)

Informação Descrição
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Janela Experiment Settings (Definições da experiência)
Para abrir a janela Experiment Settings (Definições de experiência), clique no botão 
Experiment Settings no separador Gene Expression (Expressão de genes). Nesta janela, veja 
ou altere a lista de Targets (Alvos) e Samples (Amostras), seleccione os genes de referência, 
seleccione as amostras de controlo ou defina o grupo de amostras da análise de expressão 
de genes para ser analisado se tiverem sido adicionados nomes de recolha (Collection 
Names) aos poços (Figura 69).

Figura 69. Janela Experiment Settings (Definições da experiência) com o separador 
Targets (Alvos) seleccionado.

Para ajustar as listas nestes separadores, utilize as funções seguintes:

• Para adicionar um nome de alvo ou amostra, digite um nome na caixa New (Novo) 
e clique em Add (Adicionar)

• Para remover um nome de alvo ou de amostra da lista, clique na caixa Select 
to Remove Name (Seleccionar para remover nome) nessa fila e, em seguida, clique 
no botão Remove checked item(s) (Remover itens seleccionados)

• Para seleccionar o alvo como uma referência para a análise de dados da expressão 
de genes, clique na caixa na coluna Reference (Referência) ao lado do nome 
(Name) desse alvo

• Para seleccionar a amostra como amostra de controlo para a análise de dados 
da expressão de genes, clique na caixa na coluna Control (Controlo) ao lado 
do nome dessa amostra

Sample Name Grouping Option (Opção de agrupamento 
por nomes de amostra)
Carregar os Collection Names (Nomes de recolha) nos poços permite que as amostras sejam 
analisadas numa de quatro configurações definidas pela Sample Name Grouping Option 
(Opção de agrupamento por nomes de amostra). Estas opções estão disponíveis no menu 
pendente no separador Experiment Settings (Definições da experiência). 

• Target vs. Sample (Alvo vs. Amostra). Apenas o nome da amostra no poço é utilizado 
nos cálculos de expressão de genes

• Target vs. Collection (Alvo vs. Recolha). Apenas o nome de recolha do poço 
é utilizado nos cálculos
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• Target vs. Sample_Collection (Alvo vs. Amostra_Recolha). O nome da amostra 
e o nome da recolha são combinados num único nome que é utilizado nos cálculos 

• Target vs. Collection_Sample (Alvo vs. Recolha_Amostra). O nome da recolha 
e o nome da amostra são combinados num único nome que é utilizado nos cálculos

Show Analysis Settings (Mostrar definições da análise) 
em Experiment Settings (Definições da experiência)
Clique na caixa Show Analysis Settings (Mostrar definições da análise) na janela Experiment 
Settings (Definições da experiência) para ver ou alterar os parâmetros da análise aplicados 
no separador Gene Expression (Expressão de genes):

• Clique numa célula na coluna Color (Cor) para alterar a cor dos alvos incluídos 
no gráfico Gene Expression (Expressão de genes)

• Introduza um número para a eficiência de um alvo. O software irá calcular 
a eficiência relativa para um alvo utilizando Auto Efficiency (Eficiência automática) 
se os dados de um alvo incluírem uma curva padrão. Alternativamente, introduza 
uma eficiência previamente determinada

A Figura 70 mostra a eficiência de todos os alvos, que aparece se a opção Auto Efficiency 
(Eficiência automática) estiver seleccionada.

Figura 70. Separador Targets (Alvos) na janela Experiment Settings (Definições 
da experiência) com Analysis Settings (Definições da análise) seleccionado.

Para ajustar as definições de uma amostra no separador Samples (Amostras):

• Clique numa cor na coluna Color (Cor) para alterar a cor das amostras incluídas 
no gráfico Gene Expression (Expressão de genes)

• Clique numa caixa na coluna Show Chart (Mostrar gráfico) para mostrar a amostra 
no gráfico Gene Expression (Expressão de genes) utilizando uma cor que esteja 
seleccionada na coluna Color (Cor)
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Estudo de genes
Crie um estudo de genes para comparar os dados da expressão de genes de uma ou mais 
experiências de PCR em tempo real utilizando um calibrador de inter-execução para 
normalizar os dados entre as experiências. Crie um estudo de genes adicionando dados 
de um ou mais ficheiros de dados (extensão .pcrd) ao estudo; o software agrupa-os num 
único ficheiro (extensão .mgxd).

NOTA: Os dados da expressão de genes têm de incluir uma amostra comum 
em cada ficheiro de dados para criar um estudo de genes. O software utiliza uma 
amostra comum para normalizar os dados entre experiências. Seleccione os 
nomes das amostras na janela Experiment Settings (Definições da experiência) 
(página 45).

NOTA: O número máximo de amostras que podem ser analisadas num estudo 
de genes está limitado pelo tamanho da RAM e da memória virtual do computador.

Calibração de inter-execução do estudo de genes
Todos os dados no estudo de genes são normalizados pelo calibrador de inter-execução para 
calcular o valor médio C(t) mais baixo. Quando os ficheiros de dados no estudo de genes 
incluem mais do que um calibrador de inter-execução, o calibrador com o valor médio C(t) 
mais baixo transforma-se no calibrador de inter-execução dominante. O calibrador dominante 
é utilizado para ajustar todos os valores C(t) no estudo de genes.

Para localizar o calibrador de inter-execução dominante, o software calcula a média dos 
valores C(t) de todos os calibradores de inter-execução de um determinado alvo (gene) e, 
em seguida, utiliza um algoritmo multi-escalão para determinar o calibrador de inter-execução 
dominante de todos os dados. O algoritmo para localizar o calibrador de inter-execução 
dominante inclui a seguinte hierarquia: 

1. Defina o calibrador dominante no alvo com o número mais elevado de grupos replicados 
comuns numa determinada comparação por pares. 

2. Se qualquer alvo tiver o mesmo número de grupos replicados comuns, defina 
o calibrador dominante para o alvo com o intervalo mais baixo de valores C(t) nas 
comparações por pares. O intervalo é examinado comparando o valor absoluto 
da diferença entre o C(t) máximo e mínimo para os calibradores de inter-execução 
de um determinado alvo.

3. Se qualquer alvo tiver um intervalo idêntico aos valores C(t), defina o calibrador 
dominante para o alvo com o valor absoluto mais baixo da média C(t) para amostras 
do calibrador de inter-execução elegíveis.

4. Se qualquer alvo tiver valores absolutos C(t) de média idênticos, defina o calibrador 
dominante para o grupo replicado com o valor C(t) mais baixo.

NOTA: O primeiro ficheiro de dados importado no estudo de genes irá servir 
sempre como o ficheiro central para comparação de dados por pares durante 
a calibração de inter-execução.

Janela Gene Study (Estudo de genes)
A janela Gene Study (Estudo de genes) inclui dois separadores:

• Separador Study Setup (Configuração do estudo). Clique neste separador para gerir 
as experiências no estudo de genes. Adicionar ou remover ficheiros de dados num 
estudo de genes não altera os dados originais nesse ficheiro
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• Separador Study Analysis (Análise do estudo). Clique neste separador para ver 
os dados de expressão de genes das experiências combinadas

Figura 71 - janela Gene Study (Estudo de genes).

Figura 71. Janela Gene Study (Estudo de genes).

Separador Study Setup (Configuração do estudo)
Antes de importar dados para um estudo de genes, faça o seguinte na janela Data Analysis 
(Análise de dados):

• Verifique se as amostras que contêm o mesmo conteúdo têm o mesmo nome. 
Num estudo de genes, o software parte do princípio que os poços com o mesmo 
nome de alvo e amostra (Target e Sample) contêm as mesmas amostras

• Ajuste a linha de base e o limiar (C(t)) no separador Quantitation (Quantificação) 
para optimizar os dados em cada experiência antes de os adicionar a um estudo 
de genes

• Seleccione o grupo de poços que pretende incluir no estudo de genes

O separador Study Setup (Figura 71) (Configuração do estudo) mostra uma lista de todas 
as experiências no estudo de genes.

• Adicionar experiências. Clique no botão Add Data Files (Adicionar ficheiros de dados) 
para seleccionar um ficheiro numa janela do browser. Para adicionar rapidamente 
experiências a um estudo de genes, arraste os ficheiros de dados (extensão .pcrd) 
para a janela Gene Study (Estudo de genes)

• Remover experiências deste estudo de genes. Seleccione um ou mais ficheiros 
na lista e clique em Remove (Remover)

• Adicionar notas sobre o estudo de genes. Escreva na caixa Notes (Notas) 
para adicionar comentários sobre os ficheiros e análises neste estudo de genes
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O separador Study Setup (Configuração do estudo) mostra os ficheiros de dados no estudo 
de genes, conforme se descreve na Tabela 26. 

Separador Study Analysis (Análise do estudo)
O separador Study Analysis (Análise do estudo) mostra os dados de todas as experiências 
adicionadas ao estudo de genes. Abra este separador para analisar os dados e seleccione 
estas opções para o gráfico Gene Expression (Expressão de genes):

• Mode. Seleccione Normalized Expression (C(t)) (Expressão normalizada) 
ou Relative Quantity (C(t)) (Quantidade relativa)

• Graph Data. Seleccione Relative to normal (Relativo a normal) ou Relative to control 
(Relativo a controlo) no gráfico

• x-axis options. Seleccione as etiquetas no eixo x do gráfico, incluindo Sample 
(Amostra) ou Target (Alvo)

• y-axis options. Altere as etiquetas no eixo y do gráfico, incluindo Linear, Log 2 
(Registo 2) ou Log 10 (Registo 10)

• Scaling Options. Seleccione o valor Highest (Mais elevado), Lowest (Mais baixo) 
ou deixe os dados Unscaled (Não dimensionados). Esta opção só está disponível 
quando as amostras não contêm controlos

• Graph Error. Seleccione o multiplicador das barras de desvio padrão no gráfico, 
incluindo ±1, 2 ou 3

• Botão Experiment Settings (Definições da experiência). Seleccione mostrar opções 
para alvos e amostras na janela Experiment Settings (Definições da experiência)

• Caixa de selecção Show Details. Clique em Show Details (Mostrar detalhes) 
para adicionar mais colunas de dados ao gráfico

Tabela 26. Separador Study Setup (Configuração do estudo) na janela Gene Study 
(Estudo de genes).

Título da coluna Descrição

File Name (Nome do ficheiro) Nome do ficheiro de dados da experiência (extensão .pcrd)

File Folder (Pasta de ficheiros) Directório que armazena o ficheiro de dados para cada 
experiência no estudo de genes

Date Created (Data 
da criação)

Data em que os dados do ciclo foram recolhidos

Well Group Name 
(Nome do grupo de poços)

Nome do grupo de poços que foi seleccionado quando 
o ficheiro foi adicionado ao estudo de genes

SUGESTÃO: para analisar um grupo de poços no estudo 
de genes, esse grupo de poços tem de ser seleccionado 
na janela Data Analysis (Análise de dados) antes 
de importar o ficheiro de dados para o estudo de genes.

Step (Passo) Passo de protocolo que incluiu a leitura de placa para 
recolher dados de PCR em tempo real

Grid View (Visualização 
da grelha)

Abre um mapa das placas com os dados em cada uma 
das experiências incluídas no estudo de genes
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Realçar uma amostra no gráfico Gene Expression (Expressão de genes) realça a célula 
correspondente na folha de cálculo sob o gráfico (Figura 72). 

Figura 72. Separador Study Analysis (Análise do estudo) 
na janela Gene Study (Estudo de genes).

Folha de cálculo de dados do estudo de genes
A folha de cálculo de dados na janela Gene Study (Estudo de genes) mostra a informação 
sobre cada alvo e amostra no estudo de genes (Figura 72). 

A Tabela 27 descreve as informações apresentadas na folha de cálculo Gene Study (Estudo 
de genes).

Tabela 27. Informações na folha de cálculo no separador Study Analysis (Análise do 
estudo). 

Informação Descrição

Target (Alvo) Nome do alvo (gene amplificado) seleccionado na janela 
Experiment Settings (Definições da experiência)

Sample (Amostra) Nome da amostra seleccionada na janela Experiment Settings 
(Definições da experiência)

Ctrl Amostra de controlo, quando o nome da amostra estiver 
seleccionado como um controlo na janela Experiment Settings 
(Definições da experiência)

Expression (Expressão) Normalized Gene Expression (C(t)) (Expressão de genes 
normalizada) ou Relative Quantity (C(t)) (Quantidade relativa), 
dependendo do modo seleccionado

Expression SEM (or SD) 
(SEM ou SD da expressão)

Standard Error of the Mean (Erro-padrão da média) 
ou Standard Deviation (Desvio padrão), dependendo 
da opção seleccionada
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Dados de Show Details (Mostrar dados)
Clique na caixa de selecção Show Details (Mostrar detalhes) para mostrar informações 
adicionais. A folha de cálculo adiciona a informação nas colunas mostradas na Tabela 28. 

Corrected Expression SEM 
(or SD) (SEM ou SD 
da expressão corrigida)

Cálculo do valor corrigido para Standard Error of the Mean 
(SEM) (Erro-padrão da média) ou Standard Deviation (SD) 
(Desvio padrão) da expressão relativa, dependendo da opção 
seleccionada

Mean (C(t)) (Média) Média do ciclo de limiar

C(t) SEM (or SD) (SEM ou SD) Standard Error of the Mean (Erro-padrão da média) 
ou Standard Deviation (Desvio padrão) do ciclo de limiar, 
dependendo da opção seleccionada

Tabela 28. Informação adicionada à folha de cálculo quando a opção Show Details 
(Mostrar detalhes) está seleccionada.

Informação Descrição

Data Set (Conjunto 
de dados)

Dados de fluorescência de um fluoróforo num ficheiro 
de dados

Relative Quantity 
(Quantidade relativa)

Quantidade relativa calculada de amostras

Relative Quantity SD 
(SD de quantidade relativa)

Desvio padrão do cálculo da quantidade relativa

Corrected Relative Quantity 
SD (SD de quantidade 
relativa corrigida) 

Desvio padrão calculado da quantidade relativa corrigida

Unscaled Expression 
(Expressão 
não dimensionada)

Expressão não dimensionada calculada

Unscaled Expression SD 
(SD de expressão não 
dimensionada)

Desvio padrão calculado da expressão não dimensionada

Corrected Unscaled 
Expression SD (SD 
de expressão não 
dimensionada corrigida)

Desvio padrão corrigido da expressão não dimensionada

Expression (Expressão) Expressão relativa 

Wells (Poços) Número do poço na placa

Tabela 27. Informações na folha de cálculo no separador Study Analysis (Análise do 
estudo).  (continuação)

Informação Descrição
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Janela Gene Study Report (Relatório de estudo de genes)
Abra a janela Gene Study Report (Relatório do estudo de genes) para organizar os dados 
do estudo de genes num relatório. Para criar um relatório do estudo de genes, siga estes 
passos:

1. Ajuste os dados e gráficos do relatório do estudo de genes conforme necessário antes 
de criar um relatório.

2. Seleccione Tools > Reports (Ferramentas > Relatórios) para abrir a janela Gene Study 
Report (Relatório do estudo de genes).

3. Clique nas caixas de selecção na lista de opções do relatório para seleccionar e remover 
opções para seleccionar os dados a apresentar. 

4. Clique no botão Update Report (Actualizar relatório) para actualizar o painel de pré-
visualização do relatório. Este painel mostra o relatório.

5. Imprima ou guarde o relatório. Clique no botão Print (Imprimir) na barra de ferramentas 
para imprimir o relatório actual. Seleccione File > Save (Ficheiro > Guardar) para guardar 
o relatório como um ficheiro em formato PDF (ficheiro Adobe Acrobat Reader), MHT 
(documento Microsoft) or MHTML (documento Microsoft), e seleccione uma localização 
para guardar o ficheiro. Seleccione File > Save As (Ficheiro > Guardar como) para 
guardar o relatório com um novo nome ou numa nova localização.
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10 Utilizadores e preferências
Leia este capítulo para obter mais informações sobre como gerir os utilizadores do software 
e suas preferências:

• Iniciar sessão ou seleccionar utilizador (abaixo)

• Janela User Preferences (Preferências do utilizador) (página 106)

• Configurar notificações de e-mail (página 107)

• Administração de utilizadores (página 112)

Iniciar sessão ou seleccionar utilizador
O CFX Manager™ software gere vários utilizadores e suas preferências. O utilizador actual 
do software com sessão iniciada é apresentado no topo da janela principal do software 
(Figura 73).

Figura 73. Nome do utilizador apresentado. 

O CFX Manager software gere quem inicia sessão no software através da caixa de diálogo 
Login (Iniciar sessão) (Figura 74). Ao iniciar o software, a caixa de diálogo Login (Iniciar 
sessão) abre-se automaticamente se houver dois ou mais utilizadores mostrados na janela 
User Administration (Administração de utilizadores).

Figura 74. Caixa de diálogo Login (Iniciar sessão).

Inicie sessão no software ou mude de utilizador através dos passos seguintes:

1. Abra a caixa de diálogo Login (Iniciar sessão) (se ainda não estiver aberta), clicando 
para tal no botão de Selecção do utilizador na barra de ferramentas ou seleccionando 
User > Select User (Utilizador > Seleccionar utilizador) na barra de menus.
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2. Seleccione um nome na lista pendente User Name (Nome de utilizador). A predefinição 
é “Admin” (administrador).

3. Digite uma password na caixa Password.

4. Clique em OK para fechar a caixa de diálogo Login e abrir o software. 

5. Para adicionar um novo nome de utilizador e password, contacte o administrador 
do software.

Alterar a password
Altere a password de acordo com as instruções seguintes:

1. Seleccione User > Change Password (Utilizador > Alterar password) no menu da janela 
principal do software para abrir a caixa de diálogo Change Password (Alterar password).

2. Introduza a antiga password na caixa Old Password (Password antiga).

3. Introduza a nova password nas caixas New Password (Nova password) e Confirm New 
Password (Confirmar nova password).

4. Clique em OK para confirmar a alteração.

Janela User Preferences (Preferências do utilizador)
O CFX Manager software regista as preferências de cada utilizador que inicia sessão 
no software. Para alterar as preferências do utilizador, abra a janela User Preferences 
(Preferências do utilizador) utilizando um dos métodos seguintes:

• Clique no botão User Preferences (Preferências do utilizador) na barra 
de ferramentas da janela principal do software

• Seleccione User > User Preferences (Utilizador > Preferências do utilizador) 
na barra de menus da janela principal do software

• Clique num dos separadores (Figura 75) para ver ou alterar as preferências

Figura 75. Janela User Preferences (Preferências do utilizador) com separadores.
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Separador Email
Seleccione o separador Email (Figura 75) para introduzir os endereços de e-mail para os quais 
pretende que seja enviada a confirmação da conclusão do ciclo. O software pode enviar 
um ficheiro de dados ou um ficheiro de relatório anexados ao e-mail quando as caixas 
de selecção junto a estas opções estiverem seleccionadas. 

CONFIGURAR NOTIFICAÇÕES DE E-MAIL

Clique no botão Configure Outgoing Email (Configurar e-mail a sair) para abrir a janela 
Options (Opções) (Figura 76) para configurar o servidor SMTP e enviar um e-mail de teste 
do computador. Introduza o seguinte:

• SMTP Server Name. O nome do servidor SMTP conforme fornecido pelo fornecedor 
de serviços de internet

• Port. O número de porta do servidor SMTP, conforme fornecido pelo fornecedor 
de serviços de internet; regra geral, é 25

• Use SSL. Utilizar (ou não) Secure Sockets Layer (Camada de Sockets Segura). 
Alguns servidores SMTP requerem a sua utilização, enquanto que outros não

• Use Default “From” Address. Utilizar o endereço “from” (do remetente) predefinido. 
Geralmente, isto pode ficar no estado predefinido de seleccionado. No entanto, alguns 
servidores SMTP requerem que todo o e-mail enviado tenha um endereço “from” 
(do remetente) que seja de um determinado domínio, ou seja <nome>@Sua 
Empresa.com. Se for o caso, anule a selecção desta caixa de selecção e indique 
um endereço “from” válido na caixa “From” Address

• Authentication Required. Muitos servidores SMTP requerem a autenticação. 
Se for o caso, seleccione esta caixa e indique um nome de utilizador (User Name) 
e uma Password nos respectivos campos

• Test email. Para testar as definições de e-mail, introduza um ou mais endereços 
de e-mail na caixa de texto Test Email Address (Testar endereço de e-mail). 
Os endereços de e-mail podem ser separados por vírgulas. A seguir, clique 
no botão Test Email (Testar e-mail)

Figura 76. Opções de configuração de e-mail.

NOTA: Alguns servidores SMTP não permitem anexos, e outros permitem anexos 
apenas até determinado tamanho. Se pretende utilizar o CFX Manager software 
para enviar ficheiros e/ou relatórios de dados por e-mail, teste a capacidade 
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do servidor seleccionando a caixa Test Attachment (Testar anexo) e definindo 
Attachment Size in MB (Tamanho do anexo em MB) como 5 megabytes (MB) 
ou mais.

Separador Files (Ficheiros)
Seleccione o separador Files (Ficheiros) para mostrar uma lista das localizações predefinidas 
para abrir e guardar ficheiros. Clique no botão “...” à direita de cada caixa para abrir uma 
janela do browser e localizar uma pasta:

• Default Folder for File Creation. Seleccione uma pasta predefinida onde pretende 
guardar novos ficheiros. Seleccione uma localização para cada tipo de ficheiro (ficheiro 
de protocolo, placa, dados ou estudo de genes)

• File Selection for Experiment Setup. Seleccione os ficheiros de protocolo e de placa 
predefinidos que aparecem ao abrir a janela Experiment Setup (Configuração 
da experiência)

• Data File Prefix. Defina o texto inicial do nome do ficheiro para ficheiros de dados

Separador Protocol (Protocolo)
Seleccione o separador Protocol (Protocolo) na janela User Preferences (Preferências 
do utilizador) para especificar as predefinições de um novo ficheiro de protocolo na janela 
Protocol Editor (Editor de protocolos):

• Protocol Editor. Defina as predefinições que aparecem no Protocol Editor (Editor 
de protocolos). Seleccione um volume de amostra predefinido para descrever o volume 
de cada amostra nos poços e seleccione uma temperatura de shutoff da tampa

• Protocol AutoWriter. Selecciona as predefinições que aparecem no Protocol AutoWriter

Separador Plate (Placa)
Seleccione o separador Plate (Placa) na janela User Preferences (Preferências do utilizador) 
(Figura 77) para especificar as seguintes predefinições de um novo ficheiro de placa na janela 
Plate Editor (Editor de placas):

• Plate Type. Seleccione o tipo de placa predefinido 

• Plate Size. Seleccione o tamanho de placa predefinido 

• Units. Seleccione as unidades utilizadas para descrever a concentração do modelo 
inicial para poços que contêm padrões 

• Scientific Notation. Seleccione notação científica para ver unidades de concentração 
nessa notação

• Scan Mode. Seleccione um modo de leitura predefinido

• Fluorophores. Clique nas caixas de selecção para seleccionar os fluoróforos 
predefinidos que aparecem nos controlos de carregamento de poços do Plate Editor 
(Editor de placas)

• Libraries. Introduza os nomes de amostras (em Sample Names) e alvos (em Target 
Names) utilizados nas experiências. Estes nomes aparecem nas listas do separador 
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Targets (Alvos) e Samples (Amostras) na janela Experiment Settings (Definições 
da experiência) 

Figura 77. Separador Plate (Placa) na janela User Preferences 
(Preferências do utilizador).

Separador Data Analysis (Análise de dados)
Seleccione o separador Data Analysis (Análise de dados) na janela User Preferences 
(Preferências do utilizador) para alterar as predefinições de dados que aparecem na janela 
Data Analysis (Análise de dados).

Figura 78. Separador Data Analysis (Análise de dados) na janela User Preferences 
(Preferências do utilizador).
109



Utilizadores e preferências
Para os dados de quantificação, seleccione as definições seguintes:

• Analysis Mode. Seleccione o método da linha de base predefinido para o modo 
de análise. Escolha Baseline Subtracted Curve Fit (Ajuste da curva com subtracção 
da linha de base), No Baseline Subtraction (Sem subtracção da linha de base) 
ou Baseline Subtracted (Com subtracção da linha de base)

• C(t) Determination Mode. Seleccione entre o modo de regressão (Regression) 
ou de limiar simples (Single Threshold) para determinar a forma como são calculados 
os valores C(t) para cada traçado de fluorescência

• Log View. Seleccione On (Activado) para mostrar um gráfico semi-logarítmico 
dos dados da amplificação. Seleccione Off (Desactivado) para mostrar um gráfico linear

Para os dados de discriminação alélica, seleccione as definições seguintes:

• Display Mode. Seleccione RFU para mostrar os dados na forma de um gráfico de RFU, 
ou seleccione Threshold Cycle (Ciclo de limiar) para mostrar um gráfico de ciclos 
de limiares

• Normalize Data. Esta selecção só está disponível com RFU seleccionado. Seleccione 
No (Não) para mostrar dados não normalizados. Seleccione Yes (Sim) para normalizar 
os dados para a amostra de controlo

Para os dados de ponto final, seleccione as definições seguintes: Seleccione o número 
de ciclos finais cuja média deve ser calculada ao calcular os cálculos de ponto final:

• PCR. Introduza o número de ciclos para PCR para calcular a média de ciclos finais 
para dados de quantificação (a predefinição é 5)

• End Point Only Run. Introduza o número de ciclos para End Point Only Run 
(Ciclo só de ponto final) para calcular a média de ciclos finais para dados de ponto 
final (a predefinição é 2) 

Separador Gene Expression (Expressão de genes)
Seleccione o separador Gene Expression (Expressão de genes) na janela User Preferences 
(Preferências do utilizador) para especificar as predefinições de um novo ficheiro de dados 
de expressão de genes:

• Relative to. Seleccione um controlo ou zero. Para colocar em gráfico os dados de 
expressão de genes que originam em 1 (relativo a um controlo), seleccione Control 
(Controlo). Ao atribuir uma amostra de controlo na janela Experiment Setup 
(Configuração da experiência), por predefinição, o software calcula automaticamente 
os dados relativos a esse controlo. Seleccione Relative to zero (Relativo a zero) para 
que o software ignore o controlo, que é a selecção predefinida quando nenhuma 
amostra de controlo é atribuída na janela Experiment Settings (Definições da 
experiência)

• X-Axis. Representar por meio de gráfico o alvo (Target) ou a amostra (Sample) no eixo x

• Y-Axis. Representar por meio de gráfico a escala Linear, Log 2 ou Log 10 no eixo y

• Scaling. Seleccione uma opção de dimensionamento para o gráfico. Deixe o gráfico 
sem dimensionar. Em alternativa, escolha uma opção de dimensionamento para 
dimensionar para o valor mais alto (Highest) ou mais baixo (Lowest)

• Method. Definir o modo de análise predefinido, incluindo a expressão normalizada 
(Ct) ou a expressão relativa (Ct)

• Error Bar. Seleccione Std Dev. para o desvio padrão, ou Std. Error Mean para o erro 
padrão da média

• Std Devs. Seleccione o multiplicador do desvio padrão para representar por meio 
de gráfico as barras de erro. A predefinição é 1. Altere o multiplicador para 2 ou 3
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Separador QC (Controlo de qualidade)
Seleccione o separador QC (Controlo de qualidade) na janela User Preferences (Preferências 
do utilizador) para especificar as regras de controlo de qualidade a aplicar aos dados no 
módulo de análise de dados. O software valida os dados de acordo com os testes activados 
e os valores atribuídos (página 111). 

Figura 79. Separador QC (Controlo de qualidade) na janela User Preferences 
(Preferências do utilizador).

Especifique para adicionar valores de cutoff e para activar as seguintes regras de controlo 
de qualidade:

• Controlo negativo com C(t) inferior a XX. Introduzir um valor de cutoff de C(t)

• NTC (no template control) com C(t) inferior a XX. Introduzir um valor de cutoff de C(t)

• NRT (no reverse transcriptase control) (sem controlo da transcriptase inversa) com 
C(t) inferior a XX. Introduzir um valor de cutoff de C(t)

• Controlo positivo com C(t) superior a XX. Introduzir um valor de cutoff de C(t)

• Desconhecido sem C(t)

• Padrão sem C(t)

• Eficiência superior a XX. Introduzir um valor de cutoff da eficiência da reacção 
que é calculado para a curva padrão

• Eficiência inferior a XX. Introduzir um valor de cutoff da eficiência da reacção 
que é calculado para a curva padrão

• R^2 da curva padrão inferior a XX. Introduzir um valor R^2 de cutoff para a 
curva padrão

• Desvio padrão da C(t) do grupo de réplicas superior a XX. Introduzir um valor 
de cutoff do desvio padrão que seja calculado para cada grupo de réplicas
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Administração de utilizadores
Abra a janela User Administration (Administração de utilizadores) na janela principal 
do software:

• Seleccione Users > User Administration (Utilizadores > Administração 
de utilizadores)

• Clique no botão User Administration (Administração de utilizadores) na barra 
de menus

Se iniciar sessão como administrador (Administrator), abra a janela User Administration 
(Administração de utilizadores) para gerir utilizadores e respectivos direitos:

• Manage Users. Adicionar ou remover utilizadores e atribuir uma função a cada um

• Manage Rights. Alterar os direitos relativos às funções de utilizadores (Principal, 
Operator ou Guest)

NOTA: Esta janela só pode ser editada por utilizadores administradores. 
Os restantes utilizadores só podem visualizá-la.

Para atribuir uma função a cada utilizador, seleccione uma função na lista de funções 
da janela User Administration (Administração de utilizadores) (Figura 80). Neste exemplo, 
ao utilizador Guest é atribuído o direito de guardar ficheiros. 

Figura 80. Janela User Administration (Administração de utilizadores) 
com três utilizadores.

Adicionar e remover utilizadores do software
Só um administrador do software pode adicionar e remover utilizadores. Para adicionar 
utilizadores do software no painel Manage Users (Gerir utilizadores), siga os passos seguintes:

1. Introduza um nome de utilizador (User Name) para o novo utilizador do software. 

2. Seleccione uma função (Role) para o utilizador. Estas funções restringem os direitos 
de cada utilizador. A predefinição é Principal.

3. (Opcional) Introduza um nome completo (Full Name) e uma password para o novo 
utilizador do software.
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4. Clique em OK para abrir uma caixa de diálogo e confirmar que pretende fechar a janela. 

5. Clique em Sim para fechar a caixa de diálogo e a janela.

Para remover um utilizador do software, siga os passos seguintes:

1. No painel Manage Users (Gerir utilizadores), clique na caixa da lista Delete (Eliminar) 
para cada utilizador do software que pretende remover.

2. Clique em OK para abrir uma caixa de diálogo e confirmar que pretende fechar a janela.

3. Clique em Sim para fechar a caixa de diálogo e a janela.

NOTA: A lista de utilizadores do software tem de incluir sempre um administrador.

Atribuir direitos a funções de utilizador
A janela User Administration (Administração de utilizadores) dá acesso a funções e direitos 
de utilizadores. O software inclui as quatro funções seguintes:

• Administrator (obrigatório). Cada utilizador com a função de administrador 
(Administrator) possui todos os direitos, os quais não podem ser alterados. 
O administrador pode também adicionar e remover utilizadores do software e alterar 
os direitos de cada função

• Principal. Por predefinição, cada utilizador com a função de principal (Principal) 
possui todos os direitos

• Operator. Por predefinição, cada utilizador com a função de operador (Operator) 
possui todos os direitos, com excepção de ignorar ciclos e criar um estudo de genes

• Guest. Por predefinição, os utilizadores com função de Guest não têm direitos 
e só podem ler os ficheiros

Para especificar os direitos de cada função, siga os passos seguintes: Só um administrador 
do software pode alterar os direitos de qualquer função. 

1. No painel Manage Rights (Gerir direitos), clique na caixa sob a designação da função 
para adicionar ou remover esse direito. Clique em um ou mais direitos da lista. Clique 
em Restore Default Rights (Repor direitos predefinidos) para repor todos os direitos 
de todas as funções na lista predefinida.

2. Clique em OK para abrir uma caixa de diálogo e confirmar que pretende fechar a janela.

3. Clique em Sim para fechar a caixa de diálogo e a janela.

Para ver a sua função e respectivos direitos actuais, seleccione User > User Administration 
(Utilizador > Administração de utilizadores). Contacte um administrador do software para 
modificar as definições de utilizador, os direitos e as funções mostrados na janela 
User Administration (Administração de utilizadores). Um utilizador do nível Principal, 
Operator ou Guest só pode ver as respectivas definições de utilizador, direitos e funções.
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11 Recursos

Leia este capítulo para obter mais informações sobre recursos para o sistema de detecção 
em tempo real CFX96™:

• Assistente de calibração (abaixo)

• Manutenção do instrumento (página 117)

• Registo de aplicações (página 119)

• Resolução de problemas (página 120)

• Especificações técnicas (página 122)

• Bibliografia (página 124)

Assistente de calibração
O sistema CFX96 é calibrado de fábrica para fluoróforos utilizados habitualmente em placas 
de poços brancos e poços transparentes (Tabela 29).

O sistema CFX96 inclui também um canal dedicado para química FRET; este canal não requer 
calibração para fluorocromos específicos. 

Para abrir o assistente de calibração para calibrar o sistema de PCR em tempo real CFX96:

1. Seleccione um instrumento no painel Detected Instruments (Instrumentos detectados).

2. Seleccione Tool > Calibration Wizard (Ferramenta > Assistente de Calibração) para 
abrir a janela e calibrar novas combinações de placas e fluorocromos (Figura 81).

Tabela 29. Fluoróforos e canais calibrados de fábrica.

Fluoróforos Canal

FAM, SYBR® Green I 1

VIC, HEX, TET, CAL Gold Fluor 540 2

ROX, Texas Red, CAL Fluor Red 610 3

Cy5, Quasar 670 4

Quasar 705 5
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Figura 81 - exemplo da janela Dye Calibration (Calibração de fluorocromos).

Figura 81. Janela Dye Calibration (Calibração de fluorocromos).

Calibração do sistema CFX96
Para calibrar o sistema CFX96 na janela Dye Calibration (Calibração de fluorocromos):

1. No painel Calibrate New (Calibrar novo) ou Existing Fluorophores (Fluoróforos 
existentes), na lista pendente seleccione o fluoróforo que pretende calibrar. Se o nome 
do fluoróforo não estiver incluído na lista, digite o nome na caixa e adicione-o à lista.

2. Seleccione o tipo de placa. Se o tipo de placa não estiver incluído na lista, digite o tipo 
na caixa e adicione-o à lista.

3. Seleccione um canal para o fluoróforo.

4. Clique em Add to Plate (Adicionar à placa) para adicionar o fluoróforo. Para limpar 
a placa, clique em Clear Plate (Limpar placa) para remover todos os fluoróforos.

5. (Opcional) Repita os passos 1–6 para adicionar cada fluoróforo que pretende calibrar 
para a placa.

6. Quando terminar de adicionar fluoróforos, clique em View Plate (Ver placa) para abrir 
Dye Plate Display. Utilize esta janela como guia para carregar flurocromos na placa. 

7. Prepare uma placa de 96 poços para calibração de fluorocromos, pipetando solução 
de fluorocromo em cada poço, de acordo com o padrão mostrado no Pure Dye Plate 
Display. Para cada fluoróforo, encha 4 poços com 50 μl (placa de 96 poços) de solução 
de fluorocromo de 300 nM. Repare que pelo menos metade da placa contém poços em 
branco.

8. Para selar a placa, utilize o método que irá ser usado na experiência.

9. Coloque a placa de calibração no bloco e feche a tampa. Em seguida, clique 
em Calibrate (Calibrar), e clique em OK para confirmar que a placa se encontra 
no bloco.
116



Manual de Instruções do Sistema de Detecção por PCR em Tempo Real CFX96™
10. Quando o CFX Manager™ software conclui o ciclo de calibração, aparece uma caixa 
de diálogo. Clique em Yes (Sim) para terminar a calibração e abrir o Dye Calibration 
Viewer (Visualizador de calibração de fluorocromos).

11. Clique em OK para fechar a janela. 

Manutenção do instrumento
O sistema CFX96 inclui um sistema de vaivém óptico sensível e um bloco de amostras 
que têm de aquecer e arrefecer muito rapidamente. A contaminação destes componentes 
pode interferir com a ciclagem térmica e a recolha de dados. 

AVISO! Nunca permita que a reacção seja executada com uma tampa de amostra 
aberta ou com fuga. Poderá verificar-se a fuga dos reagentes, os quais poderão 
revestir o bloco, a tampa interior e a cabeça óptica no sistema de vaivém. 
A sujidade excessiva pode ofuscar o sinal, e a contaminação por fluorescência 
pode criar um sinal de fundo excessivo. O sistema de vaivém óptico só deve ser 
limpo por técnicos da assistência Bio-Rad com a devida formação para o efeito.

Para evitar a contaminação do sistema CFX96, veja as sugestões seguintes:

• Limpe sempre a parte exterior de qualquer recipiente antes de o colocar no bloco

• Nunca execute uma reacção com um vedante que esteja aberto, solto, furado ou 
que apresente outros danos, uma vez que tal poderá contaminar o bloco, a tampa 
interior e o sistema óptico

• Nunca execute uma reacção de PCR ou de PCR em tempo real com reagentes 
voláteis que possam explodir e contaminar o bloco, a tampa interior e o sistema 
óptico

• Limpe periodicamente o bloco e a tampa interior para evitar a acumulação 
de sujidade, de material perigoso para o ambiente ou de soluções fluorescentes 
(página 117)

• Nunca limpe nem toque de outra forma no sistema óptico atrás dos orfícios da placa 
de aquecimento presentes na tampa interior (Figura 82 na página 118)

• Limpe regularmente a tampa exterior e a base do Termociclador C1000™ (para mais 
informações, consulte o manual de instruções do termociclador C1000)

Limpeza do módulo de reacção óptico
O bloco do módulo de reacção óptico e a base do Termociclador C1000 devem ser limpos 
regularmente para remover detritos e sujidade que poderão interferir com o seu funcionamento 
correcto. Assim que descobrir detritos e líquidos derramados, limpe-os com um pano macio 
sem fiapos humedecido com água. A limpeza do instrumento permite o seu funcionamento 
preciso. Para informações mais detalhadas sobre a limpeza da Base do C1000, consulte o 
manual de instruções do termociclador C1000.

AVISO! Nunca utilize soluções de limpeza corrosivas para o alumínio. Evite riscar 
a superfície do compartimento do módulo de reacção C1000. Uma superfície 
riscada e danificada compromete a precisão do controlo térmico.

AVISO! Nunca verta água ou outras soluções sobre o compartimento do módulo 
de reacção C1000. Os componentes molhados podem provocar choques 
eléctricos quando o termociclador é ligado à tomada.
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Limpe o módulo de reacção óptico CFX96 assim que detectar detritos, sujidade ou 
contaminação no bloco ou na tampa interior. Qualquer sujidade pode interferir com 
a capacidade que o bloco tem de alterar rapidamente a temperatura e recolher dados 
de fluorescência precisos. Para limpar o módulo de reacção, siga as directrizes seguintes. 
Siga estas sugestões de limpeza:

AVISO! Para evitar choques eléctricos, retire sempre o módulo de reacção da base 
do termociclador, ou desligue a base da tomada antes de limpar o instrumento.

AVISO! Nunca toque no sistema óptico, localizado atrás dos orfícios da placa 
de aquecimento na tampa interior (Figura 82), nem permita que soluções entrem 
em contacto com o mesmo.

Figura 82. Orifícios da placa de aquecimento na tampa interior.

• Limpe a superfície exterior.  Utilize um pano húmido para limpar substâncias 
derramadas na caixa exterior. Se necessário, utilize uma solução suave de sabão 
e enxague a superfície com um pano limpo. Limpe a tampa para evitar a corrosão

• Limpe as aletas de refrigeração. Elimine a poeira com uma escova macia ou um pano 
húmido. Elimine as camadas de poeira presentes nas aberturas de ventilação com um 
aspirador. Utilize água e um pano macio sem fiapos para remover os detritos agarrados 
às aletas. Evite riscar a superfície. Se necessário, utilize uma solução suave de sabão 
e enxague bem para remover completamente os resíduos. A limpeza das aletas melhora 
a precisão de aquecimento e arrefecimento das amostras

NOTA: Nunca utilize soluções de limpeza corrosivas para o alumínio, tais como 
lixívia ou produtos de limpeza abrasivos.

• A utilização de óleo nos poços não é recomendada. Se for utilizado óleo, os poços 
devem ser limpos rigorosa e frequentemente. Elimine o óleo quando este apresentar 
uma cor não característica ou se estiver sujo. Utilize uma solução de etanol a 95% para 
limpar o óleo. Não deixe acumular óleo no bloco

• Limpe os poços do bloco. Limpe imediatamente os derrames para evitar que sequem. 
Utilize pipetas descartáveis em plástico com água (recomendado), etanol a 95% 
ou lixívia diluída a 1:100 em água. Utilize também um pano macio sem fiapos ou uma 
toalha de papel e água para limpar o bloco. Enxague sempre os poços com água várias 
vezes para eliminar todos os vestígios de reagentes de limpeza

AVISO! Nunca limpe o bloco com soluções alcalinas fortes (sabão forte, amónia 
ou lixívia concentrada). Nunca utilize soluções de limpeza corrosivas ou abrasivas. 

Nunca toque em nada 
atrás destes orifícios.

Bloco (96 poços)
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Este tipo de agentes de limpeza pode danificar o bloco e comprometer a precisão 
do controlo térmico.

AVISO! Os resíduos de lixívia, etanol ou sabão presentes nos blocos podem 
corroer os mesmos e destruir os elementos de plástico durante um ciclo. Depois 
da limpeza, enxague sempre muito bem os poços com água para eliminar todos 
os vestígios de reagentes de limpeza.

AVISO! Nunca aqueça o bloco depois de adicionar uma solução de limpeza. 
Aquecer o bloco com solução de limpeza danificará o bloco, o módulo de reacção 
e a base do termociclador.

• Limpe a tampa interior. Utilize água e um pano macio sem fiapos para remover 
os detritos e soluções da superfície da tampa interior. Nunca utilize detergentes 
abrasivos ou materiais que possam riscar a superfície. A limpeza da tampa interior 
melhora a precisão de aquecimento e arrefecimento das amostras

Registo de aplicações
Antes de um novo ciclo, o instrumento inicia um teste de auto-diagnóstico para verificar se 
está a funcionar de acordo com as especificações. O software regista os resultados deste 
teste no ficheiro de registo do ciclo e da aplicação. Se detectar um problema em uma ou mais 
experiências, abra os registos do ciclo e da aplicação para descobrir quando é que 
o problema começou.

O CFX Manager software regista informações sobre o estado de um instrumento durante 
um ciclo no Registo de aplicações (Figura 83). Utilize estes registos para seguir eventos que 
ocorrem em instrumentos e no software, e também para a resolução de problemas.

Para abrir o registo de aplicações na janela principal do software, seleccione View > 
Application Log (Ver > Registo de aplicações). 

Figura 83. Exemplo de um ficheiro de registo de eventos.
119



Recursos
Resolução de problemas
Regra geral, os problemas de comunicação do software e do instrumento podem 
ser resolvidos reiniciando o computador e o sistema. Certifique-se de guardar o trabalho 
em curso antes da reiniciação.

NOTA: Verifique se o computador tem suficiente RAM e espaço livre no disco 
rígido. A RAM mínima é 2 GB, e o mínimo de espaço livre no disco rígido é 20 GB.

Instalar o software manualmente
Se necessário, instale o software manualmente de acordo com as instruções seguintes:

1. Insira o CD do software.

2. Clique com o botão direito no ícone do CD do software e seleccione Explore (Explorar) 
para abrir a janela do CD.

3. Faça duplo clique na pasta CFX_Manager para abrir a pasta e, em seguida, faça duplo 
clique em setup.exe para iniciar o assistente de instalação do software. 

4. Siga as instruções do assistente para instalar o software e clique depois em Finish 
(Terminar).

Instalar os controladores manualmente
Se necessário, instale os controladores manualmente de acordo com as instruções seguintes:

1. Insira o CD do software. Se não tiver o CD, localize a pasta dos controladores 
no caminho de ficheiros C:\Program Files\Bio-Rad\Drivers no seu disco rígido.

2. Clique no ecrã de instalação do software do botão Drivers (Controladores) (Figura 84).

3. Clique na pasta BaseUnit para abri-la. 

4. Para computadores com Windows XP, faça duplo clique em BioRadC1000DriverInstall.exe 
para aceder à janela de instalação. Para computadores com Windows Vista, clique com o 
botão direito do rato em BioRadC1000DriverInstall.exe e seleccione Run as Admin 
(Executar como admin) para aceder à janela de instalação. 

Figura 84. Janela de instalação de controladores.

Quando a instalação estiver concluída, fecha-se a janela de instalação.
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Opções de falha de corrente
Se ocorrer uma falha de corrente, o instrumento e o computador encerram. Após uma 
breve falha de corrente o instrumento retoma a execução de um protocolo, mas o registo 
de aplicações toma nota da falha de corrente. Consoante as definições do computador 
e o período de tempo sem energia, o instrumento e o software tentam continuar a funcionar, 
dependendo do passo do protocolo:

• Se o protocolo se encontrar num passo sem leitura de placa, o protocolo continuará 
a ser executado assim que o instrumento voltar a receber energia

• Se o protocolo se encontrar num passo com leitura de placa, o instrumento aguarda 
que o software seja reiniciado e retome a comunicação para recolher os dados. 
Nesta situação, o protocolo só continua se o software não for encerrado pelo 
computador. Quando o computador e o software voltam a arrancar, o protocolo 
continua

Se quiser abrir uma tampa motorizada bloqueada num módulo de reacção para remover 
as amostras durante uma falha de energia, siga estes passos para remover a placa 
de bloqueio:

1. Retire o módulo de reacção da caixa do C1000, carregando para tal na barra 
de bloqueio da base do C1000.

2. Coloque o módulo na parte frontal de uma mesa, de modo que a parte da frente 
do módulo se projecte 5 cm sobre o bordo da mesa, conforme mostrado na Figura 85. 

Figura 85. Configurar o módulo óptico para remover a placa de bloqueio.

3. Com uma chave Allen, retire os dois parafusos grandes sob o bordo dianteiro do módulo 
de reacção (sob o botão de abertura da tampa). Não retire os dois parafusos pequenos 
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localizados no bordo dianteiro do módulo. Deverá ouvir a patilha de bloqueio a libertar-
se no interior do módulo. A Figura 86 mostra os dois parafusos grandes. 

Figura 86. Retire estes parafusos para desbloquear o módulo óptico.

4. Empurre a tampa do módulo de reacção para abri-la. Repare que a patilha (plástico 
escuro) já não está afixada. Retire as amostras do bloco.

5. Volte a montar o módulo de reacção com a tampa aberta, colocando de novo a patilha 
de bloqueio e fixando-a com os dois parafusos grandes. A Figura 87 mostra a patilha 
de bloqueio instalada. 

Figura 87. Patilha de bloqueio do módulo óptico.

Especificações técnicas
Dimensões e peso

Especificações eléctricas

Tamanho (L x P x A) 33 x 46 x 36 cm (13 x 18 x 14")

Peso 21 kg (47 lb)

Tensão 100-240 V

Frequência 50-60 Hz

Consumo de energia 850 Watt

Capacidade nominal dos 
fusíveis

10 A
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Condições de operação

Termociclador

Temperatura

Óptica

Software

Generalidades Utilização em interiores

Temperatura Temperatura ambiente de 15-31°C

Humidade
Humidade relativa máxima de 80% 
(sem condensação)

Altitude
Até 2.000 metros acima do nível 
do mar

Nível de ruído Cumpre as especificações 61010-1

Grau de poluição 2

Classe de instalação 2

Caixa Caixa do C1000

Velocidade máxima de rampa 5°C/seg

Velocidade média de rampa 3,3°C/seg

Amplitude programável do 
gradiente

1-24°C

Intervalo de variação de 
gradiente operacional

0-100°C

Método de aquecimento e 
refrigeração

Peltier

Tampa Aquece até 105°C

Intervalo 0-100°C

Precisão ±0,2°C do alvo programado a 90°C

Uniformidade ±0,4°C no espaço de 10 seg até atingir 
90°C

Excitação 6 LEDs com filtro

Detecção 6 fotodíodos com filtro

Intervalo de comprimentos de 
onda de excitação/emissão

450–730 nm

Sensibilidade Detecta 1 cópia da sequência alvo 
no ADN genómico humano

Intervalo dinâmico 10 ordens de magnitude

Sistemas operativos Windows XP, Windows Vista, Windows 7

Análise multiplex Até 5 alvos por poço
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Sistema
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Aviso de direitos de autor Minpack (1999) Universidade de Chicago. Todos os direitos 
reservados

A redistribuição e utilização sob as formas original e binária, com ou sem modificação, 
são permitidas desde que sejam cumpridas as condições seguintes:

1. As redistribuições do código de origem devem reter o aviso de direitos de autor acima, 
a presente lista de condições e a seguinte declaração de isenção de responsabilidade.

2. As redistribuições sob forma binária devem reproduzir o aviso de direitos de autor 
acima, a presente lista de condições e a seguinte declaração de isenção 
de responsabilidade na documentação e/ou noutros materiais fornecidos 
com a distribuição.

3. A documentação do utilizador final incluída com a redistribuição, caso exista, 
deve incluir a seguinte declaração:

Este produto inclui software criado pela Universidade de Chicago, como Operador 
do Laboratório Nacional de Argonne.

Licenciado para PCR em 
tempo real

Sim

Capacidade de amostra 96 poços

Tamanho de amostra 1–50 μl (10–25 μl recomendado)

Comunicações USB 2.0
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